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The perception that Linux is still too difficult for the average computer
user is the biggest challenge that Linux evangelists need to tackle. 

Linux gained prominence at a time when it wasn’t ready for mass con-
sumption. A lot of people tried it during the late 1990s and were turned off by
its quirkiness. It was simply discounted as a play-tool for geeks.

And this image still persists. But instead of confronting this, Linux sup-
porters continue to tout every other aspect in order to gain converts: it’s free, it’s
stable and it’s secure. 

Does it really matter?
All software is free in India. Okay, it costs 150 bucks. Given the current state

of affairs, how exactly is this whole free angle going to make anybody bite?
We’re used to ‘buying’ the latest version of Photoshop for resizing our digital
photos even when there are umpteen free tools available on the Net for this sim-
ple task. Yes, things might be different if we actually had to pay Rs 4,000 for a
copy of Windows. But they aren’t. Also, with the release of Windows 2000 and
then XP, Microsoft has made bold steps in rectifying the bad poster boy image
of Windows. 

What’s important is that Linux has come a long way from its humble begin-
nings. Most of its kinks have been ironed out and the rough edges smoothened.
Sure it still needs to improve on driver support for new hardware, sort out cer-
tain compatibility issues with Microsoft Office and add a few features to its top
applications such as Star Office and GIMP. But on the whole it’s a viable desk-
top alternative to Windows. 

What’s needed now is to get users to try it once again. But without a cen-
tralised marketing push, it’s naive to hope that everyone will see the light. The
best bet then is to get top-tier system resellers to adopt and propagate Linux.

This has been made easier with the recent US Department of Justice ruling
against Microsoft. The Redmond bully can no longer offer special incentives to
its cronies or force any system vendor from adding non-Microsoft software to
their PCs. Right now there’s nothing stopping PC makers from bundling a free
Linux CD or offering dual boot functionality. At the very least they can place a
desktop icon for ordering a free trial copy of Linux. 

This effortless seeding activity might be just the thing that’s needed to pop-
ularise Linux and loosen Microsoft’s stranglehold on us all. Plus it pays to sup-
port the underdog. If anything, it’s the only way to fight complacency and drive
innovation.

vinit_aggarwal@jasubhai.com

“What's needed 
now is to get
users to try Linux 
once again”

Selling Linux:
Pull or Push?

Vinit Aggarwal
Assistant Editor
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Macromedia Contribute
Size: 17.90 MB, Type: Trial
Mindware\Software\Developer Tools

Holiday Lights 5.3
Size: 1 MB, Type: Trial
Mindware\Software\Home

Adobe Photoshop Elements 2.0
Size: 111 MB, Type: Trial
Mindware\Software\Multimedia

Tiger Woods PGA Tour 2003
Size:  63 MB, Type: Trial 
Playware\Arena\Games 

Jewel Cad 5
Size: 2.69 MB, Type: Trial
Mindware\Software\Multimedia

Cute FTP Pro 3.0
Size: 4.68 MB, Type: Trial
Mindware\Software\Internet

India Accounts for Windows 95/98
Size: 6.05 MB, Type: Trial
Mindware\Software\Office

Brave Dwarves 2 v1.03
Size: 4.9 MB, Type: Trial 
Playware\Arena\Funzone

Registry Analyst 1.0
Size: 0.44 MB, Type: Trial
Mindware\Software\System

PFS Manager 2.03
Size: 6.75 MB, Type: Trial
Mindware\Software\Multimedia

Acronis True Image 6.0
Size: 8.90 MB, Type: Trial
Mindware\Software\System

Need For Speed: Hot Pursuit 2
Size: 92.4 MB, Type: Trial 
Playware\Arena\Games 

ICUII 5.6
Size: 2.40 MB, Type: Trial
Mindware\Software\Internet

HIGHLIGHTS

1Click & Lock
1Click & Lock is a system tray security
utility you can use to secure your desktop
when you are away from your PC. It’s
secure and very
easy to use. Just
define a pass-
word and select
Lock to hide
and deny access
to your desktop
to anyone who
doesn’t have the
password. You
can set the program to launch automati-
cally with Windows, lock your desktop
from the system tray, log access attempts,
and apply a custom background image.
When enabled, 1Click & Lock even allows
visitors to your PC to leave messages for
you. The cold-boot and boot key protec-
tion give maximum protection that’s dif-
ficult to get around.
Size: 1.3 MB, Type: Trial
Mindware\Software\System

Effect 3D Studio 1.0
E f f e c t 3 D
Studio lets
anyone create
professional
3D animated
graphics with
hundreds of

rendering effects, lighting effects, back-
grounds, material settings, and
motions. This truly is 3D animation
made simple. 
Size: 23.75 MB, Type: Trial
Mindware\Software\Multimedia

Battlefield 1942
Join the Battlefield in the year 1942 and
experience the heat of the battle as you
heroically storm the beaches of Normandy,
drive a tank across the deserts of northern
Africa, pilot a fighter plane during the Bat-
tle of Midway, or command a battleship at
Guadalcanal or prowl the sea lanes for
enemy subs! This is a unique first person
team-based action game that places you
right in the midst of a raging battlefield.
You’ll get to
be an Allied
or an Axis
serviceman,
and join in
as a member
of an assault
team, or a
medic or an engineer, or it will be your job
to knock out tanks. With a wide choice of
historic WWII era weapons within your
armoury, enlist and fight in some of the
most famous and pivotal battles of World
War II.
Size: 133 MB, Type: Trial
Playware\Arena\ Games

ON THE CD

8

The Connect section on your Digit CD
this month brings you Bookmarks on

sites which will give a glimpse into how
people have celebrated the New Year.
You never know, you might come across
some real great experiences. 

Also, in Connect find the Newsletter
section which brings sample newsletters
related to travel. The newsletters provide
information ranging from travel news to
people’s travel experiences. So, the next
time you want to plan a trip, you know
where to get the dope.

KNOW YOUR CD

MUST-TRY SOFTWARE

JANUARY 2003

MINDWARE\CONNECT
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If you are wondering whether you want
to buy the current issue or not, check
out the highlights of the magazine.
Also, click on Mindware or Playware to
check out the software on the CD

Burning issues
Are buffer underruns the
bane of your life? Get over
them and optimise your
CD-writing process

WEB SPECIAL HIGHLIGHTS

WEB SPECIAL

taste technology at http://www.thinkdigit.com

BY DEMAND
You get to choose what goes on 
Digit Interactive. This month, you 
have chosen:
Ringtone Converter 3.7.8 (4.3 MB) for
Mindware 

James Bond 007: NightFire (147 MB) for
Playware

Expect these on the February 2003 CDs

Virusproof forever
No virus, no Trojan, no worm, no
matter how powerful, can get to
you if you know how they work and
squish them right at the entry point.
Or even better, never let the entry
point be insecure

JANUARY 2003
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Windows 
Refund Day

If you want a refund for any
Microsoft operating system,

your day has arrived. Come
January 23, 2003 you can start
litigation to get back your
money from Microsoft, or
from the manufacturer who
sold you the OS with your
computer. 

So, who qualifies for a
refund?  If you bought a com-
puter that came bundled with
a Microsoft OS or if despite
having an existing licence, you
were forced to obtain another
licence for a replacement com-
puter, you can get your money
back. But before you head off
to a local courthouse, take a
look at the licence agreement.
You stand to get a replacement
only if you can present the
proof of ownership and all
copies of the software,
unopened! The idea is to hold
computer manufacturers
accountable for refusing to
provide a refund for unused
copies of any Microsoft OS.
Needless to say, the movement
has been spearheaded by Linux
enthusiasts. Incidentally, this
movement comes around in
the same week as the Linux-
World Expo at New York. 
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CD Mount Rainer
ReWrite format
■ What is it?
A packet writing technology
that will allow optical disks
to be written to and read
from with the ease of floppy
disks.

■ What does it do?
This standard allows CD-
MRW disks to be formatted
even while data is being writ-
ten on the disk, thus saving
time. The media can be
ejected at any time during
the format process—the
drive simply picks up where
it left off after the media is
reinserted. 

Fault management will be
integrated into the drive
hardware itself, instead of
through the software as with
existing standards such as
UDF 1.50. These disks are
proposed to have a 2 K
addressing system (as
opposed to the 64 K address-
ing system of floppy disks),
resulting in a more efficient
use of space.

■ What does it imply?
The CD Mount Rainer
ReWrite format will facilitate
easy reading and writing to
optical media using packet
writing technologies. Since it
will be a standards-based
technology, there will be uni-
versal compatibility between
media and drives. With
greater data capacity and
reliability, this technology
spells the death of the
already obsolete floppy disk.

hypethesis

■ AskJeeves gets real people to help you search the Web ■ UK lampposts may hold hundreds of cell phone transmitters ■ LG Philips LCD unveils 52-inch LCD TV 

Perfect DVD copies

After spam and popup
advertisements, the

Internet now aids a new
malignance. Your e-mail
could invite burglars
to come and
clean your
home while
you are out of
town. Crooks
are now buy-
ing up huge
e-mail lists
over the Internet and send-
ing mass mail in the hope of
getting autoreply messages
that scream out ‘We are not
at home’. Smart thieves in
the UK are using information
within ‘Out of Office’ autore-
ply e-mail and are cross ref-

erencing this information
against publicly available
databases such as 192.com

and bt.com that contain
names, addresses and

telephone num-
bers. This makes
leaving auto-
replying mes-
sages equivalent
to putting up a
note on your
front door,

informing all and sundry
about your absence. 

The solution is clear—
keep your messages bland,
redirect enquiries to others or
to alternate addresses and do
not put personal contact
information in your e-mail.

E-mail invites burglars

An American firm called
321 Studios has released a

software program that can cre-
ate mirror images of an entire
DVD on a blank DVD.
Called DVDX-
Copy, this pro-
gram can dupli-
cate the menus,
special features
and enhanced
audio. 

Hollywood's
lobby group, the
Motion Picture
Association of America
(MPAA) has stated that such
products violate the Digital
Millennium Copyright Act
(DMCA), which outlaws tools
to circumvent copy-control
technology, including the

Contents Scramble System
(CSS) used on DVD media.
Facing possible criminal pros-
ecution, 321 Studios respond-

ed by saying that con-
sumers have a legiti-
mate right to make
backup copies of DVDs
they own. 

To appease Holly-
wood, DVDXCopy
intends to introduce a
unique digital water-
mark to enable tracing
the DVD source, a dis-

claimer that the backup is
for personal use only and,
most importantly, electronic
controls embedded into the
DVD that prevent the copied
DVD from being duplicated
further. 

Total cost of owner-

ship of Linux could

be as much as

22% higher than

Windows 2000

Source: IDC

snapshotIllustrations: Farzana Cooper
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Drive eraser
W32.Galil@mm is a mass-
mailing worm that has the
potential to overwrite all
files on all drives that it can
write to with 215 bytes 
of text. It is written in Visual
Basic and its uncompressed
size is 80,626 bytes.

The worm uses its own
SMTP engine or Microsoft
Outlook to send itself to all
addresses that it finds on the
infected computer. Multiple
copies of the worm can be
attached to the outgoing
message. The message
seems to have been for-
warded from a Yahoo!
account and talks about sex
being illegal in the United
States. 

The latest virus definitions
of most anti-virus software
should take care of the
worm.

P2P Worm
This is a memory-resident
worm called AGOBOT.C and
it propagates itself through
the KaZaa, Grokster and
Bearshare file-sharing peer-
to-peer networks and net-
work shared drives. It regu-
larly attempts to connect to
an Internet Relay Chat (IRC)
server as a bot. When con-
nected, it may launch
Denial of Service (DoS)
attacks against other users.
It also has backdoor capabil-
ities and allows malicious
users to take control of
infected PCs.

This worm infects all
computers running on Win-
dows and creates entries in
the registry so that it runs
automatically every time
Windows starts. It can be
identified and removed with
the latest updates of most
anti-virus software such as
AVG or Norton AntiVirus. 

redalert

■ Video game Jen saves Ben features Jennifer Lopez saving kidnapped Ben Affleck ■ Columbia Records Japan offers albums on demand burnt on CD-R 

Saying it with a nice com-
forting vibration could well

be the next way to commu-
nicate. MIT Media Lab is
working on letting people
communicate by passing
along the ‘touch’ ele-
ment. The Tangi-
ble Media Group,
the research team
at the Media Lab,
says that the exist-
ing vibrator mode
is too crude to actu-
ally convey subtle
feelings. Hence they
have come up with a proto-

type design that features five
tiny speakers that vibrate

against the skin on the fin-
gers and thumbs some

250 times per second.
Pressure sen-

sors tucked
behind the
speakers let
you vibrate
the person

right back.
The intensity

of the vibration
depends upon

how hard you
squeeze. When test-

ing this on a group of stu-
dents, they immediately used
the technique to emphasise
what they were saying, or to
interrupt the other person.
Over time, they managed to
develop a distinct ‘vibralan-
guage’ that added to the effect
of talking on the cell phone.
All the users found it extreme-
ly easy to work with and to get
used to this. The idea is to let
people transmit thoughts and
feelings more effectively and
also help people with disabili-
ties communicate using cell
phones.

OS/2, one of the most
robust OSes and the

world’s first fully 32-bit
graphical desktop will be
declared officially dead
by IBM on March 12,
2003, with support
continued till
December 31, 2004.
IBM’s support is con-
sidered an industry
standard and their com-
mitment to older technology is

legendary. Still, the
move comes as no

surprise—with
IBM’s inability

to attract the
hardware commu-

nity to write drivers
for newer devices,

Microsoft stole a
march right under Big

Blue’s nose by getting
harware support for Win-

dows 95 right from its launch. 

Squeeze the cell phone

statattack

Who killed OS/2? Block viruses

With computer viruses
spreading through

networks faster than the eye
can blink, a researcher at the
Hewlett-Packard laboratories
in England just came up with
a radical new theory—put
the brakes on the infected
computer to limit infection.
Computers that are infected
tend to behave differently
than uninfected ones, says
Matthew Williamson, the HP
researcher. 

The infected computer
quickly tries to make as
many connections as possi-
ble with neighbouring com-
puters, through all possible
network services, including
e-mail. Throttling back the
infected computer results in
it taking a far longer time to
start infecting other
machines, giving enough
time to alert system admin-
istrators to take necessary
actions. 

The idea worked amaz-
ingly well at HP’s lab, during
tests to try out this new the-
ory. Incidentally, the limits
imposed by throttling
appeared to have no notice-
able impact to the user of the
infected computers. So
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heroes
Low-price PCs
Wal-Mart Stores Inc is offer-
ing a computer at $199
(approx Rs 10,000) with
neither Microsoft software
nor Intel hardware. The
Wal-Mart machines are full-
fledged computers without
Windows. Its sales, largely
from technology enthusi-
asts, businesses and schools,
are already exceeding
expectations.

Robotics
Leif Askeland, an icon in the
toy industry, has created a
robotic lap cat named FurRe-
al Friends that will appeal to
retailers, parents and chil-
dren. The furry robot purrs
when petted and presses its
face into your hand if its
cheeks are rubbed. 

Microsoft
applications

Sun Microsystems
announced a deal on
December 4, 2002, to
install StarOffice on some
European Sony PCs, mark-
ing another defection from
dominant Microsoft prod-
ucts. Corel had earlier
announced deals to put its
WordPerfect software on
PCs from HP and the North
American wing of Sony. 

eBay
Fraudsters are tricking
legitimate users of eBay
into handing over their
identities to set up bogus
auction accounts. The
scammers rely on good rat-
ings earned by the legiti-
mate users to make their
own bogus auctions look
respectable. 

zeroes

Artificial Intelligence will soon
be everybody’s cup of tea and
you can be a part of
the research for
implementing AI.
Researchers have
finally conceded
that the quest for
AI is too daunt-
ing for a single
group, and are
looking at the formi-
dable resources of the Internet
for help. 

World Wide Mind, a
research team run by Mark
Humphrys at Dublin City Uni-
versity, says that for AI to
advance, the entire field needs
to be democratised. To harness

the power of developers and
novices worldwide, Humphry’s

team has devel-
oped an inter-
active pro-
gram that lets
them post
their research

on the Net for
others to use.

Previously, AI
research focussed on

creating entire robotic systems
that could ‘sense’ the world.
But the new shift is in creating
logical subsystems or mod-
ules, that are used in vision,
navigation, locomotion,  and
problem solving among 
others. 

AI on the Internet
followup

Google has now yet anoth-
er distinction—it provides

many Web-based businesses
with a steady supply of cus-
tomers. Numerous small Web-
based service providers and
entrepreneurs are now
dependent on Google for their
customer base. For example, if
you were looking for yacht
charters at the British Virgin

Islands, you could possibly
end up looking up Bareboats-
BVI, a site that gets most of its
customers over from Google.
The yacht broker does not end
up paying anything to Google,
but still relies on it for income. 

Google uses many vari-
ables in its automated ranking
process but the popular one
bases its ranking on the num-
ber of sites that link to it. These
links spell the number of endorse-
ments. Google regularly shuffles

its rankings to reflect changes
in its own methods or in the
Web’s link structure and con-
tent. This way, many small
time independent businesses
that would get lost in the
World Wide Web, get fair expo-
sure. But, Google can be very
aggressive when it comes to
customers using unfair means.
Sometimes a site’s ranking low-
ers dramatically or even disap-
pears altogether if Google
detects some evidence that the
site’s owner was using decep-
tive tactics such as building a
network of linked sites to cre-
ate the illusion of popularity
and thereby receiving a higher
ranking.

But the free lunch may
soon come to an end—big
businesses are spending more
money into making sure that
their site listings are optimised.
Google doesn’t make any
money out of this—although
sponsored site links are posted,
these are not ranked, they
appear as separate links.

Google for pinstripes

Super Gateway

The world’s second fastest
supercomputer has just

arrived, and it does not stay in
a lab. Gateway, the PC maker,
has just announced that its
8,000 computers located at
Gateway stores all over the US
will now work, instead of
hibernating. 

After joining forces with
United Devices, using their
Alliance MetaProcessor plat-
form, the 8,000 PC-grid based
supercomputer is capable of
an incredible 14 TFLOPs.
Compare this with the world’s
fastest supercomputer yet, the
Earth Simulator that clocks in
at 35.61 TFLOPs. The next
nearest number cruncher
clocks in at a comparatively
smaller 7.23 TFLOPs. This
means that the Gateway/
United Devices supercomput-
ing grid, called the Platform
On Demand (POD), is now
the Number Two supercom-
puter on the Top 500 Super-
computer list. 

The Alliance MetaProcessor
platform protects the network
with data encryption, firewalls
and intrusion prevention
methods and secure grid
implementation. This secure
supercomputer is available
immediately for use to a vari-
ety of industries, including 
life sciences, geosciences,
nanosciences, entertainment,
financial services and more. 

Source: Aberdeen Group

Out of 29 advi-
sories published by
CERT during the
first 10 months of
2002, Linux soft-
ware accounted for
16 and Microsoft
for only 7

snapshot

■ ATi coming with R400, possibly with GDER 3 memory, by summer ■ Gateway ties with pressplay to offer 2,000 songs pre-loaded on new PCs 
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Researchers at the Universi-
ty of Boulder,

located at Colorado
in the USA, used
video games to find
out whether a cultural
or racial stereotype
could be linked 
to armed and
unarmed males. 

The subjects in
the study were asked to
shoot only when the
human targets in the game

were armed; however, they
typically shot at unarmed
black men compared to

unarmed white men. The
video game showed

photographs
of males
against a vari-
ety of back-

grounds and asked
the subjects to imme-

diately conclude
whether the image

showed an armed or

unarmed man. The unarmed
males had aluminium cans,
cell phones, cameras and wal-
lets. When asked to make 
a spilt-second decision, all 
the subjects concluded, mis-
takenly, that black men were
armed. 

The research helped estab-
lish that hidden cultural
stereotypes exist in situations
wherein the subject has to
react very quickly and on
instincts.

Thought-provoking games

Moore’s law states that
the amount of infor-

mation storable on a given
amount of silicon has rough-
ly doubled every year since
the microprocessor technolo-
gy was invented. Andrew S.
Grove, the Chairman of
Intel, recently sug-
gested that Moore’s
Law might be redun-
dant by the end of
the decade. The
inactive Intel proces-
sors are leaking current,
threatening the future valid-

ity of Moore’s Law. 
As chips become more

powerful and draw more
power, leakage tends to
increase. Going by statistics,
the industry is used to power

leakage rates of up to
15 per cent, but chips

constructed of
increasing num-
bers of transistors
can suffer power
leakage of up to 40

per cent. Chips made
up of a billion transistors

may leak between 60 and 70

watts of power. The power is
largely dissipated as heat,
which causes cooling prob-
lems for powerful chips.

Currently, Intel is seeking
ways to design chips with
multiple cores with
improved design and better
insulators. The microproces-
sor giant intends to make
more efficient use of the
humble transistor in order to
deliver ever increasing per-
formance. In short, Moore’s
law is going to be upstaged
by electricity!

Moore’s Law outlawed

Calling it the ‘most defini-
tive sound experience yet’,

Creative’s Audigy 2 is a PC
audiophile’s delight. The Audi-
gy 2’s jaw-dropping specifica-
tions include 24 bit music
fidelity with 96 KHz
in seven chan-
nel surround
sound. It also
incorporates the EAX
Advanced HD technology for
truly immersive PC gaming
experience and Dolby Digital
EX compatibility, among oth-
ers. Be it gaming or listening to

music, you can enjoy rich and
realistic 6.1 surround sound. It
utilises the breakthrough sur-
round sound technology of
Windows Media Audio 9,

bringing in the
next wave
of home

theatre-like
experience to the

PC. It has an incredi-
ble 106 dB Sound to

Noise Ratio and the
unique reputation of being the
first and only THX certified
add-in soundcard.

Drown in the music
Amazon’s online store lets

shoppers host recom-
mendations for other buyers
shopping for the same mer-
chandise. Now, this technol-
ogy, that tracks and links
consumer perusal and pur-
chases, has left Amazon red
in the face due to its latest
faux paus. 

In early December 2002,
Amazon users who were look-
ing at a spiritual guide by well
known Christian evangelist
Pat Robertson were shocked
to find a manual on sex rec-

ommended alongside. The
incident clearly illustrates the
pitfalls of online recommen-
dations, which were hailed as
excellent marketing tools.
After receiving a complaint,
Amazon promptly withdrew
the recommendation. Unfor-
tunately, this technology is
easily manipulated by people
who repeatedly shop, or just
click through the links
online.  Analysts claim that
this sort of incident will drive
away existing and potential
customers. 

Amazon red-faced

A50-year-old computer
called CSIRAC is still oper-

ational in Australia. This one-
time state-of-the-art machine
runs at a blistering 300 KHz,
has 2 KB of RAM and 2.5 KB of
storage. While the more ration-
al among us may scoff at its
utility, in it’s hey day this 
7 tonne machine packed quite
a wallop. Between 1951 and
1964, it worked with Australian
universities on projects as
diverse as calculating the
design of water storage systems,
weather prediction, Fourier
analysis research and sky-
scraper design. CSIRAC also
worked with Australian indus-
try on studies for BP’s Kwinana
refinery, the Commonwealth
Aeronautic Research Laborato-
ry and was used by undergrad-
uate and graduate students for
research into programming. 

Over the hill

■ Apple to open a store less than 2 miles from Gates’ house ■ The Sims Online released December 17 ■ nVidia NV30 release delayed to summer of 2003 

Source: ComScore

Online sales world-
wide for Nov 1 to
Dec 6, 2002,
reached $8.2
billion, up
29% from a year

snapshot
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Researchers at the Okla-
homa University in the US

have invented a method to
store digital information on
hydrogen atoms. The inven-
tors of this technology, Bing
Fung and his colleagues,
found that the 19 hydrogen
atoms in a single liquid crystal
molecule can be used to store
1,024 bits of digital informa-
tion. The information is stored
in the interaction of the mag-
netic moments of the protons

within the atoms and is related
to the spins of the subatomic
particles of the atoms. In ini-
tial experiments, they succeed-
ed in encoding a 32 pixel
square monochrome image in
a molecule where the informa-
tion was stored in a binary for-
mat. This was done by firing a
set of 1,024 different radio fre-
quencies at the molecule. Each
of the frequencies either had
an amplitude (representing a
binary 1) or did not (repre-

senting a 0). The information
thus stored was read by firing a
second pulse at the molecule
having a slightly different fre-
quency. Consequently, the
information was read by meas-
uring the changes in the inter-
ference patterns using a
Nuclear Magnetic Resonance
(NMR) instrument.

While this technology is
still a while away from com-
mercial viability, it promises
big things for storage.

“Companies
throughout the
country have net-
works that are
wide open because
of wireless LANs…
millions of houses
are getting con-
nected, which
means that more
and more are get-
ting vulnerable”

Richard Clarke, special advi-
sor to the US President for
cyber security

“Everyone can hear
what you’re talking
about on the
phone. When
you’re IM-ing,
everyone can hear
you typing, but it
sounds like you’re
working.”

Melanie Miller, staff assis-
tant at the Massachusetts
Institute of Technology, on

Pinging a data packet to a
remote computer and cal-

culating the time taken to
receive its echo is used to
ascertain the reliability of the
Internet connection. Howev-
er, Chis Chafe, cellist and
researcher at Stanford Univer-
sity, has modelled the Internet
connection as guitar strings,
twanging them to reveal those
subtle characteristics that are

missed by pinging. 
The time taken by the

pulse to bounce back depends
on the state of the network.
The longer the connection
time, the lower was the fre-
quency range reproduced.
This works such that any sud-
den loss of sound indicates a
broken link somewhere or
missing packets of data, thus
revealing the jitter. 

In a curious twist of comput-
ing, Microsoft is creating a

digital archive project where
you can build a giant database
of your life using the modern
PC. Called MyLifeBits, the
project aims to build archives
that chronicle the events
in people’s lives.
Add in all the pho-
tographs, home
videos, audio
recordings of con-
versations, letters
and other official
and unofficial
documentation, and pretty
soon, you should be able to
run the equivalent of a Google
search for any event in your

life. With data storage costs
expected to come down mas-
sively, this could be feasible—
calculate some 1,000 GB for 4
hours of videotape recording
for everyday of your life. 

This digital archive could
be a boon for the
archaeologists of a

future genera-
tion trying to
uncover our
c i v i l i s a t i o n .
While the secu-

rity risks are pretty
clear, an accurate,

searchable store of events
could help us preserve our
experiences more vividly for
posterity.

Archive your life!

Molecular photography
tomorrow’stechnology

Internet buzz

quoteworthy

Wireless network-

ing industry expect-

ed 

to bring in $2 bil-
lion revenue this

year, and estimated

to grow by 30%

snapshot

Source: 802.11 Planet Conference

Anew technology called
FACES (Free flight

Autonomous and Coordinated
Embarked Solver) allows planes
to swarm the air and can pre-
vent mid air collisions, regard-
less of the traffic. FACES is
being developed by the Centre
For Aerial Navigation Studies,
France and lets pilots choose
their own routes immediately

after take off,
instead of forc-

ing them to
fly a prede-
t e r m i n e d
path. The

software advis-
es pilots to make

manoeuvres only
when absolutely necessary and
maps out the best routes, sav-
ing on travel time. 

The theory of distributed
software is applied so no par-
ticular plane is ever in control,
and they make their avoidance
manoeuvres together. FACES
has already been tested on a
simulator using archived data
on real air traffic and it success-
fully prevented a pile-up with
35 planes sharing airspace. The
software sets the plan, keeping
in account the flight plans of
other planes that have already
set it into sequence. Once the
routes have been set, the pilots
carry out the choreographed
manoeuvres. This will result in
the non-colliding routes. 

Controlling air
traffic

■ Pirated DVDs of The Lord of the Rings: The Two Towers already all over South Asia ■  Yahoo! launches Web hosting plans for small businesses
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Game interrupted

Dear Vinit, 

I’ve noticed a disturbing trend where every new game

demands even more system resources in order to run

smoothly. In my opinion, if you are a true gamer then

rather than constantly upgrading your computer system,

you should buy a PlayStation 2 or an Xbox gaming console.

All games for these platforms run smoothly and you don’t

need to spend money on ‘upgrading’ these consoles to play

any new game. Also, most games released today have ver-

sions for the Xbox and PS2.

Sushant

Via e-mail

Dear Sushant,
Immersive graphics and multiplayer gaming are no longer the forte
of the PC, with the current-generation game consoles having
caught up in these departments. Therefore as you've rightly point-
ed out, if gaming is all you need to do, then buying a console makes
more sense, especially considering that most games are now cross-
platform. But you need not fall for the six-month upgrade cycle as
no game developer is foolish enough to create and release a game
that doesn’t run on the majority of PCs sold in the last couple of
years. Thus DOOM III when released, will run on a GeForce2-class
graphics card, albeit without all the bells and whistles.

Eager to not serveDear Vinit, 
Your December editorial hit the nail on the head—most of the com-

panies in India, even multi-nationals, have taken the law in their

hands and are only interested in selling their products: once an item

is sold, the customer no longer exists for them. Cheers to you for

raising this issue. I hope it will make companies get up and take a

long hard look at their service policies.Trevor
Via e-mail

Hi Trevor,
Yes, companies still take their customers for granted. And what
bothers me most is that their frontline support personnel, who
interface directly with their customers, are often the weakest links
in the organisational chain. Also things get trickier in a country like
ours where we don't have a 'working' mechanism of seeking com-
pensation. Hopefully more and more companies will awaken to the
fact that providing value to their customers is the only thing that

Q. Would you replace Backbyte with a monthly 
technology quiz?

Your vote counts

Thankfully, Backbyte still finds a place in the magazine (and 
our readers’ hearts)

38%
Yes

54%
No

8%
What's Back-

This month’s question:

JANUARY 2003

What more would you like featured in
the ‘Off the Shelf’ section?

Log on to www.thinkdigit.com and vote on it

Credit overdue

Dear Vinit,

In the news article titled ‘What's in a Name?’ in the November

2002 issue, Linux was addressed as

“Linus Torvalds’ operating sys-

tem” and you mentioned

that Richard Stallman

wants it to be ‘renamed’ as

GNU/Linux. The OS we

know today as Linux was born out of the GNU project, conceived

by Stallman in 1984. It is very strange how Torvalds, who only

contributed in creating the kernel, is today considered to be the

creator of the entire Linux system. The whole ideology behind

the Linux OS remains concealed from the users—that of software

created free, by and for the masses. In that context, I think there

is complete justification in calling the system GNU/Linux to give

credit where it is due.

Baishampayan Ghose, Free Software Foundation, India

Via e-mail

Dear Baishampayan,
While the collective work of GNU programmers was of paramount
importance in conceiving Linux, the fact remains that singular per-
sonalities will often take the credit for a collective’s blood, sweat and
tears. Take the case of Microsoft—how many of us remember that
Paul Allen was the co-founder of that company? Both Windows and
the Redmond giant are synonymous with Bill Gates; piling credit on
one individual may not be fair to others but it is a fact of life.

Categorise this!Dear Vinit,
‘Brilliant’ is the only word that came to my mind when I
got the December issue in my hand. I reside in Colombo,
Sri Lanka, and every month relatives coming from Chen-
nai get the magazine for me. Digit is an extremely useful
and informative magazine and I have gained a lot from it.
I base my buying decisions on your test results and as such
I was hoping you would test products from categories such
as DVD-RWs, FDDs, LAN cards, projectors and dish anten-
nae, among others.
Mohammed Ameer SahibVia e-mail

Dear Mohammed,
Whoa! Some of the categories that you have mentioned, such
as  DVD-RWs, are based on very nascent technologies and
there aren’t enough products available in the market to do a
full blown comparison test. Others like LAN cards perform sim-
ilarly, irrespective of brands; while floppy drives are simply
dead. Even though we constantly try to add new product cat-
egories, I’m sure Digit will not be doing comparison tests on
dish antennae in the near future.
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A bundle of joy 

Dear Editor,

Every special issue of Digit brings

with it some truly explosive packag-

ing that simply blasts away any other

national or international technology

magazine. The packaging of the

December 2002 issue reveals a

unique blend of artistry and innova-

tiveness crafted with intricate preci-

sion. Plus the concept of distributing

the Six Essential Handbooks in a sep-

arate, specially designed pouch is

especially praiseworthy.

Arindam Sarkar

Via e-mail

Dear Arindam,
We did plan on doing something
extra special for the December 2002
issue. But it took more than just plain
hard work; a few ‘unplanned’ mistakes
and serendipity were big contributing
factors in the final design of the packag-
ing as well. In the end we’re glad you

We also need to swallow a
bitter pill with all the bou-
quets we’ve received for the
December 2002 issue. We
messed up the contact
details for quite a few prod-
ucts:

■ On Page 76, the Logitech
Cordless Freedom Optical has
been incorrectly priced at 
Rs 3,380. Its correct MRP is 
Rs 6,950

■ On Page 135, the price of
Age of Mythology has been
incorrectly listed as Rs 1,299.
It is actually priced at Rs
2,535. Also the game was
developed by Ensemble Stu-
dios, is published by Microsoft
and the Web site is www.age-
ofmythology.com

■ On Page 135, the book
reviewed is not Foundation
Illustrator 10 but Director 8.5
Studio

■ On Page 66, the contact
details of Macromedia
Dreamweaver MX have been
incorrectly stated as Wipro
Infotech Enterprise Software
Group, when they should
have been Macromedia 

■ On Page 48, the contact
details for the Gainward
GeForce4 card are incorrect.
Contact Mediatech India at
2936696, 2014083 or

Goof Ups

Saving data, one PC at a time

Hello Digit,

After reading the ‘Data Watch’ arti-

cle in the November 2002 issue,

I have successfully configured a

backup solution on both my

home and office PCs. Please

pass on my good wishes to

Mahesh Benkar for the won-

derful illustrations that graced

the article.

Jayanth Vasisht

Via e-mail

Dear Vinit,

Thanks to your ‘Data Watch’ article I was successful in

recovering important data files, which I had mistakenly

deleted. Also the graphics and illustrations in the article

were simply superb. Keep it up!

Rasna Mehrotra

Via e-mail

Send your letters marked ‘Readers Letters’ to the Digit office: 
D-222/2, MIDC, TTC Industrial Estate, Om Sagar Building, Nerul, Navi Mumbai 400 706, 

Phone: 022-7629191/9200  Fax: 022-7629224 
E-mail: readersletters@jasubhai.com 

Short Bytes
Great issue!
Dear sir,
Your December 2002 issue
was simply irresistible. The
100+ Tips & Tricks CBT was
especially mind-blowing.
Three cheers to the Digit
team! 

Krishna Kumar Khatri
Via e-mail

Price not justified
Dear Vinit,
I am a regular reader of
your magazine, but your
December 2002 issue disap-
pointed me in terms of the
price—Rs 150! The price tag
is not justified at all.

Souvik Sinha
Via e-mail

No representation without taxationDear Sir,
I would like to add to your reply for the ‘Strange Cus-
toms’ letter on Page 29 of your December issue. I was
recently checking up on the price of the Asus GeForce4
Ti 4200 Deluxe graphics card and found that it sells for
$150 (Approx Rs 7,500) on the Net, but is priced at an
exorbitant Rs 18,000 in India! The local importer has a
simple reason: “The product sells slowly and in low
quantities. Thus if I don’t charge a premium, I cannot
make money.”
Ajay Puri
Via e-mail

Dear Ajay,
Unfortunately, we live in a commercial world where 
businesses follow either the ‘high volumes, low mar-
gins’ or ‘low volumes, high margins’ model. Factor in
some ridiculous custom duties and you’re left believ-
ing that nobody cares for the sentiments of Indian con-
sumers who simply want to get their hands on the
l a t e s t  
hardware and are willing to pay the same price as their
American brethren, purchasing power parity between

Messiah of gamingHi,
I’ve been reading Digit for along time and you guys aredoing a tremendous job. Now Ihave another reason to cele-brate: Skoar! I read an ad in theDecember issue and I’m reallyexcited about it. Can you giveme some more details?Vinodh

Via e-mail

Hi Vinodh,
Well, if you like playing games then
there's plenty to celebrate about.
Skoar! will be hitting news stands in
January 2003 and will be the fountain-
head of the latest and greatest game
reviews, breaking news on the hottest
upcoming games along with loads of
cutting edge digital paraphernalia. Not
to mention the fact that there will be
three, yes THREE, CDs full of the coolest
game demos and addons you can get

Dear Rasna and Jayanth,
Accurate, efficient backing up and restoration of data is a very
important issue that we hopefully did justice to within the story.
And yes, we cannot discount Mahesh Benkar's design wizardry
which was instrumental in bringing it to life; he consistently
and pleasantly surprises us with his repertoire of design skills.

JANUARY 2003

Illustrations: Ferzana Cooper 
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TThhee  PPoowweerr  ooff  KKaaiiii
With miniaturisation emerging

across every form of technology, it
comes as no surprise that there has
been tremendous advancement in

the field of portable computing over the past year.
Ultra portable Tablet PCs and powerful handhelds
are getting closer to the end user with enhance-
ments in fabrication technology and faster, more
power-wise processors. This trend is exemplified in
India by the announcement of the Simputer, bring-
ing portable computing closer to the masses.

The newest device to hit the Indian handheld
computing scene is the Kaii, an indigenously
developed handheld that boasts robust process-
ing power, affordability and a high level of con-
figurability, making it suitable across a varied
cross-section of application areas. We spoke to
the developers of the Kaii. Following are excerpts
from an e-mail interview:

■■ What was the inspiration for Kaii?
The idea originated in August 2001. We wanted
to develop an intelligent, low-cost and flexi-
ble handheld computing platform that would
serve as an engine for a variety of vertical appli-
cations. These include a PDA, inventory, e-gov-
ernance, ticketing, GPS, etc.

■■ What is your vision for Kaii?
The Kaii is a multi-purpose handheld computing
platform, which can serve a variety of market
needs and applications. It has always been our
vision to make the platform available to both
hardware and software developers and original
equipment manufacturers (OEMs) who can take
it to new markets by applying their own unique
ideas and skills. 

■■ What are the advantages offered by Kaii
apart from the obvious advantage of cost?
Kaii is not merely a PDA. Its biggest advantage
is its flexibility, USB Host control and state-of-art
power management. Another unique feature tar-
geted at larger  OEMs is the concept of mass cus-
tomisation, where the OEM can choose the hard-
ware and software components. No handheld man-
ufacturer has offered this concept before. The exist-
ing Palm and Pocket PC devices offer only a USB
client, while Kaii has both, host and client. Through
the USB Host, external USB devices such as the
mouse, keyboard, hard disk and printer can be con-
nected. For instance, when the Kaii is coupled with
an 802.11b Wi-Fi card, an OEM can offer a special
purpose corporate workstation for under Rs
15,000. This workstation can be complete with all

office automation software, an e-mail client, a
world standard Web-browser and a Sun certified
Java Virtual Machine. Companies such as Insur-
ance and FMCGs can equip large sales forces with
a Kaii, loaded with their custom applications. This
can be carried to client locations, the orders taken
on the spot and the person can upload the orders
to the corporate ERP using Wi-Fi when he or she
returns. The Kaii can also be included in the hand-
held GPS receiver, e-books and information kiosk
markets.

■■ How does it compete with other PDAs in
functionality and power?
In the PDA avatar, the Kaii offers all the power
and multimedia features of a Pocket PC. Like Palm
OS and Microsoft Pocket PC, the standard soft-
ware includes MS Office compatible software for
word processing, spreadsheets, presentations, a
Web browser, an e-mail client and a Sun certified
Java Virtual Machine. Feature wise, KAII is highly
competitive as against a Palm or any model of
Microsoft Pocket PC. It also has many games such
as Asteroids, Tetris, etc., and software to sync with
MS Outlook. It has a CF card slot, a Multi-Media
Card (MMC) slot and infrared. Additionally, the
Kaii is ‘world ready’ due to its double-bit ability
and has language packs for most languages avail-
able either for free or for a charge from the vast
Linux community. In addition, the USB Host
expands and extends the Kaii PDA’s functionality.

Most companies sell their PDAs at low price
initially and then cash in on the proprietary
accessories. A Kaii owner is given many non-pro-
prietary and hence, inexpensive choices.

■■ What kind of response has it received? Do
you plan to take it to foreign markets as well?
We are overwhelmed by the kind of interest gen-
erated. It was designed for the global community
of which India is a part. We took a lot of inspira-
tion from India in the diversity of applications
required, as well as the cost competitiveness
required. Kaii is a platform for people to bring
their ideas to fruition. Its concept has generated
interest from all corners of the world.

■■ Who is your target audience?
In the PDA avatar, the audience is those who
seek value for money. As a platform, it is for all
the hardware and software developers, and
OEMs who have a unique idea and need a plat-
form to help bring it to fruition.

As communicated to Marco D’Souza

We wanted
to develop an
intelligent, low-
cost and flexible
handheld
computing
platform that
would serve as
an engine for a
variety of
vertical
applications

“

”

Devesh R. Agarwal, Managing
Director, Infomart (India) Pvt Ltd
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Three years into the millenni-
um, and we stand on the verge

of yet another persuasive wave of
technology as it entwines itself
into the very fabric of our lives.
What was once considered high
technology is now accessible to a
vast cross-section of users, rang-
ing from teenagers to grandpar-
ents, as much as it is to technolo-
gists and scientists. We are used
to an infusion of gadgets that
have made themselves indispen-
sable—be it cellular phones, ATM
cards or ready access to the Inter-
net. Let’s take a look at some of
the technologies that are going to
be instrumental in furthering this
acceptance of technology in our
day-to-day lives.

While high-speed networks draw on all the advantages of your office Eth-
ernet, high-bandwidth wireless networks spell untold levels of conven-

ience and portability. With 802.11b (WiFi) networks already in place in many
parts of the world, and present in numerous home and office networking
equipment, there’s no looking back. The 54 Mbps bandwidth of such net-
works provides adequate room for data-hungry applications such as stream-
ing audio and video and high-volume file downloads. Also, the capability of
providing up to eight discrete channels in the specification lets the network
handle different types of data streams. While there were speed breakers in the
shape of slow acceptance for the 802.11a standard and compatibility with
other wireless standards, today, both the 802.11a and 802.11b standards can
be merged into a single device. Another hybrid variant of the 802.11x stan-
dard is the 802.11g, which boasts of bridging the gap between the 802.11a and
802.11b standard, enabling them to talk to each other. On the horizon are
other exciting wireless standards such as Ultra Wide Band (UWB) wireless 
communication. With its significantly higher levels of security, UWB is 
likely to gain wider recognition and acceptance in the forthcoming year.

The wire-free network

MARCO D’SOUZA
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Cellular technology already has a strong foothold in our daily lives. While speech is still the main
medium for cellular networks, many upcoming technologies are built to open the doors to newer

forms of media such as audio and video broadcasts, videoconferencing and advanced messaging sys-
tems. While devices that support these technologies are still beyond the reach of most users, it is just
a matter of time before this technology becomes widely accessible.

GPRS is among the most significant cellular technologies this year. It is gaining acceptance among
service providers as well as end users. With the ability to handle data transmission at a maximum of
144 Kbps, this technology is a taste of the potential of a handled device to deliver more than just voice
communication. This year, expect to see the proliferation of GPRS-based networks along with the
advent of newer standards such as EDGE, which marks an entry into the 3G realm of 2 Mbps cellular
bandwidth. 

While these standards will take time to stabilise and reach the user, there will be a consolidation
in technologies where standards such as Wideband Code Division Multiple Access (WCDMA) will unify
cellular communication standards, making data, voice, videoconferencing and multimedia messaging
a part of everyday life.

Pulsing at the very core of our systems, processors have grown in strength to become
massive number-crunching devices. Not too long ago, the prospect of having a

computer that could allow you to create and edit your own video on your home com-
puter was unheard of. But today’s processors are more than able to handle power-hun-
gry applications such as real-time audio and video processing, and bleeding-edge
games with smoother levels of multitasking. 

The year 2003 will see a slew of processors armed with higher clock speeds,
advanced fabrication processes and newer technologies to tackle new-age applica-
tions with greater ease. AMD and Intel are going to herald 64-bit computing with their
new processors aimed at the desktop and server segments. Aided by technologies such
as Banias and better fabrication processes such as 0.09-micron technology, manufac-
turers will be able to pack in more transistors into processors, resulting in greater fea-
tures and capability and higher integration of components. Besides the desktop com-
puters, advances in processor fabrication will be reflected in handheld devices too—
with clock speeds of up to 400 MHz, handheld processors will break new ground in
portable power without sacrificing on battery life.

Processing powerhouses

Communication unlimited

The storage field has seen a lot of excitement in the past year. Hard disks already
offer as much as 300 GB capacity and the bar for even entry-level drive

capacities has been raised—the end of 2002 saw 40 GB drives paving the way
for 60 GB ones. In 2003, advancements in fabrication technology will allow for
even larger capacities to be integrated into the same form factor and price range.
New technologies such as IBM’s Pixie Dust allow the fabrication of devices where
smaller magnetic domains can be reliably created and retained on the hard disk platters.
This allows the disks to have storage densities of up to 100 billion bits per inch—that’s four times
the present capacities! You can look forward to hard disk drives with capacities beginning at 400 GB
and notebook drives with up to 200 GB capacity!

On the optical drive front, Blue Ray is all set to redefine optical storage where standard 8 cm optical disks will boast of a 27 GB
capacity. With many manufacturers already equipped to produce these drives, the only await is for the standards to support these
technologies to be finalised. Another promising technology that is making its present felt is Recordable DVD drives. Given its supe-
rior storage capability and falling prices of hardware and media, this will become very popular.

Storage unbound

JANUARY 2003
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The code that runs our desktops, servers and operating sys-
tems has seen a visual metamorphosis over the past year,

with increasin stress on better looking and more intuitive inter-
faces. Things have changed under the skin too, with stronger
protection against external threats, faster networking and sup-
port for new hardware. Through it all, the familiar ‘desktop’
metaphor has remained with the folders, recycle bin and 
wallpaper. 

While there is no sign of breaking away from this metaphor,
upcoming OSes will offer greater levels of stability and interfaces.
They will also serve as a platform for unifying new-age applica-
tions such audio and video editing, better media file management
and a better broadband experience. OSes will also move into the

64-bit realm to complement the arrival of 64-bit processors and
applications. 

On the desktop front, Microsoft’s new OS, codenamed 
Longhorn, boasts of a brand new interface, a powerful new data-
base-like file system, support for Palladium technology, as well as
provision for 3D hardware for a more realistic and 
visually rich interface. On the Linux front, the launch of 
United Linux assures compatibility and higher ease of use. Other
distributions of Linux will also focus on the 
end user where user-friendliness will be enhanced. The OSes for
mobile devices will also change to offer stronger multimedia sup-
port—the upcoming versions of Microsoft Pocket PC 2002 and
Palm OS 5 support faster processors, full audio and video.

Apart from the processor and the motherboard, peripherals and other system compo-
nents are also getting faster and are demanding greater levels of bandwidth from inter-

faces—both internal and external. While the year gone by has seen advancements in the
speed of interfaces such as ATA and USB, this trend will continue with greater performance
through innovations in the design itself. 

Serial ATA is one such standard that will make a big appearance this year—with a
150 MBps bandwidth, this interface is faster than any existing IDE interface we have
today. To corroborate this fact, there is no future roadmap charted out for the parallel
ATA standard.  Since Serial ATA uses thinner connecting cables, there will be far less 
clutter in your system with greater cooling and therefore, more stable performance. 
Several hard disk manufactures have already launched hard disk drives based upon 
this standard.

On the external front, USB 2.0 took time to gain acceptance during the beginning
of 2002. Compared to USB 1.1’s paltry 12 Mbps bandwidth, USB 2.0 features a 
bandwidth of 480 Mbps allowing for fluid operation of devices such as DV cameras,
external storage devices, scanners, etc. With strong support from manufacturers of moth-
erboards as well as peripheral devices, you can look forward to the USB 2.0 interface
peripheral devices. 

Operating systems

Connectivity

Advancements in graphics processing hardware have made cartoon-like game
characters a thing of the past. The buzzword today is visual computing and

this is apparent from the current generation of games, conventional application
software and operating systems. With today’s OSes drawing on the capabilities
of the graphics processor for even rendering a shaded and bevelled scroll bar, our
entire experience with computers is moving closer towards a visual realm.

In the race for launching the fastest graphics card, the two bigwigs in
graphics processors, ATi and nVidia, are going all out on the promotions and
enhancements. This is supplemented by the fact that even upcoming graphics
APIs such as DirectX 9 and OpenGL 2.0 boast of capabilities that will bring cin-
ema-quality graphics to your computer. The year 2002 has already given us a
taste of things to come with ATi’s Radeon 9700. This year, we will witness some
more powerful graphics solutions with products such as the GeForce FX and
ATI’s upcoming R10000 graphics processor.

The visual realm
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After the processors, probably the single most important component that spells computing performance is the memory. The past
year has seen rapid advancements in the memory scene—the RDRAM and the DDR camps have been churning out faster mod-

ules with denser capacities. 
While both have gained acceptance, the future clearly stands in

favour of DDR memory. It has been very visible in the AMD and Intel plat-
forms and its newest iteration, DDR2, is poised to be the memory plat-
form of choice for both Intel and AMD. Making its way to this market is
the DDR-III, which yet again promises to provide a worthy complement
to the forthcoming processor platforms with bandwidths ranging from 
6.4 GBps all the way to a blistering 25.6 GBps—faster than the PC4300
DDR2 memory bandwidth of 4.3 GBps. This year will see DDR-III appearing on
motherboards across the Intel and AMD platforms.

On the topic of density, these RAM modules have already touched the 512 MB mark, spelling good
things for the server and enterprise segments. However, with future operating systems and application programs
demanding greater amounts of memory, greater densities will also mean lower costs per module.

No longer is the desktop the only place to get work done. The newest slew of handheld
devices—cellular phones, Tablet PCs, handheld devices and new-age notebook comput-

ers—have seen advancements in processing power, battery life and storage capacities, result-
ing in an array of fairly advanced capabilities. Cellular phones such as the Sony Ericsson T68i
and Nokia’s Communicator are prime examples of this yet unrealised potential. 

This year will see an explosion in devices that let you take your communication, 
documents and even Internet on the road with you. Devices that incorporate imaging
capabilities such as the Sony Ericsson P800 will be widespread in this year. Handheld
devices based on the Windows Pocket PC and Palm platform have already demon-
strated support for seriously powerful processors with full imaging, audio and video
capabilities.

In 2003, also watch out for the emergence of Tablet PCs—the next mobile com-
puting device. Delivering high levels of user-friendliness and functionality, Tablet
PCs, along with forthcoming cellular and handheld devices will revolutionise mobile
computing.

They’ve been around for the longest time—CRT monitors are
trusty devices that have lasted all through the years, with very

little of the underlying technology changing. However, LCD dis-
plays, once the devices of the privileged, are now within our budg-
ets due to enhancements in fabrication processes and yields. With
all the advantages of smaller footprints and greater brightness
and contrast levels, LCD technology is fast catching up on the
price and resolution front as well. The year will see the arrival of
LCD displays that are affordable, with screen sizes in the 14 and
15-inch range.

One of the display technologies to look out for is Organic
LED. Displays based on this technology eliminate the need for a
power source for backlighting, spelling significantly lower manu-
facturing costs along with higher contrast and brightness levels. Its
response time will be about 1000 times that of present-day LCDs—
no more blurring even when viewing fast-moving images or large
displays!

The memory angle

Computing to go

Display advancements
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Xentex FLIP-PAD Voyager
Your complete companion
The portability of a laptop with the power and workspace
of a desktop—the Xentex FLIP-PAD Voyager is a device
that offers just this. This unique device with its foldable
design provides an unprecedented viewing area with a
dual screen work environment. Woven around an 1.2 GHz
(also available in 1.6 GHz) AMD Mobile Athlon processor,
512 MB of RAM, a 40 GB internal hard disk with an 80 GB
swappable hard disk, dual 13.3-inch TFT screens that offer
a total resolution of up to 1536x1024, this mobile device
offers workstation-class and touchscreen functionality. It
has four USB ports and FireWire, along with integrated
Ethernet and modem. If you miss your graphics
workstation while in transit, this laptop will keep your
productivity levels up.
Web site: http://www.xentex.com/voyager/

▲ ▲ Ellula Inflatable Speakers
Not just hot air
These inflatable speakers from Ellula radiate sound
from their surface, which makes them omni-
directional. They come in three funky shapes, one
of which is even shaped like a Budweiser beer can!
Since size is not a factor, these speakers make the
perfect accessories for your mobile presentations
and portable audio player. They bring along a
battery pack, an adapter and an amplifier. If you
want all ears, these are the speakers to pack.
Web site: www.inflatable-speakers.com

▲▲

Gadgets that
complement 
your style.
Go ahead,
Show off!
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Sony PEG-NX70V Clié
Power palm
Sony’s new handheld stuffs fistfuls of
functionality into an intelligent clamshell case.
Sporting a 200 MHz StrongARM processor, this Palm
OS 5-based device supports digital video (MPEG-4)
and audio playback, a voice recorder and an
expansion slot for wireless network connectivity. It
incorporates expandable 16 MB of RAM and the
integrated camera can capture 640x480 resolution
images with its 3,10,000-pixel sensor. Say bye-bye to
tinny sounds, as this handheld features a speaker
that can produce polyphonic alarms and reminders

that can be user-recorded. With its 320x240 colour
screen and full multimedia support, the Sony

PEG-NX70V is the handheld to trust your
data with style.

Web site: www.sonystyle.com/micros/clie/

JANUARY 2003

Nokia 3650
Keeping us connected
Nokia departs from the norm once more, incorporating a
completely new design while infusing technology and
functionality into the 3650. At its heart beats a GPRS cellular
phone that supports data transfer speeds of up to 40.2 Kbps
and runs the Symbian OS, which can run Java-based
applications and games. It sports a crisp 176x208 pixel colour
display that can play MPEG-4, Real Audio, Real Video, WAV
and MIDI formats. It also features SMTP and POP3 e-mail
access. Additionally, it has a built-in camera that can capture
640x480 colour images that can be sent to other users if the
network service allows it. The 3650 contains 4 MB of internal
memory and is also Bluetooth and infrared capable.
Web site: www.nokia.com

Creative Nomad Jukebox Zen
Nirvana on the move
If you thought hard disk-based MP3 players were bulky and
awkward, think again—Creative’s new Nomad Jukebox Zen
incorporates a whopping 20 GB hard disk drive in a
device small enough to fit into your pocket—around
5,000 MP3s can be stored at 128 Kbps! This sleek
player integrates a FireWire port and a USB port. The
device can store songs in categorised playlists that
can be easily and speedily accessed through the
scrolling button and intuitive icon-driven interface. 
Web site: www.nomadworld.com/products/jukebox_zen/

▲ ▲

▲▲

▲▲



Do you want to break free of the
corporate world, skip the coffee
machine and step off the rumour

mill to contribute to the economy on
your own? 

The latest trend of freelancing is
more conducive to an independent work-
er. With cities growing in every direction,
much of one’s time is spent in commut-
ing. Strict work routines, tyrannical man-
agement and the temptation of better
opportunities around the corner have
many of us thinking of a life of work 
at home.

The idea of working for yourself
sounds sweet, but there are a lot of things
to consider before you set out on your
own. The primary one is whether your

work gives you that kind of freedom. Cer-
tain jobs, by their very nature require you
to coordinate with a team. While the
Internet has made communication easi-
er, it does not do away with all the barri-
ers. The IT and media industry, however,
offers great scope of working from the
confines of your home—copywriters,
writers, network consultants and Web
designers thrive professionally in their
own habitat.

Players on the field
Amith Ellur, a certified Microsoft con-
sultant, has been freelancing for various
companies for the past six years. His work
ranges from setting up a smooth work-
flow process to simple database opera-

tions. His work hours and fees depend
upon the nature of work. The reason he
chose to freelance, Ellur says is, “If you
are an employee, people recognise the
company you belong to and not the indi-
vidual; if you are a freelancer, people
recognise you and your work.”

Chandan Naik, a layout artist, has
another reason to be in the freelancing
game. He lives in Borivili, a far-flung sub-
urb of Mumbai, which makes his travel-
ling time go up to anywhere between 2
and 3 hours in any direction to get to
work. This is a large chunk of his waking
hours, considering that his job would
involve late nights. Moreover, his work-
load would usually avalanche during a
certain time period, instead of being
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Freelancers are entrepreneurs by themselves, so they have to keep 
learning and updating their knowledge to provide quality solutions on 
time, everytime

—Amith Ellur, Microsoft Consultant
“

Long, hot hours of travelling, difficult work environments and slave drivers are all passé. Be your
own boss, work in the comfort of your air-conditioned, music-filled room and make big bucks!  

MMee,,  MMyysseellff  aanndd  WWoorrkkiinn’’MMee,,  MMyysseellff  aanndd  WWoorrkkiinn’’
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spread evenly over a month. Sailesh
Peringatt, a programmer, prefers to
freelance for the interest quotient. It
allows him to pick and choose inter-
esting jobs. “This way, you tend to
learn and grow very fast in terms of
knowledge as you are not limiting
yourself,” says Peringatt.

Such a work scenario may mean
professional schizophrenia—where
you are a copywriter in the morning,
a technical writer in the afternoon
and editor in the evening—but it
assures intellectual stimulation. For
Naik, it means working on a large spec-
trum of magazines. Diwali usually means
working on special editions of Marathi
magazines, while year-ends see him
working on IT publications. Each maga-
zine has its own style and focus and this
diversity is what keeps Naik intrigued.

Since working on your own takes
away one very big advantage that a cor-
porate house offers—that of frequent
training sessions that keep one abreast of
the latest trends, freelancers have to rely

upon themselves to update their skills
and knowledge. “Most of my free time is
spent learning new languages and
processes so as to handle any kind of
project,” says Peringatt. Ellur agrees:
“Freelancers are entrepreneurs by them-
selves, so they have to keep learning and
updating their knowledge to provide
quality solutions on time, every time.” 

Another thing an independent worker
can’t fall back on is a support system. Cor-
porate clients have well-drawn legal con-

tracts that can be quite daunting to a
newbie. While such paperwork assures
that the freelancer isn’t exploited, it
can also be used against the individual
worker in case the work is not deliv-
ered on time or isn’t up to a certain
quality. “Corporates are well-equipped
to handle freelancers who don’t deliv-
er quality. A freelancer is most of the
times a one-man show with no legal
assistance, whereas corporates have
access to virtually everything. So if a
freelancer doesn’t deliver quality, the
client can stop payments and also get

legal clauses in the way. Not to mention,
that they can give you a poor recommen-
dation, which will hinder your future proj-
ects,” explains Ellur.

Independent working doesn’t neces-
sarily translate to working from home.
Just like in a 9-5 job, the client is the king
and your work habits rotate around him.
The type of project you are working on
decides your location of work. “Most of
the times clients don’t want the project
details to go out of the office boundary,

The advantage
for me over 
an employed 
individual is 
that I can play 
different roles 
at all possible
levels

Amith Ellur
MICROSOFT CONSULTANT

“
”

The Internet is brim full of Web sites
that claim to offer big money with
minimum work hours. But like

everything else on the Net, many of
them are just database mining sites that
require you to sign up for a fee or pay for
the training pack. The exact nature of the
work is ambiguous. But some offer gen-
uine solutions for those sitting at home. 

Some Web sites offer data processing
jobs such as converting books or PDF for-
mats into online documents and other
text conversion jobs. Other jobs include
medical transcription, which involves
receiving dictations of medical notes and
then transcribing that data into a digital
format and rerouting it to the respective
doctor. These jobs require you to have
some kind of scientific or medical back-
ground to aid your understanding of the
scientific terms. Other work opportuni-
ties include basic data entry, replying to
e-mail, receiving mail responses, pursu-
ing helpdesk on mail and chat. This is
quite on the lines of a Call Centre.

Some sites offer to pay for just click-

ing on advertisements to assure advertis-
ers of user response. Given below are-
some sites that let you work from home:

Elance.com (www.elance.com) is a work-
from-home site. As cited by one end user,
for a particular project you might have to
pay Rs 6,000 towards registration, but at
the end of it you could earn up to 
Rs 15,000. Even though you have to pay
a certain sum at the commencement of a
project, this amount is usually recovered
by the end of the project.

Guru.com (www.guru.com) guages your
potential and directs you to the right job. The mode of payment can be chosen

between a monthly salary and an hourly
rate. They have a ‘Workstyle at a glance’
section, which is designed to help the user
and the staff learn more about the pre-
ferred work environment. Once your skills
are assessed and you’ve entered the cycle,
it is fairly easy to find the right kind of
work. Make sure to read the clauses asso-
ciated with each type of job.

Datamatics.com (www.datamatics.com)
is one of the pioneering work-at-home
sites in India. However, a previous user

The Website Story
‘Now you can work on your own terms’... or so they say

Elance.com is one of the popular choices of
freelancers

Guru.com has a team of experts that evalu-
ates your potential



hence you have to make use of their
resources,” explains Ellur. Naik, on the
same note, needs to coordinate with the
editorial team of the magazine he works
on and hence is required to be at the
client’s workstation. But Peringatt, being
a programmer, can work from his home.
His typical hours are from 11 am to 6 pm
and then again from 11 pm to 3 am. “The
most productive hours are during the
night with absolutely no disturbance.
Also, the Net is quite fast then,” he
explains. But he generally prefers to
“work till I drop, as I’m working for
myself. It is very important that I finish
work as soon as possible, so that I can
move on to other interesting stuff”. Naik
has a better work discipline. His work
rotates around the other people in a
given team and hence it isn’t completely
at his convenience, though he can
choose a particular project depending on
his personal ability to handle it.

Show me the money
The crucial concern any individual set-

ting out on his own faces is
that of money. After all,
money is the reason most of
us are in it. A regular job
ensures a salary deposit in the
bank at the end of the month.
With freelancing, the work-to-
pay ratio is always negotiable
and never assured. How one
discusses the pay packet again
depends upon the nature of
the work: Naik prefers to be
paid by the day as it works very well with
his work scenario since he is required to
work from the client’s site for unpre-
dictable hours, with focus more on the
quantity of work rather than the quality.
For Ellur, charging depends upon the
project specifications and the customer
comfort. “In cases where the customer
himself is not clear about his require-
ments, it is advisable to charge by the
hour where the specifications are frozen
on a daily basis. When the customer is
clear about the output, you can charge a
lump sum,” says Ellur. 

Peringatt, on the other hand, charges
for the work put in and not the hours
spent working, “so I don’t have to keep
reporting to the client on how much
work was done in a day, as I may be work-
ing on other parallel projects.” He con-
tinues, “Sometimes, charging by the hour
is not justified. If the developer is skilled
and has experience, it will take him
much less time to finish the project com-
pared to an inexperienced developer who
would take months to research. An
umbrella amount takes care of all these
factors. The client is informed of a date
when I will be able to present the demo
or the deliverables and that date is
adhered to.”

So how much can you hope to make
on your own? And is this payment
assured? Peringatt has had many dis-
tasteful experiences in this regard—“Get-
ting money out of the client is a big
headache. The money invariably gets
delayed for some reason or another.” But
Ellur begs to differ—he maintains that
clients pay, at even a premium, provided
that you deliver quality on time. A novice
freelancer can hope to earn between 
Rs 10,000 to Rs 15,000 in any field,
depending on the kind of contacts he or
she has and the quality of the work. A
seasoned IT consultant, in the opinion of
Ellur, can make anything from Rs 30,000
to Rs 1,00,000 a month. A layout artist
can make around Rs 7,000 throughout

the year and up to Rs 15,000 during the
end of the year and festivals when mag-
azines get out their special editions. 

Bag of tricks
What you need to work on your own,
besides a PC with all the peripherals of
your trade, is a good database of con-
tacts and people who will give you work.
If you’ve already been working for a
while, people are already familiar with
your work and the trust hurdle is
bypassed. Once the ball is set rolling,
each project well delivered will ensure
future work, as work relations with free-
lancers are based on trust. In the words
of Ellur, “Being a freelancer, if you have
five satisfied customers, then you are
assured five more job offers for the
future.” You can also tie up with a Web
site online that trades services with
companies that are on the lookout for
them such as www.elance.com and
www.freeagent.com. These sites are meeting
points for those who are seeking specif-
ic professional services and those who
can provide them (see box, ‘The Website
Story’).

The availability of projects, like in
any other profession, depends on the
overall economic scenario and your own
skill sets. The key is to constantly rein-
vent yourself and keep abreast of the
skills and technologies in your field.
Along with that, you need to cultivate a
firm discipline and mark out your work
hours. Always understand the nature of
the project to its last detail so that there
are no misunderstandings that could
wash away hours of your work. With
that, also calculate a rupee per work unit
ratio that you can justify to your client—
you don’t want to come across as exorbi-
tantly priced, nor should you sell your-
self short in anyway. Once you have
these few things in place, all you need to
do is work hard and the money will keep
streaming in.

RACHANA SANGHANI and MITALI PAREKH
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I am my own
master; I only
do things that
interest or
challenge me

Sailesh Peringatt
SOFTWARE PROGRAMMER

“
”

complains that the site no longer offers
the opportunities it initially did. Some
unpleasant experiences by a few users
prompted them to quit, but there are
others who continue to be influenced by
the concept.  

Many of these sites operate world-
wide, but the vendors handle currency
conversion and the user is paid in the
local currency. Most of them require you
to pay a registration fee as deposit, which
is refunded once the job is done. This fee
is a precautionary measure to assure
delivery on the scheduled date. In case
you do not submit work at the designat-
ed time, the compensation would be
reduced. This is where you need to be
cautious as most of these services have a
‘do so at your own risk’ clause.

Datamatics.com is a meeting ground for
both clients and service providers
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The Digital Media
Test & Research
Centre (DMTRC)
conducts a series

of elaborate tests to eval-
uate the merit of each
hardware and software
product. To ensure that
our readers have all the
information they need to
make an informed buy-
ing decision, engineers at
DMTRC evaluate and
review the latest hard-
ware, software and technology services in accor-
dance with the most up-to-date evaluation
processes and methodologies used around 
the world. 

Comparison Tests
We use a dual rating system, the first of which is

applied to the Comparison
Tests in which we compare
the performance of products
within a particular category.

Each product is evaluat-
ed under different parame-
ters such as performance,
value for money, features,
warranty and support, etc. 

Weightages are then
applied to the various test
parameters according to
their importance for 
that particular category of
products. 

These weightages are
then used to arrive at an
overall grade for each indi-
vidual product. An overall
grade of A+, therefore, indi-
cates that the product is
close to perfection.

The Awards
Digit awards out-
standing products
by selecting a Best
Performance and
Best Value winner in
each comparison
test. The winner of
the Best Perfor-
mance Award will be
the product that
scored the highest in
the performance seg-
ment of our tests.

This award represents the best performing prod-
uct in our tests and doesn’t factor in any other
parameter such as value for money, features, sup-
port, etc. The winner of the Best Value Award
will be the product that scores the highest in
our value for money parameter which is derived

taking into account the ratio of
a product’s performance and fea-
tures to its price. The product
winning this award offers good
performance at a great price.

In Bazaar
The second part of the rating system is used to
evaluate individual hardware and software prod-
ucts in the Bazaar section. The evaluation covers
parameters such as performance, ease of use,
value for money and the build quality/features of
the product in question and then arrives at an
overall rating. 

Here each of these parameters is given a
weightage of 25 per cent and is rated on a scale
of 5, which is represented by arrows ( ). 

The greater the number of arrows, the better
the product. This simple five-point rating system
is designed to give you an easy-to-interpret
assessment of a product. For example, a product
that receives an overall score of five arrows sig-
nifies an outstanding buy!

How we Test
A new year and a whole new
set of technologies on the
horizon! In this New Year's
issue, we bring you some of
the hottest technologies and
products over a range of cat-
egories. In our comparison
tests, we have a shootout
between 10 laser printers in
the sub-Rs 30,000 category
from six differ-
ent brands. If
you've always
wanted to
buy a laser
printer but were
under the impression that it
would cost a lot, this is the
shootout that will help you
with your decision. 

We have also reviewed a
cross section of some of the
funkiest input devices com-
prising of six keyboards, 10
mice and four keyboard-
mouse combinations fea-
turing some of the newest
technologies like dual opti-
cal sensors, wireless con-
nectivity and even unifica-
tions of the two! Be it gam-
ing, image editing or even
general use, find the key-
board and mouse that suits
you best.

In the Bazaar section, we
bring you reviews of the
hottest products such as
Intel’s newest Pentium 4
3.06 GHz with HyperThread-
ing technology. There are
also a set of digital
droolables here, with the
funky and feature rich Fuji
S602 Zoom digital camera
and the lightweight and
incredibly portable Creative
MuVo portable MP3 player.
Don't forget to check out
peripherals such as the
Canon Canoscan LiDE 20
scanner and Iomega’s
newest 48x24x48x external
USB 2.0 CD-Writer.

In Test this Month
It looks good and the technology is glitzy, but does it do the job?

Excellent: a brilliant combination of price, performance and features—far 
beyond expectations
Good: a good buy, better than most products in its category
Average: reasonably competent but nothing spectacular about the product
Mediocre: does not live up to expectations, needs improvement in many areas
Poor: has serious drawbacks and needs improvement before it can be 
used for its target application

The 5-point Rating System used in Bazaar
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Who needs a laser printer? The answer
is quite simple: if your daily work
routine involves printing a large

number of sheets for office use and more
importantly, you need the printouts real fast,
then you need a laser printer. If you are not
satisfied with your old inkjet printer and are
thinking of upgrading to something better and
faster, and something that still fits your budg-
et, then you need a laser printer. To make the
choice easier for you, we test 10 laser printers
costing less than Rs 30,000. 

IMAGING: Solomon Lewis

JANUARY 2003
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W
hen it comes to choosing a desktop-level
laser printing solution, you must be ask-
ing yourself some questions. Like, will it
fit my budget? Will it be able to print
fast enough? What will the image quali-
ty be like? Well, these questions should

not worry you much because laser printers have evolved from
being bulky, unglamorous pieces of hardware lying in a remote
corner in your office to aesthetically pleasing products that
offer fast printing speeds and great image quality. Laser printers
today are capable of crystal clear printouts at up to 100 pages
per minute—ideal for situations where you need bulk printing
at a continuous flow. To make the choice easier for you, we test
10 laser printers costing less than Rs 30,000.

Laser printers also have a number of advantages over other
printing technologies—they produce superior quality documents
(both text and graphics, in monochrome as well as colour) and
the cartridges are also longer lasting compared to their inkjet
counterparts. Couple this with the fact that you can use a laser
printer over a network, and you have a cost-effective printing
solution for applications where many users use a shared resource
to print from. 

Getting your hands on a printer of your choice should not
be a big problem. Industry bigwigs such as HP, Samsung and
Epson have kept the buyers interested with their impressive prod-
uct line. What’s more interesting is that together with overall
quality, manufacturers have also started concentrating on small
but nifty features such as the LCD display, the inclusion of the
USB and the Parallel ports, the inclusion of a network port and
paper tray holders with one-touch adjustments. 

If you are still not convinced about buying a laser printer, we
test 10 such printers under the Rs 30,000 mark. Go ahead and
make your choice.

Digit Test Process
We tested the laser printers on a test machine comprising of a
Pentium 4 running at 2.8 GHz on an Intel D850EMV2 mother-
board with 256 MB of RDRAM. We used a GeForce3 chipset-based
graphics card and a Seagate ATA 4, 40 GB, 7,200-rpm hard disk
which was installed on the primary IDE channel. The monitor
used was the Samsung 75E and a generic CD-ROM was used for
installing the drivers. The hard drive was clean formatted and
Windows XP was installed. The printer drivers were loaded on to
the OS after connecting the printer under test. Once the test on
each printer was completed, its drivers were uninstalled. The
onboard USB port was used for all printers that featured the USB
interface. For the image quality test, the resolution was kept at a
default 600 dpi. 

Test methodology
The printers were tested on four primary parameters: features (20
per cent weightage), performance (40 per cent), value for money
(20 per cent) and warranty and support (20 per cent). The weigh-
tages allotted to each parameter was used to calculate the 
overall scores.

Features: We looked for usability features such as the type and
number of buttons/controls, LCD display provided and indica-
tors if any. We also checked the build quality and noted the
default paper capacity. Another important feature was the toner
price—we calculated the cost per page keeping in mind its esti-
mated print life. Apart from this, we also considered the docu-
mentation provided by the manufacturers such as quick start
guides and the comprehensiveness of the manuals and other
documentation.
Performance: We evaluated the speed, quality and bulk print-
ing efficiency. To test a printer’s speed, we ran three tests. In the
first test we print-
ed an image file
three times and
noted the aver-
age time taken.
Next, to check
the speed of text
printouts, we
recorded the
time taken to
print 50 pages of
text in a Word
document. Final-
ly, we printed a
Combi docu-
ment in PDF for-
mat and the time
taken to print a
single page was
noted. We also
performed a
bulk-printing test
where we printed
50 pages of text
and checked if
there were any
paper jams or
multiple sheet printouts. 

To test the quality of the printouts, we printed our test image
file and a sectional analysis was done on the printout where we
noted the level to which details were captured in pre-defined
areas of the printout. This was done for both the image file as well
as the Combi document. For checking the quality when printing
text, we used a document containing text with varying font sizes.
The sentence that we used contained all the alphabets from the
English language in both upper and lower case. In this test we
looked for any misaligned or blotchy text and awarded higher
points to printouts that were accurate and readable.
Warranty and support: Here we looked for the type of war-
ranty provided, the number years for which it’s valid, the num-
ber of service centres present in the country and the number of
cities in which they are present. We also checked if the warran-
ty provided is comprehensive and whether a replacement is pro-
vided during the warranty period.

Looking for a workhorse of a printer capable of churning out pages fast, in bulk and cheaply? We test
10 laser printers that cost less than Rs 30,000—Go ahead! Bring one home

This greyscale image was used for testing the
print quality of the laser printers. The image con-
tains a good mix of fine details in different zones
of the printable area. For instance, the area near
the leaves gives a good indication of a printer’s
ablity to pick up details
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How They Fared
Laser printers are capable of churning out large volumes of print-
outs with impressive quality. These workhorses have long been
the mainstay of huge corporations because of their ability to
deliver quality and speed, and now, with prices having gone
down, they are a fairly viable option for use at home and in a
small office.

Features
When it comes to features in laser printers, the equation is sim-
ple: the greater the number of features it supports for easier
paper handling and usage, the higher the points it gets. This
includes a paper in and out tray, an LCD display, a USB port
along with the mandatory parallel interface. It should also sup-
port as high a resolution as possible within the price range and
preferably, it should have visual indicators for paper empty,
paper jam and so on, which would facilitate easier usage of the
printer. Lets take a look at which of the printers did well in
these areas.

1/2 page Ver. AD

Bleed: The region of the page that is beyond the 
marked area within which printing usually occurs.
Buffer: Memory within the printer that stores data from the com-
puter until it can be printed. Buffers vary in size, with the average
for laser printers being around 8 MB. Greater the buffer, the bet-
ter the handling of large print jobs.
CMYK: CMYK stands for Cyan, Magenta, Yellow and blacK and
is a shorter version of the industry standard term, ‘four colour
process printing’. By combining these colours, a printer is able
to print all possible colours. Most full-colour prints that you 
see are created by this method (magazines, brochures, retail
packaging, etc).
Colour Balance: This term refers to the correct combination of
Cyan, Magenta and Yellow required to exactly reproduce the
colours of the original scene or object
Dpi: Short for Dots Per Inch, this is a measure of the vertical reso-
lution of the printer. Higher dpi values (1200 and above) produce
sharper printouts, while lower dpi values (300 and below) pro-
duce images that have noticeable dots in them.
Duplexing: This refers to the ability of a printer to print on both
sides of a paper. This is a very handy way of saving on paper.
However, this option is neither cheap, nor common. An alterna-
tive is to use manual duplexing. In this method, you print the
odd or even-numbered pages first and once the job is complet-
ed, you manually flip the pages over and the printer prints on the
other side.
Interface: This is the type of connection that the printer has with
the computer. Older printers use the parallel interface, but this
has become obsolete. The latest printers use either USB or
FireWire connections as their interface.
LASER: An acronym for Light Amplification by Stimulated Emis-
sion of Radiation, this is a process that produces a very intense
light beam. In a laser printer, this beam is used to fuse the toner,
or ink, onto the paper.
PostScript: This is a computer language or protocol used for
communication between the computer and the printer. The com-
puter sends information about the pages to be printed by the
printer in PostScript format.

Jargon Buster
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Resolution: While buying a printer you should first define
your needs. If you need a device for printing documents at the
maximum possible quality, you should go in for a printer that
supports the maximum resolution (1200 dpi and above). A 1200
dpi printer will give you the capability to print high-quality

monochrome images or complex documents
that include many details. The only

downside is that these high-resolu-
tion printers are anywhere

between 25 per cent and 60
per cent more expensive than
their 600 dpi counterparts.
You can opt for a printer with
a lower resolution of say, 300
dpi, if you don’t intend to print
documents at extremely high

quality and if you need a
cost-effective solution. Out
of the 10 printers that we
received, six supported a res-
olution of 1200 dpi, the

remaining ones supported a resolution of 600 dpi. The six high-
resolution printers were Canon LBP 1120, Epson EPL-5900L,
HP Laserjet 1200, Lexmark E322, Samsung ML-1450 and Wipro
Laser 1540.

Interface: Most of the printers connect to the PC through the
popular parallel interface. But now manufacturers have also start-
ed to produce printers with the USB interface and some even pro-
vide a USB and parallel interface in combination. If you own an
older machine that does not feature a USB interface, a printer
which has only a parallel interface will suffice, but if you own a
newer computer that features a USB port as well as parallel ports,
a USB printer is preferable. All the printers in the comparison sport-
ed a USB port, but the HP Laser 1000 used a USB-to-parallel port
interface and, integrating the old with the new, the HP Laserjet
1200 featured the USB 2.0 interface in addition to a parallel port.
Paper capacity: One must also consider the paper capacity of
the paper-in tray. The Samsung ML-1450 offered a mammoth
paper capacity of 550 sheets. This printer does not support the
option for manual feed, but that is hardly of any concern while
buying laser printers. This one is a great option if your print jobs
are large in quantity, where you would not want to be bothered
with having to fill the paper tray too often. 

The next highest tray capacity in this comparison was of
250 sheets. The printers that offered this included the Canon
LBP 1210, the HP Laserjet 1200, the Laserjet 1000, and the
Wipro Laser 1540. The printer that supported the lowest tray
capacity was the Canon LBP 1120 with support for 125 sheets—
however, this was also among the lowest priced printers in 
this roundup.

Before a laser printer can start printing, it needs to have all the infor-
mation about a page in its memory. Where information about the
image to be printed is communicated to it via a page description
language (PDL), the printer’s internal processor first converts the
instructions into a bitmap, which is stored in the printer’s memory,
to be later reproduced on paper.

At the heart of the printer is a small rotating drum—the organic
photo-conducting cartridge (OPC)—with a coating that allows it to
hold an electrostatic charge. First the drum is given a positive
charge and then a laser beam scans across the surface of the drum,
selectively imparting points of negative charge onto the drum’s sur-
face that represents the output image—every point on the drum
corresponds to a point on the sheet of paper. In the meantime, the
paper is passed through an electrically charged wire that deposits a
negative charge onto it. The laser beam is then turned on and off as
it scans the rotating drum, using a complex arrangement of spin-
ning mirrors and lenses. The mirror drum spins incredibly fast and is
synchronised with this on/off switching of the laser. A typical laser
printer will perform millions of switches every second. Inside the
printer, the drum rotates to build one horizontal line at a time—the
smaller the rotation, the higher the resolution down the page (the
step rotation on a modern laser printer is typically 1/600th of an
inch, giving a 600 dpi vertical resolution rating and in some of the
latest printers, this resolution even goes up to 1440 dpi. Similarly,
the faster the laser beam is switched on and off, the higher the reso-
lution across the page. As the drum rotates to present the next area
for laser treatment, the written on area moves into the laser toner.

Toner used for printing mono is very fine black powder, positive-
ly charged so that it is attracted to the points of negative charge on
the drum surface. In colour printing, it could be either a CMYK or
RGB used individually or in a combination. Thus, after a full rotation,
the drum’s surface contains the whole of the required black image

for mono printing or any varied settings for colour.
A sheet of paper now comes into contact with the drum, fed in

by a set of rubber rollers. The charge on the paper is stronger than
the negative charge of the electrostatic image, so the paper mag-
netically attracts the toner powder. As it completes its rotation, it
lifts the toner from the drum, thereby transferring the image to the
paper. Positively charged areas of the drum don’t attract toner and
result in white areas on the paper. Toner is specially designed to
melt very quickly and a fusing system now applies heat and pressure
to the imaged paper in order to stick the toner permanently. The
drum is then cleaned of any remnants of toner either by mechani-
cally scraping the drum or by covering the drum with an even elec-
trical charge so the laser can write on it again. 

For managing the printer for a longer run, the felt pad which
cleans the drum and the corona wire, needs to be changed regularly.

Under the Bonnet

With its high resolution of 1200 dpi,
the Samsung ML-1450 is a good
choice for crisp and clear printouts
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Toner price: Cost is always a primary consideration when buy-
ing any product. A printer’s cost effectiveness depends on the cost
of the product plus the cost of printing a page. The lower the cost

per page, the better. To check this, we calculated
the price of the toner in relation with

the specified life of the toner. 
Here the HP printers come out

tops. Printing on any one of these
printers, be it the HP Laserjet 1000
or the Laserjet 1200, will cost you
just 88 paise per page. If running

cost is of concern, these printers
would keep your expenditure to
a minimum. The Epson EPL-
5900L also provides good value
for money, where printing a

document will cost you 93 paise. This value is very close to that
of the Wipro Laser 1540, which delivered printing costs of 95
paise per page. The printer that offered the lowest value as far
as toner price is considered was the Lexmark E322. Here print-
ing a document would cost you Rs 1.74.
Accessories: An important feature that most manufacturers miss
is the inclusion of an interface cable (either USB or parallel). Hunt-
ing for an interface cable after purchasing the printer can be a very
time consuming and unwelcoming task. Here the Canon LBP
1210, Epson EPL-5900L, the Lexmark E210 and E322 and the
Wipro 1540 scored over the others by providing the respective
interface cables. 
Documentation: It always helps if a manufacturer provides a
detailed user manual that is lucid and simple to understand. This
is especially applicable to the quick setup guide—by referring to
this quick start guide, a user can easily get the printer up and run-
ning in the least possible time. The printers in the comparison
that did not provide a quick start guide were the Canon LBP 1120,
the HP Laserjet 1000 and 1200 and the Lexmark E322. All the
other printers included a quick start guide.

Build quality
Here we noted the build quality of each printer in specific areas
such as the sturdiness of the paper feed tray, paper-out tray and
toner flap—all three areas have moveable parts and are handled
the most. All the printers featured good build quality in these
areas. The only exception was the Wipro Laser 1540—though it
has a good build quality, we found the paper-in tray to be some-
what flimsy.

Performance
In our performance tests we checked the printers for speed and
quality. To judge the speed of the printers, we printed different
file types such as image, text and combinational documents
including text and graphics.
Speed: In the
speed tests, we
first printed a
TIFF image docu-
ment and noted
the time taken. In
this test, the Sam-
sung ML-1210
came out tops,
logging just 26.73

1/2 page Ver. AD

The Epson EPL-5900L provides
good value for money due to low
running costs
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Features
LCD display (Y/N)
Indicator lights

Resolution (dpi)
Interface
Input buffer (MB)
Physical dimensions (LxWxH) cm
Paper feed tray
Paper capacity

Tray 
Manual 

Toner price (Rs)
Weight (kg)
Package contents

Accessories 

Bundled software 
Documentation

Manual 
Quick Start guide 

Build quality (scale of 5)
Paper-in tray
Paper-out tray
Toner flap

Performance
Printing speed

Image (seconds)
Word (seconds)
Combi document (seconds)

Printing quality
Image (scale of 5)
Point size (scale of 5)
Combi document (scale of 5)

Bulk printing test
Paper jam 
Multiple sheet pickups 

Warranty & Support
Type of warranty 
Number of years
Number of authorised service centres
Number of cities covered
Overall Score
Features (20%)
Performance  (40%)
Warranty and support (20%)
Value for money (20%)
Overall product rating
Overall grade
Vendor name

Phone
E-mail

Price (in Rupees)

Canon
LBP 1120

N
Power

1200
USB
512 kb
36.2x30.7x37.2  
2

125
1
3,650
6

Power cord

Driver CD

✔

✖

4
3.5
3.5

42
355
25.65

3.5
4
3

✖

✔

NA
2
80
51

9.2
25.53
9.00
15.85
59.58
B+
Canon India Ltd

011-680 6572
brijesh@canon.co.in

14,605

Canon
LBP 1210

N
Power

600
USB, Parallel
2
38.8x52.4x25.4
1

250
10
3,650
7.8

Power cord, 
interface cables
Driver CD

✔

✔

4
3.5
3.5

38.15
206
16.97

3.5
4
3.5

✖

✖

NA
2
80
51

12.2
30.25
9.00
13.35
64.80
A
Canon India Ltd

011-680 6572
brijesh@canon.co.in

21,192

EPSON
EPL-5900L

N
Power

1200
USB, Parallel
2
39.9x26.3x25.6 
1

150
1
5,600
7.9

Power cord, 
printer cord
Driver CD

✔

✔

4
2.5
3.5

36.52
260.59
28.6

3
4
3

✖

✖

On site
1
144
60

12
26.09
8.00
13.37
59.46
B+
Epson India Pvt Ltd

080-5321266
achaiah@
eid.epson.co.in
19,000

HP
Laserjet 1000

N
Power, Paper jam

600
USB to Parallel
1
41.4x48.5x25.4 
1

250
0
3,250
NA

Power cord, USB to
parallel cord
Driver CD

✖

✖

3.5
4
3

29.93
301.5
20.95

2.5
3
3

✔

✖

NA
1
239
80

8.1
23.71
11.00
13.68
56.49
B+
Hewlett-Packard 
India Ltd

011- 6826000
tarunjeet_sarao@
hp.com
15,500

HP
Laserjet 1200

N
Power, Paper jam

1200
USB 2.0, Parallel
8
48.8x25.4x41.4 
1

250
0
3,250
8.3

Power cord

2 Driver CD

✖

✖

4
3.5
3.5

46.77
220.33
28.57

3.5
4
3

✖

✖

NA
1
239
80

12.2
26.33
11.00
12.53
62.06
A-
Hewlett-Packard 
India Ltd

011- 6826000
tarunjeet_sarao@
hp.com
20,500

Lexmark 
E210

N
Paper out, Error, 
Ready

600
USB, Parallel
4
32.8x35.6x23.1 
2

150
1
4,250
6.5

Power, USB, 
interface cable
Driver CD

✔

✔

3.5
3.5
3

41.77
286
31.48

3.5
3.5
3.5

✖

✖

RTB
1
27
27

11
25.63
5.00
15.26
56.89
B+
Lexmark International
(India) Pvt Ltd

044-824 2090
vmehta@lexmark.com

16,000

LASER PRINTERSCATEGORY

Disclaimer: All prices are subject to variation    NA =  Not available RTB = Return to base
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Lexmark 
E322

N
Ready, Toner low, Load
paper, Paper jam,
Error, Press button
1200
USB
8
38.1x36x22 

2

150
1
5,223
9

Power cord, USB cord

Driver CD

✔

✖

3.5
4
3.5

148.41
182.72
300.67

3.5
4
3

✖

✖

RTB
1
27
27

11.2
22.76
5.00
7.34
46.30
C+
Lexmark International
(India) Pvt Ltd

044-824 2090
vmehta@lexmark.com

30,831

Samsung
ML-1210

N
Error, Paper, Data

600
USB, Parallel
8
32.9x35.2x22.9 
2

150
1
2,650
6.2

Power cord

Driver CD

✖

✔

3.5
4
4

26.73
280
47.85

3
4
3

✖

✖

On site
1
138
103

11.3
26.48
10.00
17.37
65.15
A
Samsung Electronics

India Information &

Telecommunication Ltd

NA
NA

14,500

Samsung 
ML-1450

N
Error, Manual, 
Paper, Data

1200
USB, Parallel
12
36.2x40.9x29.5 
2

550
0
6,200
12.4

Power cord

Driver CD

✖

✔

3
4
3.5

45.61
248
33.14

3.5
3.5
3.5

✖

✖

On site
1
138
103

15.1
25.05
10.00
12.63
62.78
A-
Samsung Electronics

India Information &

Telecommunication Ltd

NA
NA

21,200

Wipro
Laser 1540

N
Ready, Alarm,
Data

1200
USB, Parallel
2
36.0x37.0x23.5
1

250
1
3,800
9.2

Power cord, 
interface cables
Driver CD

✔

✔

2.5
3.5
3

140
202
29.58

3.5
3.5
3.5

✖

✖

Carry in
1
170
100

12.8
24.32
10.00
18.00
65.12
A
Wipro Peripherals

022- 26397418
helpdesk.mumbai@
wepindia.com
13,750
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seconds to print
the image file—
ideal for you if
your daily work
revolves around
printing a large
number of
i m a g e - h e a v y
d o c u m e n t s .
Another worthy
mention here is
the HP Laserjet
1000, which
logged an
impressive time
of 29.93 seconds. 

The Lex-
mark E322
struggled in this
test, posting a
below-average
score of 148.41

seconds (2 minutes, 28 seconds). The Wipro Laser 1540 was also
sluggish, taking 140 seconds (2 minutes, 20 seconds) to complete
the test.

Our next speed test involved printing a text document with
approximately 30 per cent text coverage. The Lexmark E322

did well here, firing out 50 pages in just a little above 3 min-
utes (182.72 seconds). Following closely was the Wipro Laser
1540 which took approximately 20 seconds more to get the
job done (202 seconds) and the Canon LBP 1210 (206 seconds).
The slowest printer in this test was the Canon LBP 1120—it
clocked 355 seconds (5 min-
utes, 55 seconds) to print
the 50 pages. Look else-
where if your daily
work involves print-
ing documents in
huge numbers. 

Our next test was
the Combi document
test. Here we recorded the
time taken to print one page of a
PDF document consisting of
text and graphics. The Lex-
mark E322, the fastest in the
previous test, was ironically
the slowest performer here,
taking 300.67 seconds (5 minutes) to print the document. The
one printer that performed really well in this test was the Canon
LBP 1210. This printer was able to print the Combi document
in a speedy 16.97 seconds—if your print jobs generally involve
large quantities of text-heavy documents, this printer fits the
bill very well.

Quality: In this test we printed a TIFF image
file at 600 dpi and checked the image for clar-
ity in reproducing details in the photograph.
The difference in image quality was not as
stark as it would have been if they were
colour printers. However, some printers still
managed to stand out here with discernible
variations in image quality.

In terms of overall image quality and
clarity, most of the printers did quite well.
Printers like the Canon LBP 1210 and the
HP Laserjet 1200 performed well in repro-
ducing clarity in monochrome images as
well as text—there was no smudging or loss
of contrast in the printed page. The only

Look for

The 
models

Price
range

Monochrome Imaging General-purpose document printing

Performance
Canon LBP 1210

Rs 21,000 to 
Rs 22,000

A printer that exhibits fast printing
speed and has a large-capacity paper
feed tray. A printer with a resolution of
at least 600 dpi should be sufficient for
these applications

Decision Maker

A printer that features sharp printing
quality for images, preferably one
with a resolution of 600 dpi or more
and a large print buffer

Price-conscious
Wipro Laser
1540, HP Laser-
jet 1000
Rs 13,000 to 
Rs 15,500

Performance
HP Laserjet 1200,
Samsung ML-
1450
Rs 20,500 to 
Rs 21,500

Price-conscious
Wipro Laser
1540, Lexmark
E210
Rs 13,000 to 
Rs 16,000

The Lexmark E322 is ideal for print-
ing documents that contain text
and images such as a Web page

■ Select the proper location to place your laser printer. A properly
ventilated area is recommended. Select a place where temperature
and humidity do not change frequently. Try to avoid areas with
heavy dust buildup.
■ Position the printer on a sturdy and level surface. Allow sufficient
space around the printer for air flow. 
■ While cleaning your printer, always use a lightly dampened cloth
to clean the outside of the printer. To clean the inside use a dry, lint-
free cloth. This will ensure that no liquid enters the inner parts of
the printer. Most manufacturers provide useful cleaning information
on their manuals—always refer to them.
■ Use papers manufactured specifically for your printer and also
select the correct paper type for your print job.
■ Keep your printer up-to-date by downloading the latest drivers
and patches from the manufacturer’s Web site. This helps because

most manufacturers provide driver updates for their
units and these include patches that add fonts or rectify incompati-
bilities. 
■ If debris is the primary cause of failures, toner is the primary cause
of debris. All toner cartridges release a small amount of toner into
the machine. This is why it’s important to clean the machine when
you change the cartridge. It is also important that the density con-
trol of the machine be properly set to prevent the machine from
pulling too much toner into itself. We all like dark prints, but if your
print settings are too dark, it could be detrimental to the life of the
cartridge in the long run.
■ Don’t pile documents or miscellaneous objects on top of your
printer, as they could cause damage. Your printer could overheat
and this could result in malfunctioning and even a reduction in the
printer’s life.

7 Ways to Care for your Printer
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one that performed under par in this test was the HP Laserjet
1000—the image produced by this printer was of very 
low quality and looked washed out even when using the best
quality mode.

In our next test, that is, the point size test, we printed a doc-
ument containing varying font sizes and checked for the quali-
ty. All the printers performed well in this test.
Bulk printing test: We performed this test to check the effi-
ciency of the printers when printing in large numbers. We
printed 50 pages of text and checked if there were any paper
jams or multiple sheet printouts. Most of the printers passed
this test without errors. These included the Canon LBP 1210,
Epson EPL-5900L, HP Laserjet 1200, Lexmark E210 and E322,
Samsung ML-1210 and Wipro Laser 1540. But there were some
printers that didn’t perform well in this test. These included
the HP Laserjet 1000 and the Canon LBP 1120. We experienced
paper jams with the HP printer and the Canon LBP 1120 gave
trouble with its multiple sheet pickups even when the papers
were shuffled to prevent them from sticking.

Warranty and support
Warranty and support becomes an important consideration
when buying a peripheral device. Most manufacturers provide
a one-year warranty and the autho-
rised service centres are usu-
ally spread across the
country. The important
thing is that the service
centres should be
spread across the coun-
try and not be con-
centrated in a
single area. In
this comparison,
Wipro had the maximum
reach with 170 service cen-
tres across 100 cities. HP too
has a wide reach with 239
service centres across 
80 cities. Canon provides
the maximum warranty period at two years.

1/2 page Ver. AD

With an unmatched 239 service
centres, HP printers are very cus-
tomer friendly

Warranty type: A carry-in warranty is definitely a big
pain as far as bulky items such as laser printers are concerned.
The warranty should be comprehensive and on-site. 
Warranty period: The greater the warranty period, the better. It
indicates that the manufacturer has greater faith in the product.
Suitability: Faster and higher quality printers are a lot costlier
than slower ones. If you’re in no hurry to take your printouts, or
don’t need excellent quality, set your sights a little lower. You’ll
end up saving big bucks that way.
After-sales service: With expensive items such as laser printers,
it’s a real bother to watch them crash or otherwise malfunction.
Adding lousy customer service to that is like rubbing salt into a
wound. Ask people who have already bought printers about 
their experiences with the customer-support staff. It might take
some effort on your part, but is any day better than learning the
hard way.

Buying Smart
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What it all Leads to
Out of the 10 printers that we tested, some offered good features
such as high resolution support, while others offered good docu-
mentation. Most printers aimed at improving the printing expe-
rience by offering good looks and sporting LED indicators. We
also noted that nowadays manufacturers provide USB and paral-
lel interfaces, which makes it convenient to connect the printer.
The printers have also improved on build quality and ease of use.
The printers have improved to a great extent in performance too.

The Canon LBP 1210 bagged the Best Performance
Award—it exhibited superior print quality and at good speeds. In
fact, it performed better in the speed tests than even some print-
ers that supported higher resolutions. The pure text and image
prints were also impressive, where it logged a time of 38.15 sec-
onds and 206 seconds (3 minutes, 26 seconds), respectively. This
printer was also quite amazing when it came to paper handling,

performing reliably in
the bulk printing test.

This printer also
offers good features

and sports good solid
looks. The front panel

has a simple interface
design, while the back
panel features the

usual USB and parallel
interface. One of the important
criteria of any printer is the
maximum paper capacity it
can handle, and this printer is
provided with a 250-sheet

paper tray and there is also provision for manual paper loading.
To save on space, the paper-in tray can be detached if not in use.
The printer package included a power cord, interface cables, man-
uals and the driver CD and also a quick start guide. The build
quality was also very impressive—the trays don’t feel tacky and
sport a solid construction. 

Our Best Value Award goes to the Wipro Laser 1540. This
printer is for those who want a decently fast printer at an afford-
able price. The printer design is simple. There are visu-
al indicators on the front for Ready, Alarm and
Data Flow conditions. The printer supports a max-
imum resolution of 1200 dpi
and sports the USB and
parallel interfaces. The
paper-in tray can hold a
maximum of 250 sheets
of paper and also sup-
ports a manual paper
feed option. The printer
gave some acceptable
results in our print quality
tests. When printing text, it
was able to print even
small-sized text quite
accurately. All through
our tests, there were no
paper jams or multiple
sheet pickups. All in all, this printer is a good buy for its price and
this makes it our best value winner.

YATISH SUVARNA and AHMED SHAIKH

The 1200 dpi Wipro Laser 1540
offers a decent printing speed at an
affordable price

With an excellent printing speed,
the Canon LBP 1210 is a definite
buy if price is not a consideration

1/2 page Ver. Ad
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■ input devices

The Mouse Trap

The two-button scroll mouse is still the best seller today. Optical mice from ven-
dors such as Mercury and The Best can be bought for anywhere between Rs 700
and Rs 1,000. While they are more affordable, mass acceptance is still another price

cut away, especially when a normal ball mouse can be had for less than Rs 400. The pro-
fessional user would, of course, like the reduced hassle and the greater accuracy afford-
ed by the optical devices. We test 10 mice that cover both the ball and the optical vari-
ety, and come with and without cords.

Digit Test Process
We tested the mice on a system with a Pentium 4 2.2 GHz processor, an MSI MAX2BLR
motherboard, 256 MB DDRRAM and a 40 GB Seagate Barracuda drive running Windows
XP Professional. Four primary parameters were marked: features, ergonomics, build quali-
ty and value for money. Each parameter was allotted a 25 per cent weightage. The weigh-
tages allotted to each parameter was used to calculate the overall scores.
Features: The primary feature tested was the accuracy a mouse provided in gaming and
image editing. the devices were rated on a scale of five. Next, we noted the extra pro-
grammable buttons that increase productivity. A mouse that supported the USB inter-
face obviously scored more than one designed for the PS/2 port. Similarly, an optical
mouse was rated higher than a ball mouse. As a final point of comparison, the length
of the cable was also considered—the longer the tail, the more the mouse scored.
Ergonomics: A mouse was rated on a scale of five based on the degree of symmetry
that it afforded to a user—both right and left handed. Next on the agenda was the grip,
both on a surface and with the palm. A mouse that presented better traction and palm
grip scored higher on a scale of five. To judge the ease of use, we rated each mouse on
the placement of buttons and design aspects that allowed them to sit snugly within 
the palm. 
Build quality: To test the build quality we dropped the mouse from a height of 6 feet.
We then noticed any physical damage, following which the mouse was re-attached to
the PC to ensure a working condition. Also tested was the quality and stability of the
buttons that form the pointing device.

P R O D U C T S

FRONTECH JIL-7001

FRONTECH JU-830

IBALL THE KING

LOGITECH CORDLESS 
MOUSEMAN OPTICAL

LOGITECH MOUSEMAN 
DUAL OPTICAL 

MERCURY OPTICAL 
SCROLL MOUSE

MICROSOFT TRACKBALL 
OPTICAL

MICROSOFT WIRELESS
INTELLIMOUSE EXPLORER

ODYSSEY WEB SCROLL
MOUSE

SAMSUNG SMP 
2100WX

Here are 10 entrants in the mice race. May the best mouse win!

Frontech JIL-7001
Features: PS/2 interface, no extra buttons Price: Rs 200 
Contact: Jupiter Infosys India Ltd Phone: 022-22001211 
E-mail: frontech@bom5.vsnl.net.in Web site: www.frontech.com

The JIL-7001 from Frontech combines a metallic dark blue
with silver with stunning effects. This makes the device stand

out from the crowd of the regular two-button scroll mice. 
This Plug and Play mouse does not
require any drivers to get it up and run-

ning. A PS/2 connectivity,
however, takes away from

hot plugging the device. Gamers
used to the two-button mouse will

find this mouse suitable to their need as
there is no

design differ-
ence.This mouse is available for
just Rs 200, hence making it the
cheapest of the lot and given its
performance in different applica-
tions, this is a good buy.

Frontech JIL-7001
Features
Build quality
Ergonomics
Value for money
OOVVEERRAALLLL

B+B+

The JU-830 is a two-button scroll mouse, with two extra buttons
on the sides. Upon installation of the supplied drives, these

buttons can be programmed to certain actions that include simu-
lating mouse actions such as a double-click, zooming in on Web
pages, or mapping keyboard keys like [F1], [Page Up], etc. The extra
buttons take a little getting used to, especially if you’ve assigned
them functions. Often, these buttons get pressed while moving
the mouse around. The device uses a PS/2 interface to connect to
the computer, and has a resolution of 400 dpi, both of which are
very standard features. The mouse on the whole is very ordinary,
and at Rs 350, it does
not pretend
otherwise.

Features: USB interface, two extra buttons Price: Rs 350 
Contact: Jupiter Infosys India Ltd Phone: 022-22001211 
E-mail: frontech@bom5.vsnl.net.in Web site: www.frontech.com

Frontech JU-830

Frontech JU-830
Features
Build quality
Ergonomics
Value for money
OOVVEERRAALLLL

A-A-
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The iball, is a functional combination
of a trackball and a traditional

three-button scroll mouse. The
trackball is extremely convenient for
scrolling, even for those used to the
ubiquitous three-button mouse. There
are four directions for horizontal and ver-
tical scrolling and the mouse fits snuggly into
your palm. The optical functionality increases its life-
time by eliminating any internal moving parts. Clicking is very
convenient and the cursor movement at default setting was
smooth. The cable wire is short enough to prevent unnecessary
loops, while long enough to reach the cabinet placed below the
table. With a robust design and the advantages of the centre but-
ton (there are some 30 programmable options), the iball is an
excellent buy for the multi-tasking professional who can use this
feature to cut down on the time
taken to click the glut of menus
that plague Windows. At Rs 950
it also offers a good upgrade path
for those looking to move on
from the traditional scroll
mouse.

iball The King
Features
Build quality
Ergonomics
Value for money
OOVVEERRAALLLL

A-A-

Those looking for the trinity of designer looks, the precision of
an optical device and the freedom afforded by the absence of

cords should look no further than the Logitech Cordless Mouse-
Man Optical. The mouse fits the palm as if it were a part of it. A
tri-colour body and a smooth finished contour imparts a cool look
to the device. The only problem with this mouse is the right and
left-click button: these buttons are small compared to normal
mice and are not easily accessible. The additional key provided
can be customised for any function using the Logitech Mouse-
Ware utility provided on the CD. The mouse is available for 
Rs 4,990, keeping it out of the reach of most buyers. If you are a
professional and are looking for accuracy in applications such as

Photoshop and 3dsmax, this mouse is sure
to impress you.

FFeeaattuurreess:: Optical mouse, PS/2 interface, no extra buttons 
Price: Rs 950 Contact: The Best Phone: 022-26935135 
E-mail: lata@bestitworld.com Features: Optical cordless mouse, USB interface, no extra buttons,

two AAA batteries Price: Rs 4,990 Contact: Rashi Peripherals
Phone: 022-28260258 E-mail: ho@rptechindia.com 
Web site: www.logitech.com

Logitech MouseMan Dual
Optical

iball The King

Features : Dual-optical cordless mouse, USB interface, one extra 
button Price: Rs 4,000 Contact: Rashi Peripherals
Phone: 022-28260258 E-mail: ho@rptechindia.com 
Web site: www.logitech.com

Logitech Cordless MouseMan
Optical

MouseMan Optical
Features
Build quality
Ergonomics
Value for money
OOVVEERRAALLLL

B+B+

The Dual Optical Mouse from Logitech uses optical sensing
technology for defining the pointer movement on the

screen.  It features a top-notch finish with a two-tone colour
combination that gives it an elegant look. The design of the
device is, however, biased in favour of a right-handed user. The
device fits snugly within the palm and is comfortable to use,
thanks to its shape. A rubberised side grip near the thumb pro-
vides excellent lateral hold to grasp the mouse. The buttons are
well laid and comfortable to use, with a well-balanced scroll
wheel that provides a good tactile feel. A fourth button placed
near the thumb is a good programmable stand-in. What sets the
device apart from others is the use of two 800-dpi optical sen-
sors for better accuracy and handling. The mouse showed good

directional stability and accurate pin point
precision in applications such as Photo-

shop and gaming.

The Optical Scroll Mouse from Mercury is a low-end
optical solution for those who

wish to evolve from the ball-
mouse. With a price tag of Rs
550, this offering puts optical
solutions well within the
reach of almost anyone.
The mouse has a striking
twin grey and dark blue
colour combination making it
stand out against the beige of
your desktop PC. Another big advantage of the Optical Scroll
is the USB connection which makes it easy to plug in the point-
ing device and get it up and running. Since there are older sys-
tems around which do not have the requisite port, a USB to
PS/2 converter would have helped. As far as design is con-
cerned, this device is pretty much your plain vanilla two-but-
ton scroll mouse, the only
addition being that the scroll
button glows red when used. If
you are looking for an inexpen-
sive optical mouse then noth-
ing can beat the Mercury Opti-
cal Scroll Mouse.

Features: Optical mouse, USB interface, two extra buttons 
Price: Rs 550 Contact: Kobian India Ltd Phone: 080-5566626 
E-mail: rohit@kobian.com Web site: www.kobian.com

Mercury Optical Scroll Mouse

Mercury Optical Scroll 
Features
Build quality
Ergonomics
Value for money
OOVVEERRAALLLL

A-A-Logitech Dual Optical
Features
Build quality
Ergonomics
Value for money
OOVVEERRAALLLL

BB
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Samsung is trying to break the price barrier in the mouse
market with the introduction of the SMP

2100WX, a standard two-button scroll
mouse, available for the PS/2 interface.
It performs just as expected for a price
of Rs 260. Being a Plug and Play
device, all versions of Windows
can immediately detect and con-
figure the mouse as well as the
associated scroll wheel. Since it
has only two buttons, there’s noth-
ing programmable here. Everything sets
up instantly.

As far as the feel of the SMP2100WX is concerned, the
wheel is slightly unbalanced and tends to jerk up and down.
Discouragingly, the rest of the mouse feels just as unstable and
at high speeds, it tends to move towards the left and the bot-
tom. This unbalance makes it difficult to use the SMP2100WX
for fast-paced games such as Quake III Arena. If you intend to
use it for everyday office
applications and play games
once in a while, then this
mouse just about suits your
needs—especially if you’re
looking to shell out the mini-
mum possible cash.

The first thing that strikes you about the Odysey Web Scroll
mouse is its transparent goblin green body, complete with a

matching transparent green cable. The device is a standard three-
button scroll mouse, designed for both right and left-handed
users. Featuring a PS/2 interface, the Web Scroller is a little too
large for comfort for those with small hands. Additionally, the
pointed tip of the device digs into the bottom of the palm, mak-
ing it uncomfortable during long hours. The buttons, though
large, seem tacky and do not have a comfortingly snug feel about
them. The scroll wheel also fails to deliver accuracy and tends to
scroll a little more or less than is desired. Apart from this, the
device is smooth and offers decent precision. The package
includes IWare Plus for Windows 95/98/NT on a floppy disk.

With a price tag of Rs 200, the device is suitable
for basic, non-frequent home usage where

cost is a consideration.

Odyssey Web Scroll Mouse
Features: PS/2 interface, no extra buttons Price: Rs 293 
Contact: Compuage Infocom Ltd Phone: 022-23842200 
E-mail: info@compuageindia.com 
Web site: www.compuageindia.com 

Samsung SMP2100WX
Features
Build quality
Ergonomics
Value for money
OOVVEERRAALLLL

B+B+

Samsung SMP2100WX
Features: PS/2 interface, no extra buttons Price: Rs 260 
Contact: Samsung Asia Pte Ltd Phone: 022-22814886

Trackball devices have always generated a negative
response from first time users, since they

require patience and some getting used to.
The trackball device is designed for comfort
and to reduce the possibility of acquiring
Repetitive Strain Injury (RSI). Unlike
finger-driven trackballs, which require
the thumb to click and hold the point-
er device’s buttons, the Optical’s design
allows you to use your forefinger and the
middle finger to operate the buttons and the
scroll-wheel, thus mimicking the way we use a mouse. Although
the device looks daunting, it does not take up too much desk
space. 

The installation is hassle-free and the software included, Intel-
limouse 4.1, lets you configure the extra buttons. Its Optical nature
offers a highly accurate, slip-free
method of pointing, even when
the ball is rolled rapidly. It is a USB
device but comes with a PS2
adapter. Exclusively designed for
right-handers, the Optical leaves
lefties completely at a loss.

Trackball Optical
Features
Build quality
Ergonomics
Value for money
OOVVEERRAALLLL

B-B-

Microsoft TrackBall Optical

The Intellimouse fits perfectly within the palm, making long
working hours easy on the hand. The black and metallic grey

combination makes it an attractive piece. The buttons are easy
to click with the two extra buttons just under the thumb for faster
access. The mouse is good for both gaming as well as regular
office sessions. The accuracy afforded by the optics ease both,
railing opponents in Quake III Arena and making pixel-precise
selections in Adobe Photoshop. The scroll button, which doubles
as the middle button, is very smooth and noiseless. The pack
came with two AA batteries, a receiver, a software CD and a man-
ual. The mouse gets detected without a hassle or a need to pro-

vide drivers. This optical mouse is a worthy
upgrade from the previous corded opti-

cal or the cordless infrared mouse.

IntelliMouse Explorer
Features
Build quality
Ergonomics
Value for money
OOVVEERRAALLLL

A-A-

FFeeaattuurreess:: Optical mouse, USB interface, two extra buttons, two AA
batteries Price: Rs 3,380 Contact: Microsoft Corporation India
Pvt Ltd Phone: 011-26292640 E-mail: connect@microsoft.com
Web site: www.microsoft.com

Microsoft Wireless
IntelliMouse Explorer

Odyssey Web Scroll 
Features
Build quality
Ergonomics
Value for money
OOVVEERRAALLLL

BB

Features: Optical track ball, USB interface, two extra buttons 
Price: Rs 1,690 Contact: Microsoft Corporation India Pvt Ltd
Phone: 011-26292640 E-mail: connect@microsoft.com 
Web site: www.microsoft.com
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All the Right Keys

The days of the 101-key keyboard are long gone, with newer multimedia keyboards
sporting as many as 22 hotkeys apart from aesthetic and ergonomic designs. The
price of these keyboards is now less than Rs 600, whereas a regular keyboard can

be purchased for as less as Rs 300. We tested six keyboards from Microsoft, Odyssey,
Logitech and Samsung.

Digit Test Process
We tested the keyboard on a system with a Pentium 4 2.2 GHz processor, an MSI
MAX2BLR motherboard, 256 MB DDRRAM and a 40 GB Seagate Barracuda drive. The
OS used was Windows XP Professional. The keyboards were tested on four primary
parameters: Features, Ergonomics, Build quality and Value for money. Each parameter
was allotted a 25 per cent weightage. The weightages allotted to each parameter was used
to calculate the overall scores.
Features: The interface of the keyboard was the first criterion of testing. A USB keyboard
scored higher than a PS/2 one. Next up was the number of hotkeys on the keyboard.
The greater this number, the higher it scored. Finally, some keyboards come with inte-
grated trackballs and other mouse controls—such devices scored higher over those that
did not feature these. 
Ergonomics: Comfort is paramount when judging a keyboard. The ergonomics that a
keyboard offered was evaluated on the basis of several factors—the comfort it provided
while typing, the layout of the keys on the device, the tactile feedback while typing and
the presence or absence of a palm rest were the factors considered. 
Build quality: A keyboard should be built to last, since the device is in constant touch
with its user and use and abuse are part of its job description. Keyboards were thrown
against each other on the basis of sturdiness and the stability of the buttons and of the
unit as a whole.

P R O D U C T S

LOGITECH NEWTOUCH 
MULTIMEDIA KEYBOARD

MICROSOFT 
MULTIMEDIA KEYBOARD

ODYSSEY 
OD2001 IR

ODYSSEY 
OD2001 M1

SAMSUNG 
MULTIMEDIA 
KEYBOARD SEM-M2A

SAMSUNG 
PC KEYBOARD

Keyboards are the most used components of your PC. We tested six of them to find which one
deserves your touch

The New iTouch Multimedia Keyboard from Logitech is easy
on the eyes and offers a great typing experience. It has a total

of 12 hotkeys that allow faster Web surfing and greater efficien-
cy when working with applications. The keys are soft on the fin-
gers and a delight to work with, complete with silent keystrokes
and an excellent build quality. Accompanying the keyboard is a
driver CD to configure the shortcut keys and a Quick Start Guide.
The keyboard is priced at Rs 875, which brings it under the budg-
et of most users and also makes it a very good option for both
office and home
users.

Logitech NewTouch
Multimedia Keyboard
Features: 12 hotkeys, PS/2 interface, package includes a palm rest
Price: Rs 875 Contact: Rashi Peripherals Phone: 022-28260258
E-mail: ho@rptechindia.com Web site: www.logitech.com

Testing Microsoft’s MultiMedia keyboard was a
sheer delight. It has a very intelligent

placement of the keys and features a
new design with rounded contours and
a two-tone finish with a blue body and
white keys. The multimedia keys are locat-
ed at the top, along with keys for accessing
your e-mail, an instant messenger, the Media Play-
er, the My Documents folder, etc. Apart from these, an F-lock
key allows the user alternate uses for the function keys such as
open a new Word document, send mail, etc. The keyboard pegs
are well designed and sturdy
enough to take the load of your
palm. The provided software
works seamlessly and hassle-free.
With a price tag of Rs 1,606, this
keyboard from Microsoft is one
of the best around. 

Microsoft Multimedia 
Features
Build quality
Ergonomics
Value for money
OOVVEERRAALLLL

B+B+

Features: 16 hotkeys, PS/2 interface, package includes a palm rest
Price: Rs 1,606 Contact: Microsoft Corporation India Pvt Ltd
Phone: 011-26292640 E-mail: connect@microsoft.com 
Web site: www.microsoft.com

Microsoft Multimedia
Keyboard

Logitech Newtouch
Features
Build quality
Ergonomics
Value for money
OOVVEERRAALLLL

B+B+
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Odyssey OD2001 IR

The Odyssey OD2001 IR is a sleek, sophisticated keyboard with
a black body and keys set in a tasteful dark grey. Mouse con-

trol is emulated via a track pad, provided at the upper right cor-
ner, with buttons simulating the left and right buttons. This
infrared unit works at a distance of approximately 5 metres from
the receiver (although the manual claims a safe distance of 
2 metres). With a layout that emulates a laptop’s keyboard (its
width is less compared to normal keyboards), the Odyssey is a
compact package that fits snugly on the lap of the typist. The key-
board weighs less than a kilo, while the base unit weighs less than
250 grams, making it quite easy to lug around. There are 15 spe-
cial function keys—four for Internet functions, three for volume
control, five for audio control, one key for power,  another for
standby and the last one for the alarm. You just need to plug the
PS/2 connectors for the mouse and keyboard in the sockets and its

ready. No driver installation is required
even for the 15 special keys. How-

ever, the price tag of Rs 2,340
takes some thinking. 

Features: Infra-red communication, range of 2 meters, 15 hotkeys,
on-board track pad, PS/2 interface, package includes a palm rest
Price: Rs 2,340 Contact: Compuage Infocom Ltd 
Phone: 022-23842200 E-mail: info@compuageindia.com 
Web site: www.compuageindia.com

The Odyssey OD 2001 M1 is an ideal solution for those
looking to buy a keyboard for multimedia applications,

without burning a hole in the pocket. This keyboard
is easy on the eye with a white and grey colour
combination. The multimedia keys are
neatly arranged on top and it has 
all the usual features, viz,
Play/Pause, Volume-Up, Vol-
ume-Down and Mute for
music lovers; and shortcut
keys for Web browser, such as
Search and Favorites and Power,
Sleep & Wake. 

The Odyssey OD2001 M1 is heavier
than other keyboards, giving it desk stability, while the palm
rest bundled affords good ergonomics. Installation is simple—
plug the keyboard into a PS/2
connector and you are all
set—no driver hassles, no spe-
cial software needed for the
multimedia keys. With a price
tag of Rs 585, it makes a decent
purchase.

Features: PS/2 interface, package includes a palm rest Price: Rs 585
Contact: Compuage Infocom Ltd 
Phone: 022-23842200 E-mail: info@compuageindia.com 
Web site: www.compuageindia.com

Odyssey OD2001 M1

Odyssey OD2001 M1
Features
Build quality
Ergonomics
Value for money
OOVVEERRAALLLL
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Here is a keyboard that offers excellent build quality but is
found lacking in the looks department. With around 20

additional programmable keys, the device offers both flexibil-
ity and comfort, since the keys are soft, silent and very easy on
the fingers. The keyboard is quite heavy, making it more sta-
ble on the desk. A small form factor ensures that it occupies
very little desktop space. It interfaces with the PC via the PS/2
port and a cable that is of sufficient length for most desk
spaces. On the whole, this product from Samsung provides

good value for money.

Features: 20 hotkeys, PS/2 interface, palm rest not bundled 
Price: Rs 300 Contact: Samsung Asia Pte Ltd
Phone: 022-22814886  

Samsung Multimedia
Keyboard SEM-M2A The first thing that strikes you about the SEM-DT35N is its

sleek black colour. The feel of the keyboard is very easy on
the fingers and it doesn’t offer any multimedia buttons,
bringing its cost down to an
affordable Rs 300. Borrowing a
leaf off the weird book, the
keyboard provides support
for the Korean Hangul script.
While this might seem like a good
thing for the miniscule Indian populace that
interacts with that language, to the rest of us the
feature only serves to add a lot of visual clutter. What’s
worse is the decision to obscure the all important backslash
key [\]: it is still there, but marking its position is the normal
‘pipe’ symbol and a weird looking symbol that remotely resem-
bles a ‘W’. A new user would be quite dismayed to find the all-
important backslash key missing.

But its reasonable price makes it easy to overlook this
fault—it’s extremely difficult
to find economical keyboards
that look good and perform
well. All said and done, Sam-
sung sure has a pretty decent
product on its hands.

Features: No hotkeys, PS/2 interface, palm rest not bundled 
Price: Rs 300 Contact: Samsung Asia Pte Ltd 
Phone: 022-22814886 

Samsung PC Keyboard

Samsung PC Keyboard
Features
Build quality
Ergonomics
Value for money
OOVVEERRAALLLL
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Odyssey OD2001 IR
Features
Build quality
Ergonomics
Value for money
OOVVEERRAALLLL

B+B+

Samsung SEM-M2A
Features
Build quality
Ergonomics
Value for money
OOVVEERRAALLLL
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Two to Tango

Akeyboard and mouse combination is meant as the one-
stop solution for the discerning and wallet heavy user seg-
ment. These bundles are ergonomic, good to look at and

fall within the price bracket of Rs 3,500 to Rs 6,500. Some of
these boards  aim to offer a complete solution—a wireless, opti-
cal keyborad and mose combination. We tested four such com-
bination packages.

Digit Test Process
The keyboard and mouse combos were tested on four primary
parameters: Features, Ergonomics, Build quality and Value for
money. Each parameter was allotted a 25 per cent weightage. The
weightage allotted to each parameter was used to calculate the
overall scores.
Features: The interface of the keyboard, the number of hotkeys,
whether it was wireless or corded, the presence of integrated
scrolling devices or trackballs were all taken into consideration.
The accuracy of the mouse under Photoshop and gaming was
the primary feature consideration. An optical mouse obviously
scored higher; similarly cordless and USB pairings were put on 
a pedestal.
Ergonomics: Comfort was given equal importance in both the
mouse and the keyboard. While the keyboard also rated on the
layout of the keys, the tactile feedback and a palm rest, the mouse
was primarily awarded for being symmetrical, for providing a

good grip to the palm and a good traction to the surface on which
it was placed. 
Build Quality: Keyboards were tested on the basis of sturdiness
and the stability of the buttons and of the unit as a whole, where-
as the mice were dropped from a height of 6 feet and checked for
physical damage. The quality and stability of buttons that come
along with such a pointing device was also tested against each
other on the basis of sturdiness and the stability of the buttons
and of the unit as a whole.

P R O D U C T S
LOGITECH CORDLESS FREEDOM
OPTICAL

MERCURY CORDLESS KEYBOARD
AND MOUSE KOB 30210

MICROSOFT WIRELESS
DESKTOP

TYPHOON ITEK 
RF@MOUSE AND KEYBOARD

The right mouse and keyboard work together to take the stress off your fingers. We tested four lethal
combinations to help you make the right choice

Logitech Cordless Freedom
Optical
Features: 20 hotkeys, USB interface, package includes a palm rest
and a cordless optical mouse Price: Rs 6,950 Contact: Rashi
Peripherals Phone: 022-2826 0258 E-mail: ho@rptechindia.com 
Web site: www.logitech.com 

The Logitech Cordless Freedom is a wireless set that eliminates
line-of-sight restrictions by working in the radio frequency

band. The set packs in a cordless keyboard, a cordless optical mouse
and a suitable receiver. The keyboard has an excellent layout and
works perfectly with all applications. Although it remains respon-

sive at a distance of 20 feet, the mouse (Log-
itech Cordless MouseMan Optical) misses sig-

nals and is generally not as responsive. The set is
both good looking and feature packed—

the keyboard comes with 20 hotkeys
for Internet and multimedia appli-

cations and a handy on-board scroll
button. The bundled mouse is a bit heavy

but works
very smooth-

ly. Moreover, the
Logitech MouseWare Control
Centre lets the user define short-
cut keys for both the extra button
and the centre button. 

Logitech Freedom
Features
Build quality
Ergonomics
Value for money
OOVVEERRAALLLL
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Features: 19 hotkeys, PS/2 interface, package includes a palm rest
and a cordless scroll mouse Price: Rs 2,000 Contact: Kobian India
Ltd Phone: 080-5566626 E-mail: rohit@kobian.com 
Web site: www.kobian.com

The KOB 30210 is a cordless bundle of mouse and
keyboard that operates on radio frequency. The

design of both the constituents has been
kept very simple. The keys are
placed in the standard layout
while the shortcut keys are arranged
in one line, giving the board a very
plain look. Shockingly, the keyboard
does not have on-board LEDs for [Caps
Lock], [Num lock] and [Scroll Lock]—an
unfortunate omission. The keyboard offers
decent build quality and the keys are quite
enough while in use. It requires three AA batter-
ies to work, which adds to the
weight of the keyboard and
increases its running cost. The
mouse bundled is a cordless two-
button scroll mouse which works
fine with most applications and
from a distance of over 6 feet. 

Mercury KOB 30210
Features
Build quality
Ergonomics
Value for money
OOVVEERRAALLLL
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Mercury Cordless Keyboard &
Mouse KOB 30210
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Typhoon iTek RF@Mouse and
Keyboard
Features: 16 hotkeys, PS/2 interface, package includes a palm rest
Price: Rs 1,950 Contact: Hitech Computers 
Phone: 022-24927323 E-mail: bom@hitechit.com  
Web site: www.hitechit.com 

The Typhoon iTek RF@mouse and
keyboard combination works on

the radio frequency band and is there-
fore operable from a distance without
needing a line of site. The complete pack
comes with a multimedia keyboard, a cord-
less mouse, a receiver and a palm rest for the key-
board. The layout of the board is decent with 16 hotkeys spread
across the top of the keyboard. The multimedia keys find them-
selves grouped on the left side, while the Internet keys are located
on the right. The keys are not too easy on the fingers—hard strokes
are needed to do the typing and as such the unit is not ideal for long
sessions. The two-button bundled mouse works well from a dis-
tance of 15 to 18 feet, given that
there is nothing blocking the
device from the receiver; otherwise
the pointer moves in a jerky fash-
ion on the screen. In all, the
Typhoon is a good bundle at an
affordable price.

Typhoon Itek RF
Features
Build quality
Ergonomics
Value for money
OOVVEERRAALLLL
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Microsoft Wireless Desktop
Features: 10 hotkeys, PS/2 interface, package includes a palm rest
and a cordless optical mouse Price: Rs 3,634 Contact: Microsoft
Corporation India Pvt Ltd Phone: 011-26292640 
E-mail: connect@microsoft.com Web site: www.microsoft.com

This simple looking wireless multimedia keyboard and
mouse gives a complete desktop solution. The keyboard

has a fairly easy-to-use layout with a detachable palm rest
and 10 one-touch hot keys that allow you to browse the
Internet, open your e-mail client and put your computer into
a power saving mode. The wireless mouse provided has pro-
grammable buttons which can be customised. Its unique
design suits the right as well as left-handed user. A wireless
receiver ensures your desk remains clutter free and its dual
channel receiver ensures interference-free computing, even
if the receiver is out of sight. There will be no difference in
the performance of the devices even if they are 6 feet away
from the receiver. 

1/2 page H AD

MS Wireless Desktop
Features
Build quality
Ergonomics
Value for money
OOVVEERRAALLLL
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Intel’s Pentium 4 3.06 GHz
processor finally makes

HyperThreading a reality for
the desktop PC. With this
technology, your processor
will appear like
two separate CPUs
to your OS. The
current version of
HyperThreading
technology allows
a maximum of
two threads to be
dispatched to the
CPU. Everything
else has still stayed
the same. So really
how good is the
processor?

To answer this question,
we tested the Pentium 4 3.06
GHz on a machine based on an
Intel D845PEBT2 motherboard
with 256 MB of DDR RAM, an
ATi Radeon 9700 Pro graphics
card and a Seagate Barracuda
7,200-rpm ATA IV 40 GB hard
disk drive, running Windows
XP Professional. The hard drive
was clean formatted before
installing the OS and all the
necessary driver updates and
patches were applied before
running any benchmark. 

Our first tests included
synthetic benchmarks. Here
we ran SiSoft Sandra Profes-
sional 2003 and noted the
scores in different areas. In the
CPU benchmark that indicates
the theoretical performance
potential of the CPU, the Pen-
tium 4 3.06 GHz scored 9059
CPU Drystone marks and 5567
Whetstone marks.

The CPU multimedia sub-
test is a real-life benchmark

rather than a synthetic one
and is designed to show the
improvements that instruction
sets used in various processors
(MMX/Enhanced, 3DNow!

/Enhanced, and
SSE (2)) bring to
such an algorithm.
We also ran the
Memory bench-
mark, which meas-
ures sustained
memory band-
width. Here the P4
3.06 GHz easily
outperformed the
2.8 GHz-based

processor even with
HyperThreading turned off. 

In the CPU multimedia
subtest too, the HyperThread-
ing -enabled CPU posted a
higher score in the FPU SSE
region though the integer
scores don’t offer much to talk
about.

To test the gaming per-
formance of the processor, we
ran a time demo on the retail
version of Quake III Arena
patched with version 1.30. The
test was run in three different
settings: normal, high and
max (1024x786x32x32). 

In the normal mode 
there was no difference in the
scores with HyperThreading
switched on and off, but the
difference was noticeable in
the high and max quality
modes.

Our second gaming test
involved running Comanche 4
in three different settings, nor-
mal (640x480x16), high
(800x600x16) and maximum
(1024x786x32). Here too there

wasn’t much difference in the
frame rates with HyperThread-
ing turned on and off. 

Another area where a high
amount of CPU power is
required is video encoding. To
measure the performance of a
processor during video encod-
ing, we encoded a standard
MPEG-2 format video
sequence using VirtualDub
v1.4. The DivX codec used was
v4.02 and the setting for audio
and video processing in Virtu-
alDub was turned to full pro-
cessing mode. The video com-
pression bit rate was set at 900
Kbps. Here the less time it

takes to encode the file, the
better it is. We recorded our
lowest ever score—the CPU
took a mere 51 seconds to
encode the video file. This
makes the P4 3.06 a great
option for those who work
with video encoding applica-
tions to a large extent.  

Just to put the CPU under
a bit more stress, we ran a cou-

ple of benchmarks simultane-
ously. We ran the Povray
benchmark, which is severely
CPU intensive, while simulta-
neously running Comanche 4
in the normal mode. We ran
this test first with Hyper-
Threading turned off and then
with HyperThreading turned
on just to see if it makes a dif-
ference—we achieved an aver-
age 26.57 fps with the Hyper-
Threading disabled and a
boost of approximately 11 fps
with it enabled.  

All in all, Intel’s latest desk-
top processor truly impresses
with its performance and the

HyperThreading
feature makes it
achieve higher
p e r f o r m a n c e
scores under
stress. Hyper-
Threading in its
future iterations
could very well
overcome its lit-
tle drawbacks

that still exist—for instance, it
could reduce performance if
the OS dispatches multiple
threads that are aimed at 
similar resources in the CPU.
Until then this is as fast as you
could get.

Pentium 4 3.06 GHz
Intel’s newest, baddest and fastest desktop processor

We test the latest and the best hardware and software products available in the market 

Pentium 4 3.06 GHZ

Performance
Build quality
Value for money
Features
OOVVEERRAALLLL
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SPECIFICATIONS
0.13 micron fabrication, 478
pins, 533 MHz FSB bus, Hyper-
Threading

Price: Rs 41,500
Contact: Nebula Technologies
Pvt Ltd
Phone: 022-22670567
Fax: 022-26331074
E-mail: pratik@nebulatech.com
Web site: www.intel.com
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This silver coloured printer
sports a futuristic design

with matt grey paper flaps
and a translucent black hood
that covers the cartridge bay.
This hood opens just like the
hatch of a car and then slides
along the body surface. How-
ever, the printer has a rather
large foot print. 

HP has revised the print-
er design to include support
for new types of standard car-
tridges and photo-cartridge.
The cartridge installation is
simple and requires no force
for getting them in place.
The cartridges use a smaller
drop size and the printer
comes with PhotoRet IV
which means it provides 
six basic colours instead of
four. Also, PhotoRet IV has
1.2 million colours as
opposed to the 3,500 in 
PhotoRet III mode. 

Depending on the car-
tridge, the printer
works in differ-
ent modes.
With stan-
dard car-
tridges the
printer shifts
to PhotoRet III
(for text printing); with
Photo Cartridge the printer
works in PhotoRet IV (for
printing images). The printer
automatically adjusts the
print resolution depending
on the paper quality. To
print at the maximum rated
resolution (4800x1200) the
paper type has to be selected
manually. 

The printer has support
for A4 sheets and up to 100
sheets can be loaded in one
go. The paper output flap can
handle 50 sheets, however,
the locking mechanism is not

strong enough to hold this
weight. The printer has an 
8 MB buffer and has an IEEE
1284-B parallel port and a USB
port for connecting to a PC. 

In our tests, it printed
text in black and white mode
at a relatively good speed of 
9 PPM. In the fast draft mode,
it was exceptionally fast, scor-
ing 13 PPM compared to the
normal mode of operation. In
the combination document
test, it printed the test file
under a minute in the
greyscale mode, which is
pretty fast. It surprised us by
taking the same amount of
time to print this file in
colour mode! It took approx-
imately 300 seconds (5 min-
utes) to print the test image,
which is fast enough for a
printer in the mid-range cat-
egory. It took around 180
seconds (3 minutes) to print
the image in greyscale. 

The print quality was
crisp and clear, with

no smudging
or jarring.
The image
quality test

showed slight
saturation in the

colour reproduction. The HP
5550 delivers good printing
speed, especially for text and
combination documents.
Though the image printing
speed is a bit slow, it makes
up for this with good image
quality—a good choice if you
want a printer for daily office
printing work and to occa-
sionally print photographs.

65

The S602 looks good with a
dual-tone colour finish

and rounded contours. The
ergonomics of the camera is
spot on with perfect weight
balance. It is powered by four
AA batteries that are placed
such that they balance out
the weight of the lens. 

The controls have been
placed thoughtfully—the
mode selection dial surrounds
the shutter release button and
the zoom controls are
slightly angled
to make it
comfort-
able to be
operated
by the
thumb. The
exposure mode
selector has a rub-
berised feel and provides good
grip, and the command wheel
is placed within thumb reach
and offers a good tactile feel.

It has a 3.1 megapixel
CCD count and is provided
with a zoom lens with 6x
zoom. The camera features
the third generation Super
CCD technology, which helps
in interpolating the image to
6 million pixels. You can also
record a VGA video at 30 fps
with the resolution set to
640x480. Its 1.8-inch TFT
LCD monitor is easy to use
indoors, but as with all LCD
monitors, it’s difficult to use
in bright sunlight, however
you can use the Electronic
View Finder, which has a tiny
0.44-inch LCD, instead. 

This camera includes a 
16 MB Smart Flash card and is
compatible with both Com-
pact Flash type I/II slot and
IBM’s micro-drive. It can be
hooked on to a computer
using the USB port, or the

Video Out jack. It also has a
DC-In jack and a tripod stand
mount. There are several
automatic modes to make it
easy for the aim-and-shoot
users. A very interesting fea-
ture is the ‘last five’ continu-
ous shooting mode, where the
camera takes up to 25 frames
but records only the last five
frames—particularly useful
when shooting at a sports

event where you
can predict the
moment and start
shooting just

before the fin-
ish so you
don’t miss the
action.

In our test
the camera

captured fairly
good details, producing good
tonal balance, except that the
red colour had a slight orange
tinge when seen using the
Histogram feature of Photo-
shop. Also, the edges of the
picture showed a blue halo. In
our resolution test, the cam-
era reproduced a high-quality
image at a native resolution of
2832x2128. 

All in all, this high-end
digital camera has good fea-
tures. Its 6x optical zoom and
support for attaching lenses
such as telephoto and wide
fish eye lens, make it a good
choice for professionals. The
only real hindrance is the
price—at Rs 66,000 it is too
expensive for a casual shut-
ter-bug.

Fuji S602 Zoom Digital Camera
Resolve to click

HP 5550 Deskjet Printer
Hey good lookin’

Price: Rs 66,000
Contact: Jindal Photo films
Phone: 022-28504949
Fax: 022-28504044
E-mail: k_mohan/jpl@jindals.com
Web site: www.fuji.com

Fuji S602
Performance
Build quality
Value for money
Features
OOVVEERRAALLLL
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SPECIFICATIONS

3.1 megapixel zoom lens, 6x
optical zoom, 1.8-inch LCD
monitor, 16 MB Smart Flash
card, four AA batteries

Price: Rs 9,990
Contact: Hewlett-Packard India Ltd
Phone: 011-2682 6000
Fax: 011-2682 6053
E-mail: seema_dawar@hp.com 
Web site: www.hpindia.com

HP 5550 Deskjet
Performance
Build Quality
Value for money
Features
OOVVEERRAALLLL
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SPECIFICATIONS

4800x1200 dpi printing, one
USB, one parallel port, 8 MB
buffer, 100 sheet input tray
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The Iomega is an
external USB

2.0 CD-Writer.
The back panel
has the USB,
PS/2 look-alike
power connector
and Audio Out jacks. The
power connector is unique to
this model and could pose a

problem if the cord
gets damaged as

you can only
obtain it from
Iomega. The
device is USB
2.0 ready and is

capable of 48x write and read
speed and a 24x rewrite speed.
The only bottleneck is the

rare 48x media. 
The writer burned 700

MB of assorted data at 40x in
just 3 minutes, 18 seconds.
It took a little under 3 min-
utes to burn a 610 MB ISO
image and 7 minutes, 27 sec-
onds to rewrite 700 MB at
12x—pretty good for 12x
and once 24x media is easily
available, the results will be
even better.

In its CD-ROM drive
incarnation, it copied the 700
MB of data on the ATA100

drive in just 2 minutes, 57
seconds. This product is a
good buy for those who need
a portable writer that does
justice to its price of 
Rs 9,900. 

Price: Rs 9,900
Contact: Neoteric Informatique
Phone: 022-2417 2600
Fax: 022-2418 5294
E-mail: sales@neoteric-info.com
Web site: www.iomega.com

Iomega CD-RW
Performance
Build quality
Value for money
Features
OOVVEERRAALLLL
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The Kodak CX4200 is a 
2 megapixel camera with a

maximum resolution of 1632x
1232. Its rounded contours fit
nicely into the palm and is
light enough to be carried in
the pocket. The buttons are
slightly tacky
to feel but are
well-placed.
The optical
viewfinder is
at the extreme
left, just above
the lens, so you
have to place your fingers
carefully. It has a 2x digital
zoom that lets you shoot close-
up photos despite the absence
of optical zoom. It has a 1.6-
colour TFT LCD, but it darkens
in the sunlight. The camera
has a Video Out jack and a USB
port and includes a video con-
nector RCA cable along with a
USB cable. It has 16 MB inter-
nal memory and can accom-
modate 20 to 23 pictures at
maximum resolution. You can
increase the capacity by using
a 64 MB Compact Flash card.
The camera supports a wide
range of power options with
an in-camera charging option
through the camera dock, two
AA lithium or Ni-MH batteries

or one CRV3 lithium battery.
The camera comes with an
optional docking stand that
also serves as a charging dock.
A file transfer button on the
dock makes sharing files very
simple. The only sore spot is

that Kodak did not
provide a cover for
the camera. 

In our tests,
the CX4200 was
able to capture all
the details but
without the flash,

the picture looked
dark. In the resolution test, the
image came out hazy. Though
the camera has good colour
reproduction, the overall
image quality is poor.

Overall, this camera pro-
duces sharp and colourful
images when used in well lit
conditions, but if you want
clarity and picture depth at
high resolution, then this cam-
era is surely not for you. 

Kodak CX4200 Digital Camera
Click this

Price: Rs 13,900 
Contact: Neoteric Infomatique
Phone: 022-24172600
Fax: 022-2418 5294
E-mail: sales@neoteric-info.com   
Web site: www.kodak.com

Kodak CX4200  
Performance
Build quality
Value for money
Features
OOVVEERRAALLLL
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The LiDE 20 is a sleek,
intuitive and user-
friendly scanner. The

Installation is quite easy—
Windows XP recog-
nised it without
any hassles.
You can scan
in colour at a
resolution of up to
600x1200 dpi and 48-bit
depth with over 281 trillion
possible colours. It can also be
placed vertically while scan-
ning, thus saving on desktop
space. It has a USB 2.0 inter-
face and hence requires no
external power adapters.

Its Multi scan mode scans
all the pictures in a single pass
and each image is saved in a
separate file. It even adjusts
any misaligned photographs
to ensure precision in your
scanning. Enhanced software
allows scanned images to be
written directly to a CD. 

As far as speed is con-
cerned, it completed a full

colour scan in a fast 47 sec-
onds. The colour output was
also quite bright and matched
the original. Even contrast

and colour blending, the
toughest attributes

to achieve,
were quite
r e m a r k -
a b l e .

Overall, its
p e r f o r m a n c e ,

combined with the
price of just Rs 4,370 makes it
quite an irresistable buy.

SPECIFICATIONS
600x1200 dpi optical resolu-
tion, 9600x9600 dpi interpolat-
ed resolution, 8.5x11.7 inch
scan area, 48-bit colour depth,
USB 2.0 interface. Package
includes USB cable, Scanner
stand and Canon Documenta-
tion Kit with CD containing
ScanGear CS (Windows/Mac)
CanoScan Toolbox (Win-
dows/Mac) ArcSoft PhotoStu-
dio, ArcSoft PhotoBase and
ScanSoft OmniPage SE 

Canon Canoscan 
LiDE 20
Performance
Build quality
Value for money
Features
OOVVEERRAALLLL
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Canon Canoscan LiDE 20
Standing slim

Iomega CD-RW 48x24x48x USB 2.0
Drive
Write on target

SPECIFICATIONS
External USB 2.O interface, 48x
write and read speed, 24x
rewrite speed
System Requirements: Pentium
166 MHz processor, Windows
98/Me/2000/XP, 75 MB hard
drive space

Price: Rs 4,370
Contact: Canon India Ltd
Phone: 011-6806572
Fax: 011-680 7180
E-mail: brijesh.verma@canon.co.in
Web site: www.canon.co.in 

SPECIFICATIONS
16 MB internal memory,
MMC/SD slot, 2 megapixel res-
olution, 2x digital zoom, 1.6-
inch TFT colour LCD screen,
220 gm weight, JPEG/EXIF v2.2
compression
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other features. 
The speakers were very

responsive in the low, mid and
high frequencies—something
that Indian music lovers will
appreciate. It gave good results
when VOB files were played
using PowerDVD—the sound
effects were quite thrilling
when playing games such as
Quake III Arena and Need for
Speed: Porsche 2000. However,
the real power of these speak-
ers is evident while playing
rock or heavy-metal music.

The only thing missing from
this speaker set are the stands
for the satellites. The A5.600 is
expensive at Rs 7,500, but you
wouldn’t mind the price if
crystal clear, booming sound is
what you crave.

WinTally-Acc is an easy-
t o - i n s t a l l ,

versatile account-
ing system. It pro-
vides a standard
graphical Windows
interface and any-
one with basic
knowledge of Win-
dows can start
working with the
software. The tree view inter-
face makes it easy to locate a
report from among the hun-
dreds of files. Also, the use of
graphical representation and
icons makes the interface very
interactive. 

The software has a lot of
features that can be enabled or
disabled depending on your
requirements. It has special
features such as the ability to
lock the year field when final-
ising the accounts for a partic-
ular year. The Repair Compa-
ny command creates an auto-

matic backup on a user-speci-
fied day and time. You
can also choose to dis-
play any statement as per
the required data.

With the capability
to print, e-mail, save and
publish any displayed
screen, this is a very
handy utility.

Its one glaring flaw is
that the data is not very

safe as the database used is 
MS Access, which can be edit-
ed very easily. However, the
Auditing command records all
actions, helping you keep a
check on the editing changes
done by other users. 

Overall, this is a feature-
packed, easy-to-use software,
but the price is a bit on the
higher side.

WinTally-Acc
Tally ho!

Price: Rs 7,500 (single user); 
Rs 11,500 (10 users)
Contact: Lify Pvt Ltd
Phone: (0) 98220 16457
Fax: 022-2237 5845
E-mail: lifycom@lify.com
Web site: www.lify.com

SPECIFICATIONS
Pentium 233 MHz processor, 64
MB RAM, high colour settings,
20 MB hard disk space

WinTally-Acc
Performance
Ease of use
Value for money
Features
OOVVEERRAALLLL
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Norton Ghost 2003 facili-
tates backup, restoration

and cloning data for disaster
recovery. With the new
release, even NTFS partitions
in Windows NT
environment can
be backed up and
restored. It also sup-
ports backing up,
restoring and
cloning EXT3 file
systems in Linux. 

To perform all
these tasks, Norton
needs to copy all
the required files in
the virtual partition
it creates. This is a
space constraint on the Mas-
ter Boot Record (MBR), which
is the location of the partition.

The disaster recovery
facility lets you prepare a
bootable disk, which you can
use to start the computer.

Unlike the previous ver-
sion where you had to back
up the entire drive, Norton
Ghost 2003 lets you back up
just the partitions. 

Another important addi-
tion is the support for external
USB drives. Norton Ghost also

provides a unique feature of
letting you explore the con-
tents of an image file as if it
were a folder on a local drive.
You can even check the integri-
ty of the image file as soon as

it is backed up, before
proceeding to restore. 

What the soft-
ware lacks is an intu-
itive interface and a
scheduler for taking
backups. Its interface
is limited to the wiz-
ards for setting up
new tasks; after that
it reverts to a DOS-

based system, effectively
bringing the system to a
standstill as you cannot mul-
titask.

Though a good product, it
is always better to buy the
complete system suite rather
than just an individual prod-
uct. Besides, for first time
users, there are other easier-
to-use software available.

Norton Ghost 2003
Your friendly neighbourhood ghost

SPECIFICATIONS
486 processor, VGA monitor, 16
MB RAM, Windows
98/2000/Me/XP/NT4 SP6a,
Internet Explorer 5

Price: Rs 2,633
Contact: Symantec
Phone: 022-26570658
E-mail: adeshpande@
symantec.com  
Web site: www.symantec.com 

Norton Ghost 2003
Performance
Ease of use
Value for money
Features
OOVVEERRAALLLL
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Price: Rs 7,500
Contact: Philips Sound Solutions
Phone: 020-7124196
Fax: 020-7123175
E-mail: pss.sales.marketing@
philips.com
Web site: www.philips.com/sound

Philips A5.600
Performance
Build quality
Value for money
Features
OOVVEERRAALLLL
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SPECIFICATIONS
50 watts RMS power output for
subwoofer, 10 watts RMS for
the satellites, 40 Hz-20 KHz 
frequency response, five satel-
lelite, one subwoofer, unified 
5-channel chord, audio cable,
remote with batteries, manual

The Philips A5.600 5.1-
channel speaker offers

good quality surround sound
and does well in the looks
department too. The cord
of the satellites is long
enough to be pulled
to a distance of at

least 15 feet from the PC. The
set has digital volume control
on the centre speaker and

there’s also a remote 
control for accessing 

the controls for 
volume, fade, bass
and treble, and 
for accessing the

Philips A5.600 
The power of six

➜
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DFI’s NT72-SA mother-
board aims to provide an

RDRAM and RAID solution at
a reasonable price, utilising the
Intel 850E chipset. There are
four RDRAM slots
(RIMMs) that
can support
2 GB of sys-
tem memory.
One convenient fea-
ture is the inclusion of
two Continuity RIMMS
(CRIMMS). Another distin-
guishing feature is the two-
channel onboard Promise ATA
RAID controller that supports
RAID 0 (striping) or RAID 1

(mirroring) modes. 
In the benchmarking tests,

the board performed well in
data transfer tests. SiSoft San-
dra 2003 Pro reported a disk

index of 28,766, while PC
Mark reported a disk

index of 972.
This is

pretty good
cons ide r ing

the system config-
uration. If you use

the RAID controllers,
you can expect the indices to
be better still. The bench-
marks also reported a sequen-
tial read time of 42 MBps, ran-

DFI NT72-SA Motherboard
All aboard the DFI express

dom read time of 7 MBps,
sequential write speed of 41
MBps, and random write
speed of 10 MBps. HDTach
confirmed this with a maxi-
mum read speed of 44.6
MBps, utilitsing only 9.5 per
cent of the CPU.

The Quake III Arena test
saw an fps of 285.8 in normal
mode and 281.9 in high qual-
ity mode, but dropped to 
232 fps in maximum quality
settings. The system took
97.54 seconds to convert a 
52 MB MPEG file into the
DivX format. The real attrac-
tion of the DFI is its integra-

tion of onboard RAID and an
RDRAM solution, and the
price tag of Rs 7,950 seems
justified.

SPECIFICATIONS
Two-channel audio codec (but
no onboard graphics); integrat-
ed Ethernet controller; AGP 4x
slot; five PCI slots; one CNR
slot; two PS/2, two serial, one
parallel port and two USB ports
(expandable to 4), connector
for optional IrDA interface; the
RAID controller and driver CD;
three IDE ATA/100 cables, flop-
py disk cable, RAID driver flop-
py diskette and I/O shield

Price: Rs 7,950 
Contact: Zeta Technologies
Phone: 022-2410 2288
Fax: 022-24102277
E-mail: tejas@zetaindia.com 
Web site: www.zetaindia.com 

DFI NT72-SA
Motherboard
Performance
Build quality
Value for money
Features
OOVVEERRAALLLL
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Price: Rs 11,299
Contact: Cyberstar
Phone: 022-26556178
Fax: 022-2655 6181
E-mail: sushilb@cyberstarin.net  
Web site: asia.creative.com

The MuVo portable MP3
player doubles up as a

removable USB drive. It has a
separate battery pack. 

Installation is
simple and
Windows 98
detects the
player and
configures it as 
a removable drive.
Windows Me and later
versions do not require 
you to run the installation
program. 

The model that we tested
had 64 MB of storage. This
translates into slightly over an
hour of playtime. It has a
good power consumption and
the battery held up even after
9 hours of use. Unfortunately
though, it is not equipped to
shuffle or program your
playlist.

Another sore point was

the frequency response of the
earphones—although high
frequency reproduction was
excellent, bass frequencies
took a beating. Crank up the

volume to the fullest and
you get ear-splitting dis-

tortion-free sound. 
The player

doesn’t have
ID3 support

or an LCD
screen, something

we’ve come to expect
from an MP3 player.

The Creative NOMAD
MuVo can dish out some pret-
ty high decibels. The 64 MB
version of the MuVo costs a
whopping Rs 11,299. 

SPECIFICATIONS
64 MB internal memory, neck
strap, earphones, manual, driv-
er CD, battery pack, USB inter-
face

Creative NOMAD MuVo 
Gypsy player

VariCAD 8.2-0.4 is a fast,
compact and economical

mechanical CAD package fea-
turing true 3D modelling,
solids and spatial
analysis, 2D to 3D
and 3D to 2D projec-
tion and extrusion,
parametric symbol
and mechanical part
libraries and surface
development utilities.
It can be installed as
a stand-alone applica-
tion or on a server and net-
worked in peer-to-peer and
client-server configurations. 

Most functions are pre-
sented as icons and also in the
menu bars. When working in
a networked environment,
each user can customise the
menus and icons according to
their liking. 

The software imports and
exports common CAD file
types (DWB, DWG, DXF and
IGES). The files can be con-

verted individually or as
whole directories. You can
also use file name filters.
Thus, you can transfer a
whole drawing documenta-

tion using one com-
mand line. 

For a high price of
Rs 19,950, it delivers a
strong value, though
the learning curve is
rather steep. However,
the software provides
tool tips and well-

crafted samples of program
features to make the learning
curve easier. The application
is also demanding on your
system—make sure you have
the requisite hardware to
work smoothly with this
application.

VariCAD 8.2-0.4
Designs on you

SPECIFICATIONS
Pentium II processor, 128 MB
RAM, 16 MB graphics card with
hardware support for OpenGL
graphics

Price: Rs 19,950
Contact: G T Enterprises
Phone: 080-660 6093
Fax: 080-633 1047
E-mail: gtcdrom@vsnl.com 

Creative NOMAD MuVo

Performance
Build quality
Value for money
Features
OOVVEERRAALLLL
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VariCAD 8.2-0.4
Performance
Ease of use
Value for money
Features
OOVVEERRAALLLL
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Seagate’s 120 GB Barracuda
hard disk supporting 

ATA V with a spindle speed of
7,200 rpm, has two platters of
60 GB each and four
read/write heads, result-
ing in very quick
retrieval of data.
It sports a stan-
dard 2 MB
buffer and uses
Giant Magne-
toResistive (GMR)
recording heads, resulting
in greater areal density, which
makes larger disk sizes achiev-
able.

The drive was tested on a
Pentium 4-based test bench,
with a 2.8 GHz CPU, Intel

D850 EMV2 motherboard
with 256 MB RDRAM, and a
GeForce4 Ti 4600 graphics
accelerator. This drive gave us
excellent results in the per-
formance tests. It transferred

assorted data of 
1 GB in a mere 
57 seconds. The
SiSoft Sandra

2002 Pro bench-
mark reported an

average access time of
13.1 milliseconds,

sequential read/write rates
of 41/40 MBps, and random
read/write speeds of 8/9
MBps, which is indeed very
good. Photoshop 7.0 took a
mere 12 seconds to load and

Seagate ST3120023A 
(120 GB Barracuda)
Speedy Gonzales

it opened a 190 MB image file
in 14 seconds, which high-
lights the file transfer speed of
the drive.

The disk took 14.2 seconds
to load a saved game in Return
to Castle Wolfenstein. This is
especially good news for
impatient gamers. There real-
ly aren’t any drawbacks to
this drive, except for perhaps
its price. If you do not need
the maximum storage space
that money can buy, but you

do want all the speed you can
get, then this is the drive for
you. As far as storage goes, it
sits smack in the middle of
the gap between the low-end
40 to 80 GB dwarves and the
top-end 160 to 200 GB giants. 

SPECIFICATIONS
ATA V support, 7,200 rpm, 120
GB, 2 MB buffer

Price: Rs 12,500
Contact: Seagate Technology
Phone: 1600 331104 (toll free)
Web site: www.seagate.com

Seagate ST3120023A 
120 GB
Performance
Build quality
Value for money
Features
OOVVEERRAALLLL
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Price: Rs 5,145
Contact: Mediatech India
Phone: 022-239 6696
E-mail:
sales@mediatechindia.com
Web site: www.liteon.com.tw

Liteon has introduced a
new 52x Writer, the

LTR55246S. It is surely one of
the fastest writers/re-writers
available today. In fact, in
the Indian mar-
ket, as of today,
there are no CD-
Rs that can sup-
port a writing speed of
52x. The maximum writ-
ing speed supported by media
available today is 48x.  

Its build quality is pretty
average. A design on sturdier
lines would have been appre-
ciated. It has a standard 
2,048 KB buffer. The buffer
underrun prevention technol-
ogy used by Liteon is SMART-
BURN, which is also used for
the optimisation of the CD
burning process, to ensure
that data is written accurately
on to the CD-R/CD-RW.

The test was performed on
a Pentium 4 2.2 GHz CPU,
running on an MSI Max2 BLR
motherboard, with 256 MB
DDR RAM and a Radeon 8500
accelerator. In all of the tests,

the Writer performed at the
maximum speed that the 
CD-R medium would allow.
Nero CD Speed reported mini-

mum, average and maxi-
mum speeds of

24.24x, 39.34x
and 41.31x,
respectively.
There weren’t

any hitches at any
stage of the other tests

either, proving the quality and
capability of the Writer. 

What’s more, at Rs 5,145,
it’s a pretty good deal as well.
Considering it is one of the
world’s fastest writers, that’s
not a bad price at all. If you
happen to have a raging fast
machine that can support the
data speeds required by this
CD-Writer, then by all means,
go for it.

SPECIFICATIONS
Write/re-write/read speed:
52x/24x/52x, 2,048 KB buffer,
SMART-BURN technology for
optimum writing, includes
Nero - Burning ROM v 5.5.

Liteon LTR55246S
Not to be taken lightly

Though this 5.1 channel
system has a 5,800 watts

PMPO, it has only 25
watts RMS for the satel-
lites and 50 watts RMS
for the subwoofer. The
RMS power
gives you an
idea about the
actual sound
output that the system can
achieve without distortion,
whereas the PMPO output
indicates the maximum out-
put achievable by the system,
albeit with distortions.

The wires are long enough,
and speaker stands and wall
mountings are provided as
well. One shortcoming is the
ridiculously short power sup-
ply wire. 

The system provides good
performance and at Rs 7,000,

it offers good value for
money. The subwoofer is
quite powerful and you can

crank up the volume with-
out experiencing too much

distortion. If you’re
looking to
own a 5.1
speaker sys-
tem, but are

constrained by your budget,
the Mercury HT 5800R offers a
decent enough solution. How-
ever, if you cannot settle for
anything less than perfect
sound, give this one a miss.

Mercury HT 5800R Home Theatre
5.1 Channel System
Drowning in sound

SPECIFICATIONS
Four satellites at 25 W RMS,
one subwoofer at 50 W RMS,
wall and stand mounts, remote
control with batteries
System Requirements: Sound-
card with 5.1 channel output

Price: Rs 7,000
Contact: Kobian India Ltd
Phone: 080-5566626
Fax: 022-5566625
E-mail: rohit@kobian.com
Web site: www.kobian.com

Liteon LTR55246S

Performance
Ease of use
Value for money
Features
OOVVEERRAALLLL
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Mercury HT 5800R
Performance
Build quality
Value for money
Features
OOVVEERRAALLLL

BB



test drive ■
■ undercover

72 JANUARY 2003

It was one of those mornings where you
get up feeling something essential is
missing. I checked to see if all my

appendages were in place, they were. My
trademark goatee then? No, that felt right
too. Then suddenly I hit upon it, I didn't
have a handheld! Oh the
shame of it all, me being a
techno-geek and all that.
Of course, I did need it for
the practicality of being con-
nected to my data and information
wherever I went, but that’s second-
ary. A handheld I want and a
handheld I shall get. First
stop, to the bank. Turns
out I have just enough,
so off I go.

Before I
indulge myself, I
chalk out the list
of functions I intend
to use my new toy for.
Hmm, I need it for reading
my e-books and Web pages,
and it must have good
organisation capabilities to
make sense of my chaos. A
little ability to synchronise with other
external applications wouldn’t hurt
either—all this at the lowest possible
price, of course.

The most affordable device in the
market right now is the Palm m100 priced
at Rs 6,000. Though its specifications are
showing signs of age—2 MB of memory
and a basic monochrome screen doesn’t
really allow much, but is suited to text-
based applications. Placed a notch high-
er is the Palm m105 with 8 MB of memo-
ry, costing Rs 8,500. But there’s a new kid
on the block, the funky Palm Zire made
for first time users. However, none of the
dealers I spoke to in Andheri, Mumbai,
would give away its price. 

Next up, I spotted the Palm m125
monochrome with expansion slots for
MMC and Secure Digital cards. This one
had 8 MB of memory and came with the
mandatory set of organisation software
and synchronisation via infrared and USB
connectivity. The Palm m130 is also sim-

ilar but it has a slightly bigger colour
screen. The Palm m125 uses AAA batter-
ies, while the Palm m130 uses recharge-
able Lithium Ion batteries and has very
good battery life. The m125 costs around
Rs 11,000, while the m130 is priced at

around Rs 13,500. The
prices are about Rs

500 to Rs 1,000
more in the
white market
and you get the
advantage of a
solid warranty

and a boxed
package.

Still higher are
the popular 500-series
Palm devices. The
Palm m500 has a
sharp monochrome
screen with 8 MB of
memory, a faster
processor than the
m1xx series and is
one of the lightest
devices available.
The colour device
in this range was

the Palm m515,
which has 16 MB of memory and uses a
rechargeable Lithium Ion battery with
Flash ROM upgrade capabilities. The m500
is priced at around Rs 18,000 while the
colour m515 comes in at around 
Rs 23,000. On the higher end, the new
Palm Tungsten T device has an ARM-based
processor and a crisp colour display. It runs
the latest Palm OS 5 software and is packed
to the gills with features such as 16 MB of
memory, Bluetooth, voice memo, headset
jack and even cellular phone capabilities.
All these features obviously mean a high
price, but here too, none of the dealers had
any information.

I even checked out the Pocket PC
arena, but most the dealers stocked only
the Compaq iPAQ series of handhelds,
with the iPAQ 3800 being the most pop-
ular choice. It comes with 64 MB of
memory and runs Microsoft Pocket PC
2002. With full multimedia capabilities

(yes, it can play back MP3s as well as
movie clips), a full colour screen and
plenty of application and organisation
software, it does full justice to its price
tag of Rs 33,000. Similar in capabilities
are Pocket PCs from other brands such as
Toshiba, Casio, HP, etc. However, none
of them came lower than Rs 25,000. 
Oh well…

Acknowledging that the world of
Pocket PCs held nothing for me, I settled
for the Palm m125. It suited my needs
quite well and left me with enough
money to get back home!

Fistfuls of Power
Agent 001 scouts the market for a handled device that fits his pocket

■ Memory: Depending upon
the types of applications you
plan to use, a handheld’s inte-

grated memory could run out
faster than you would imagine. You

will need at least 4 MB of memory for
text-based applications and 16 MB for
storing media files.
■ Compatibility: Your handheld should
support your applications and be able to
exchange information with your desk-
top PC and other handheld devices.
■ Expandability and upgradability:
Choose handhelds that allow the OS to
be upgraded. Look out for ones that
allow the firmware to be upgraded
through Flash programs.
■ Screen size and resolution: Mono-
chrome screens are suited to most
applications; colour screens are for
those who intend to work with graphics
and video files. Look for a colour screen
with good resolution, clarity and bright-
ness, and one that is clearly legible in
the dark as well as in bright light.
■ Battery life: Rechargeable Lithium
Ion batteries are preferable for longer
on-road life. Even if it uses conventional
alkaline batteries, make sure it has a run
time of at least 10 hours.
■ Integrated features: Opt for devices
with additional features such as a cellu-
lar phone or camera only if you are
going to actually use them. These frills
add significantly to the cost.

ILLUSTRATION: Mahesh Benkar
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Are we ready for a no-holds-barred cinema quality gaming experience? Or will the GeForce FX prove to
be yet another video card with simply faster memory and processing speed?

Movies such as Final Fantasy
and Jurassic Park left us gap-
ing with their colourful tap-
estry of digital animation.

The ‘rendering farms’ used to create these
magic movies comprise new-age render-
ing supercomputers that run on
advanced processing capabilities.
Enchanted by such movies, the aim of
every game designer and graphics hard-
ware manager has been to bring this real-
ism to a gaming experience. And this is
exactly what the new GeForce FX aims to
deliver. 

While there has been no dearth of
capability and programming skills to
accomplish this, graphics cards were not
capable of processing this vast amount
of information at a pace faster than that
of a slideshow. Over the years, every
new card has tried to achieve realism
with varying degrees of success. Hence
the launch of a new graphics card usual-
ly generates more excitement in the 
IT community than any other hardware.
Often, the revelation of the card’s 

specifications shows it to be merely 
an enhancement of the existing tech-
nology—made faster by upping clock
speeds and adding more rendering
pipelines, or conversely, by chopping a
couple of components to make the card
accessible to different market segments.

Enter the GeForce FX
The GeForce FX is built
using a 0.13-micron fabri-
cation process unlike the
0.15-micron technology
used by the reigning king of
graphics hill, the ATi
Radeon 9700. The smaller
fabrication process makes it
possible for this card to be
laden with 125 million
transistors—compare this
with the 108 million tran-
sistors used by the Xeon MP
processor. While this fabri-
cation process does offer
greater density for packing
in more transistors and

lower heat emission levels, it is a difficult
process to implement. 

This has been the primary reason for
the cards delay—it was supposed to be
released by December 2002, but the date
has now been pushed forward to mid
2003. Also, this card complies with and
even exceeds the specifications of the
upcoming DirectX 9 API—while DirectX

9 will allow for a far
greater effects and capa-
bilities for tomorrow’s
games and applications,
the GeForce FX will be
able to take advantage
of future graphics APIs
as well. Therefore, when
tomorrow’s games and
applications support
these new capabilities,
only cards such as the
GeForce FX will be able
to take full advantage of
their visual splendour.

Let’s take a look at
some of the newer tech-

Intense graFX!Intense graFX!

The pixel shader in the
GeForce FX can process

51 billion floating point
operations per second.
This…
■ Can render over a hundred
Jurassic Park dinosaurs at
100 frames per second
■ Has more floating point
power than a Cray SV-1
supercomputer
■ Is 120 times the distance
from the Earth to the Moon,
if converted to metres
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nologies that help deliver this promise of
cinema-quality gaming. 

Parallel vertex shader and pixel
pipelines
The vertex shader is the element that
allows complex meshes and 3D objects to
be created within games. In the GeForce
FX, this component was created from
scratch—while the GeForce 4 had two sep-
arate vertex shader units, the GeForce FX

features just a single pipeline. This singular
pipeline is equipped with parallel floating
point units that work together to deliver a
claimed triangle processing rate of 375 mil-
lion triangles per second (compared to the
Radeon 9700’s 325 million triangles per
second). When coupled with the DirectX 9
specification, the card can process vertex
shader programs while using 65,536
instructions (the GeForce4 Ti class cards
uses only 128 instructions), constants and
loops (primitives that are used in the cre-
ation of these programs). So what does all
this translate into? While earlier cards
allowed only for models with increasing
polygon counts, the advanced vertex shad-
ing techniques of the GeForce FX will make
even facial expressions possible.

While vertex shader warrants greater
flexibility and innovation in modifying
meshes and therefore greater realism, the
pixel shader does wonders for the textures
and special effects on the surfaces of these
3D models. Everything from the mouldy
rusted iron girders to the clammy, cold
texture of an alien’s skin will be defined
using these new innovations.

The pixel shader unit of the processor
in the GeForce FX has been considerably
revamped to add functionality for the
DirectX 9 API. Also, pixel shader programs
can now use up to 1,024 instructions with
up to 16 textures per pixel, allowing for
very complex effects on the 3D model sur-
faces. Some of the new pixel operations
are soft shadows on 3D models and frame-

buffer post processing effects such as blurs
and halos (from streetlamps and car head-
lights). Programmers can also assign func-
tions to certain textures to call upon spe-
cific effects and actions. Volumetric ren-
dering can be implemented through algo-
rithms for generating effects such as
smoke, fire, fur, grass, etc. Complex light-
ing effects can be achieved over a single
pass as opposed to using up many clock
cycles for rendering a given light effect.
Finally, the pixel shader also features 64
temporary registers (compared to 12 for
the Radeon 9700), which are used for stor-
ing complex instructions that are sent to
the graphics processor.

DDR2 memory
Another big advantage is the
support for DDR2 memory.
Operating at a blistering 500
MHz frequency on a 128-bit
data bus, this interface offers
a 16 GBps bandwidth. Even
though the memory width is
lower than that of the Radeon
9700, the effective bandwidth
is higher for two reasons: the
effective frequency is higher
with the DDR2 memory and
every bit of data that comes
out of the rendering pipeline
is compressed in the hardware
before being sent to the mem-
ory. On an average, nVidia
states that there is a 4:1 com-
pression ratio that occurs and
therefore, the resultant mem-
ory bandwidth of the card is
effectively raised to 48 GBps—
that’s the contents of an entire

The GeForce FX can spell all the difference
between a frown and a wry smile. The effect is
apparent, as modelled by Dawn, the pixie
mascot of the GeForce FX

GPU Clock: 500 MHz
Memory Clock: 250 MHz
(1000 DDR2)
Chip Technology: 256-bit
Memory Bus: 128-bit DDR2
Pixel pipelines: 8
Vertex shader: Floating
point array
Process: 0.13 micron
Transistors: 125 million

GeForce FX
GPU

AGP 8X interfaceVideo encoder

VGA outDVI out

S-Video
out

128-bit DDR2
memory
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40 GB hard disk transferred in a little
under a second!

Intellisample technology
While most of the pixel and vertex speci-
fications are focused on DirecX 9, the
pixie dust here is a technology called
Intellisample that will make even games
such as DOOM III run faster. Intellisample
is a comprehensive set of technologies
that includes a new colour compression
engine, improved fast z-clear, dynamic
gamma correction, adaptive trilinear and
anisotropic filtering, and anti-aliasing. 

The GeForce FX maximises its memo-
ry bandwidth by compressing all the data
that comes out of the rendering pipeline
before sending it to the memory con-
troller (as described above). This results in
a direct increase in effective memory
bandwidth, allowing for larger and more
complex textures. This is noticed espe-
cially when anti-aliasing is enabled, where
the demands placed on the memory
bandwidth are greater. There is a newer
algorithm for clearing the z-buffer (for get-
ting rid of obstructed or invisible poly-
gons), resulting in faster frame processing.
Finally, the card uses various methods for
implementing filtering options. The user
can choose between a direct filtering

option (trilinear or anisotropic), or a less
accurate but a high performance option.
This will result in a lower performance hit
compared to running the card in any one
of these filtering modes directly. 

Faster core and memory speeds
When it debuts, the GeForce FX is expect-
ed to have a core speed of 500 MHz and a
memory speed of 250 MHz (effectively 
1 GHz due to the 4x increase, being
DDR2). This is significantly higher than
the Radeon 9700’s core speed of 325 MHz
and 310 MHz DDR memory.

In newer games such as Stalker or Ral-

liSport, the realism in the models and envi-
ronment is unprecedented due to the use
of very high polygon-count. Also, the 128-
bit colour support allows for hitherto
unseen levels of accuracy in colours and
specular highlights in the game.

FX flow
Given the high core and memory speeds,
the card needs to breathe well. Hence, it
uses an advanced cooling system involv-
ing the use of heat pipes. In addition to a
heat sink on the critical heat-generating
components such as the GPU and memo-
ry chips, there are tiny copper pipes that
draw the heat away from these elements.
This is implemented through a special air-
flow duct in conjunction with the cool-
ing fan, resulting in a large cooling
assembly that takes up the space of two
slots in your cabinet!

The last word
Every once in a graphics era comes a prod-
uct that offers not only high clock speeds
or more memory, but truly intelligent tech-
nology with a specific goal and uses inno-
vative methods to attain it. nVidia’s
GeForce FX is one such product that repre-
sents a new species of graphics hardware
built to redefine desktop graphics. 

While all this technology scientifical-
ly translates into more pixels per second,
greater colour depths and better filtering,
the truth will be bared when we see shim-
mers on water and winking characters on
our desktops. Though this card will be out
of our financial reach, in time, the tech-
nology will trickle down to more afford-
able solutions. So be prepared for the time
when you can feel the knot in the pit of
your stomach while you watch a gleaming
Lamborghini Murciélago tear down your
screen—the only difference being that
instead of watching this with a bag of
popcorn, you’ll be holding a joystick in
your hand! 

MARCO D’SOUZA

The level of detail in the environment and
skies is made realistic by the GeForce FX’
ability to process a large number of polygons
at high speeds

The enormous air intake duct and heat pipe
solution help keep the GeForce FX cool

Specification 

Chip technology
Process
Transistors
Memory bus
Pure memory
bandwidth
Pixel fillrate
Anti-aliased Fillrate
Max FSAA mode
Triangle transform
rate
AGP bus
Memory
GPU clock
Memory clock
Memory
Vertex shader
Pixel pipelines
Texture units per
pipe
Textures per tex-
ture unit
DirectX generation
memory 
Optmisations

nVidia GeForce FX

256-bit
0.13 micron
125 million
128-bit DDR2
16 GBps

4 Gigapixel/s 
16 billion AA samples/s
8x
350 milion triangles/s

1x/2x/4x/8x
128/256 MB
500 MHz
250 MHz (1000 DDR2)
BGA 2.0 ns
FP Array
8
1

16

9.0 (+)

LMA II optimised
colour compression

ATi Radeon 9700 PRO

256-bit
0.15 micron
107 million
256-bit DDR
19.8 GBps

2.6 Gigapixel/s
15.6 billion AA samples/s
6x
325 M milion trian-
gles/s
1x/2x/4x/8x
128/256 MB
325 MHz
310 MHz (620 DDR)
BGA 2.9 ns
4
8
1

8

9

Hyper Z III

nVidia GeForce4 Ti4600

256-bit
0.15 micron
63 million
128-bit DDR
10.4 GBps

1.24 Gigapixel/s
4.8 billion AA samples/s
4x
69 M milion triangles/s

1x/2x/4x
128 MB
300 MHz
325 MHz (650 DDR)
BGA 2.8 ns
2
4
2

4

8

LMA II

Old vs New
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Fishing freshwater bends and 
saltwater coasts rewards anyone feeling
stressed. Resourceful anglers usually find

masterful leapers fun and admit swordfish
rank overwhelming anyday.

Still trying to figure out what this means?
This is a crudely encrypted message for  com-
municating secretly with someone. By taking
the third letter in each word, the message reads:
“Send Lawyers, guns and money.”

To some degree or the other, we are all
familiar with the art of stealthy communi-
cation and passing secret messages. We’ve
done it in school, devising ‘secret’ code like
the one shown above to communicate with
an exclusive band of friends. We’ve read
about it in spy thrillers—from fairly low-tech

methods like hiding information about
traitors to the French revolution in a piece
of knitting (A Tale of Two Cities), invisible
ink, ultrawide radio transmissions that
hide messages within noise-like signals
and what have you. We’ve tried to secure
our own communications by hiding infor-
mation through encryption. And now
there’s another subset to the art of keep-
ing it secret—steganography. 

Stegano…what?
The word Steganography literally
means ‘covered writing’. The tech-

nique dates back to the ancient Greeks
who sent information by scraping the

wax off a tablet and writing a message on
the underlying wood. The tablets were then
covered with wax again, rendering them
innocent when inspected by the sentries. In
modern times, the technique works to 
camouflage information. You can hide data
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A picture speaks
a thousand words

Steganos Security Suite 4, 
S-Tools 4
Find them on the Mindware CD

Draw a picture and hide a
book of thoughts within,
using steganography

A picture speaks
a thousand words
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within still images, audio or even video.
Steganography software store the classified
information in the least significant bits of
a digitised file, bits that can be changed in
subtle ways that cannot be detected by the
human eye or ear. 

The information is first encrypted as
a data file. Once you have this, you need

to select a carrier file on which the data
file can be encoded. The carrier file can
be any graphic or audio file eight times
the size of the data file. For example, one
could hide information in, say, the nose
of a puppy on a pet-adoption Web site.
The intended recipients can then extract
the information.

Message in a bottle
There are different kinds of carriers, which
can carry your message across mediums.
The earliest form of steganography was hid-
ing messages in text. With the evolution of
multimedia applications, it became easier
to hide messages in still images since these
are larger files. Audio and video carrier files
are less perceptible, hence providing high-
er invisibility. The technique of steganog-
raphy is more or less the same in each
carrier file.
Messages in text: Secret messages can be
hidden in text format by reframing the text
of the carrier file, while maintaining the
context. One form of Steganography is a
program called Spam Mimic. Based on a set
of rules called a mimic engine by Peter
Wayner, it encodes your message into what
looks just like your typical, quickly deleted
spam message. However, hiding a message
in plain text is a thing of the past, as peo-
ple are suspicious of irrelevant text. 
Messages in still images: This is the
most popular method of steganography as
minor changes in colour are unnoticeable
to the human eye. Outguess, a universal
steganography tool, comprises data-specif-
ic handlers (code) that extract redundant
bits in an image and write them back after
modification. Outguess can use any kind
of data file as a carrier, as long as a handler
is provided. The amount of message that
can be encrypted depends upon the size of
the carrier.
Messages in audio: Messages in audio are
always sent along with ambient noise. The
data is hidden in the heart of the Layer III
encoding process of an MP3 file, namely,
the inner loop during compression. The
inner loop limits the input data and
increases the step size until the data can be
coded with the available number of bits.

Dissecting Steganography

Various tools are available for concealing and
sending messages using steganography.
Some of the commonly used tools are:
■ Steganos Security Suite 4 uses powerful
128-bit encryption. It
would take 1 billion pow-
erful computers millions
of years to try every com-
bination to gain access to
your personal informa-
tion. This software uses
steganography along with
encryption to completely secure your data.
Web site: www.steganos.com

■ Datamark Technologies has a number of
products lined up for steganography. They
currently market four digital steganogra-
phy products, namely, StegComm for con-
fidential multimedia communication,
StegMark for digital watermarking storage
media, StegSafe for digital storage and
linkage, and StegSign for e-commerce
transactions.
Web site: http://www.datamark-tech.com/data-
mark.html
■ Blindside is an application of steganogra-
phy that allows you to conceal a single file
or set of files within a standard computer

image. The new image looks identical to the
original, but can contain up to 50 k of data.
The hidden files can also be password
encrypted, to prevent unauthorised access.
Web site: http://www.blindside.co.uk
■ MP3Stego hides information in MP3 files
during the compression process. The data is
first compressed, encrypted and then hid-
den in the MP3 bit stream. Although
MP3Stego was written with steganographic
applications in mind, it can also be used as a
copyright marking system for MP3 files.
Web site: http://www.cl.cam.ac.uk/~fapp2/
steganography/mp3stego

Stegano Tools
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The data is first compressed, encrypted and
then hidden in the MP3 bit stream. An out-
sider, however, can attack it by uncom-
pressing and recompressing the bitstream,
deleting the hidden information with
severe loss to quality.
Messages in video: Embedding informa-
tion into multimedia data has gained
increasing attention lately. The method of
encryption is the same as in audio
steganography. Video files are generally
very good carrier files since they have a lot
of irrelevant bits. 

Steganography and watermark-
ing 
Steganography also enables an evolved
form of watermarking. Usually, covert
channels in the carrier file carry hidden
data unrelated to the content in which it is
embedded, but digital watermarking holds
information about its carrier medium and
is broadly defined as an imperceptible
insertion of information such as a number
or text into a multimedia file through
slight data modification. This process has
gained huge acclaim from the media for
enabling copyright for their products. 

Video steganography is more suited to
avoiding piracy and is mostly used for dig-
ital watermarking. The owner’s data is
embedded either into the uncoded video
or into the MPEG-2 bitstream and can be
later retrieved from the decoded video.
Although an existing MPEG-2 bitstream is
partly altered, it does not visibly distort the
original video information.

Many commercial graphics programs
allow artistes to embed their names as well
as copyright notices within images. Some-
times the concealed message may consist
of a single bit that simply says ‘That’s done
by me!’ This is sufficient to accomplish the
desired purpose—a recording or playback
device can detect this watermark and refuse
to function, disabling access to the data if
the user doesn’t have the authorisation.

There are two types of digital water-
marks—robust and fragile. A robust water-
mark is embedded in the file in such a way
that even if the file is later transformed, the
watermark will not be removed. A robust
digital watermark is a concealed message
that identifies the source of the data. It is
called robust because it is designed to sur-
vive modifications to the data that result
from resizing, cropping, or photographing
an image to capture only the part of the
image that doesn’t have the watermark, or
even from re-sampling or making an ana-
log recording of an audio stream. Its appli-
cation includes copyright protection,
labelling, monitoring, tamper proofing and
conditional access.

On the other hand, fragile digital
watermarks are similar to fragile analog
watermarks—if the data is altered or copied
inexactly, the watermark is corrupted. If
changes are made to a file containing a
fragile digital watermark, the originator of
the watermark will be able to detect and
identify the areas where the alterations
have been made and maybe even deter-
mine what the data was before modifica-
tion. This scheme serves at proving the
authenticity of the data. 

For ensuring the integrity of data, dig-
ital signatures are preferred but fragile 
digital watermarking can detect data 
tampering without alerting the culprit.
Compatible players refuse to play content
that does not bear a valid watermark. 

All part of one family 
So how is steganography different from
encryption? While cryptography protects
the content of messages (their meaning),
steganography conceals their very exis-
tence. In encryption, the reader can see

The World Intellectual Property Organiza-
tion (WIPO) has drafted a treaty, which
requires countries to penalise those who
remove digital watermarks. The Digital
Millennium Copyright Act (DMCA) seeks
to prevent any individual from forging or
removing a watermark, or from creating
or publishing about hardware or soft-
ware that is capable of doing so. New
legislation now pending in the US Con-
gress will, if it is passed, specifically
penalise those who alter watermarks.
Thus, you could not legally create a
home recording on a player restricted to
playing for example, only Disney titles or
only titles for which a fee had been paid
to the player’s manufacturer or a consor-
tium of recording companies.

The Law Effect

Plenty of free and shareware steganogra-
phy software can be found on the Net. A
list of such software can be obtained at
http://www.cotse.com/tools/stega.htm or
http://www.cl.cam. ac.uk/~fapp2/steganogra-
phy/stego_soft.html. We are using a software
called S-Tools 4 to hide one image within
another. The receiver would need the same
software to decode it and would also need
to know the passphrase and the encryp-
tion algorithm.

Start S-Tools and Windows Explor-
er, using the latter as a drag-and-

drop interface for the software.

Drag and
drop the

image to be used
as the carrier file
from the Explorer
onto the Actions
window in 
S-Tools.

Drag and drop
the data file on

the carrier file. 

You will be
prompted to

secure the process using
a passphrase and an
encryption algorithm.
Convey these to the receiver too.

The hidden data file is ready.
Once the recipient receives it,

he or she can just right-click on the file
and choose Reveal. To extract it, right-
click on the image and save it in the des-
tination folder.

1
STEP

2
STEP

3
STEP

4
STEP

5
STEP

It’s a Secret!

The data file
to be hidden
within the
carrier file

The carrier file

Securing the data file through encryption

Extracting
the hidden
file 

A digital watermark embedded in an image
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the data but cannot decode it if he does
not know how to do so; if the reader
knows how to decode the data, it isn’t
secure. In steganography, the reader isn’t
even aware that the data is being sent! It
is often accepted that communications
can be secured by encrypting the data, but
this is not very reliable in practice. To
ensure a high level of security, the ideal
combination would be of encrypting the
data and then sending it across using
steganography.

Watermarking, as opposed to steganog-
raphy, needs the additional protection
against attempts by pirates at
distorting/removing the watermark. In this
context, the robustness depends on the

application. 
C o p y r i g h t

being the main
area of water-
marking, the
data need not
always be hid-
den, as some sys-
tems use visible
digital water-
marks. However,
the media has
mostly focused

on imperceptivity —invisible, inaudible
digital watermarks that have wider appli-
cations.

Modern visible watermarks may be
visual patterns such as a company logo or
copyright sign overlaid on digital images.
In most cases the information hidden
using steganographic techniques is not
related at all to the carrier file. These dif-
ferences in goal lead to very different hid-
ing techniques.

The final truth
Technology is a double-edged sword,

which can be used and misused depending
on the user. Steganography is an exam-
ple of this sword. It can be used for safe-
guarding data, such as in the field of
media where copywriting ensures
authenticity. On the flip side, many a
terrorist and anti-humanist activities
have been carried out cloaked under this
technique.

While we may be able to put our trust
in good faith and sense, predecessors of
steganography, encryption and ciphering
have proved that there is more harm than
good to be done by it. 

JANUARY 2003

The art of detecting, decoding, erasing and
altering messages hidden via steganography
is called steganalysis. It is easiest when the
before as well as the after steganography
copies of the file are present. Steganalysis,
can make the hidden data work against the
creator. Any malicious interceptor could alter
a carrier file without the knowledge of either
the sender or the intended receiver. Hence,
inaccurate or wrong data could be passed
under the identity of the original sender.

Steganalysis tools are found aplenty on

the Net. One only needs to be aware of the
carrier files; what follows is a three-step
process—acquire, extract and destroy or
modify. Stegdetect, for instance, is an auto-
mated tool for detecting steganographic
content in images. It is capable of detecting
several different steganographic methods
that embed information in JPEG images. 
Currently, the detectable schemes are 
jsteg, jphide (Unix and Windows), Invisible
Secrets, Outguess 1.3b, F5, AppendX and
Camouflage.

Steganalysis

1/2 page Ad
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REVEALING
Windows
Every Windows user unwittingly

leaves his or her PC naked to pry-
ing eyes. It doesn’t take a pro-
grammer or cracker to get to your

computer. Keys are left in every door and
windows (no pun intended) are well oiled
to make it simpler. Microsoft quietly
assumed that ‘desktop users’ would never
have the need for security and unabashed-
ly discarded all such features from its
‘home user operating systems’, as against
the server OSes.

This does not mean that we have to
continue to pay for the oversight of the
software giant. We can take our own steps
to safeguard our PCs and data. Here are
some of the most blatant security lapses
and workarounds for the weaknesses.

Windows logon
The Windows logon is the worst pseudo
security measure—by itself, it simply 
cannot prevent unauthorised access to 
your computer. Microsoft designed the

operating system for just desktop PCs, and
assumed that security was required only for
servers. Thus, the Windows logon only
loads the correct desktop settings and can
be bypassed by simply pressing [Esc]. There
are some ways to make it more secure,
though these are not the most elegant solu-
tions. Still, it will take more than just a lit-
tle effort to bypass these.

First, configure your Windows for mul-
tiple users from Control Panel > Users. Create

a new user by typing a new name at the
Windows logon box, then restart Windows
and login as the new user. Open the reg-
istry by running regedit from Start > Run
and navigate to HKEY_Users\.Default\Soft-
ware\Microsoft\Windows\CurrentVer-
sion\Run. If the Run key does not exist,
create it. Create a new string value named
LockEscape, and set its value to rundll32
shell32,SHExitWindowsEx 0. Now when you
log off or restart the machine, you can
login as the new user created, but if the
Cancel button or the [Esc] key is pressed,
the desktop will partially load and then
return to the login screen. Optionally, you
could set the PC to shut down upon unau-
thorised access, but this can get very irri-
tating. To do this, use the command
rundll.exe user.exe,ExitWindows as the value for
the registry key.

This method basically takes advantage
of the Windows architecture. When log-
ging in as a particular user, Windows loads
the user’s profile with Desktop settings, Set up multiple users on Windows

If you have wished for more
control over who can access
your PC or your data, the first
solution would have been to
switch over to Windows 2000
or XP. But you can have
security in Windows 98 too
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programs running at startup, etc. If no user
logs in, it loads a default profile. To this
default profile, we have added a command
to log off at startup. Note that to create
additional users, you will first need to
delete this key from the registry.

This is sufficient to keep most people
away from your computer, but if you want
higher security, there are several third-party
tools that provide excellent features. Boot-
Locker (www.bootlocker.com) is one such util-
ity that restricts access at various levels. You
can use this as a login screen to Windows,

or even when you leave your PC unat-
tended for a while. It can even bring up a
login screen for DOS. Access Denied
(www.johnru.com) is a similar software that
requests a username and password while
booting. One great feature in this program
is its ability to save short messages while
the Desktop is locked. Thus, someone who
wants to use your PC for a genuine purpose
could leave a message for you to call him
or her when you get to your PC.

Screensavers
Screensaver passwords are not as flawed as
the Windows logon—they are meant to
protect an unattended Desktop from unau-
thorised access. However, these too are
insecure because of their nature. Screen-
savers are simply executable programs. In
fact, you can change the extension of any
EXE file to SCR and load it as a screensaver!
Thus, badly programmed or processor and
RAM-intensive screensavers can often
crash and give access to the Desktop. Ama-
teur programmers can leave code that will
allow simple key combinations such as
[Alt] + [Tab], [Ctrl] + [Esc] and [Ctrl] + [Alt]
+ [Delete]. These problems plagued even
the built-in screensavers on Windows 95
systems. The easiest way to bypass the

screensaver is to simply restart the system!
Being executables, they are also vulnerable
to viruses.

Workarounds for such vulnerabilities
are simple—use more secure screensavers,
after testing them thoroughly for all possi-
ble ways to kill it. Of course, you must also
make a shortcut for it in the Startup folder
otherwise someone can simply reboot your
machine and disable the password. Couple
this with a BIOS password and you have a
fairly secure system.

For those who desperately want to get
to your Windows, programs such as SSBy-
pass (www.amecisco.com/ssbypass.htm) are read-
ily available. It takes advantage of the
Autorun facility for CDs, and kills the
screensaver without having to provide the
password. Unless you happen to interrupt
the predator, you will never know that your
system has been compromised. Thus, for

higher security, you will again have to fall
back on third-party utilities such as Access
Denied or Security Storm Desktop Lock
2002 (www.securitystorm.net). 1Click & Lock
(www.softstack.com) is an interesting utility
that combines all the functionality required

from a secure screensaver and Desktop lock.
It can be launched at startup and runs in
the system tray so that you can enable it
when leaving your PC. It logs access and
allows others to leave messages for you.
Boot keys are disabled so that no one can
access the PC from DOS or Safe Mode either.
Also, the screensaver is optional—you may

want to secure your desktop from access,
but still view the programs running. 

Network shares
Early users may remember that Windows
was not originally intended to be used as a

Passwords on Windows systems are not
safe. Any password you save within an
application or anywhere within the system
can be easily retrieved, or at least used on
another PC. Some part of this will require
good knowledge of Win-
dows, for the rest, tools
and utilities are readily
available.

If you have the Auto-
Complete feature for
forms and passwords
turned on in Internet Explorer, all this data
is stored in the Windows Registry, under a
single key. Anyone can simply export this
key, transfer it to another machine and get
access to your secure accounts on the Web.
The data is not stored as plain text, but
advanced users would even be able to deci-
pher the passwords. You can turn off Auto-

Complete from Control Panel
> Internet Options > Content
> AutoComplete.

For applications such as e-mail and mes-
senger clients, if you have saved the

account passwords in the
application, they can be
retrieved using software
such as Revelation
(www.snadboy.com). All
one needs to do is point
the cursor over the pass-

word field that displays asterisks to get the
actual password. Such software can be very
useful when genuine users have forgotten
their passwords, but the software does not
distinguish between users—it will display
the password to any user. For highest secu-
rity, all passwords should be stored only in
your head and nowhere else.

Retrievable Passwords

1Click & Lock is a
good substitute for
screensaver
security

We have always been quite clear that Win95 and Win98 are not
the systems to use if you are in a hostile security environment.

We 
recommend Windows NT for those environments“ ”— Paul Leach, a Microsoft representative, commenting on the security flaws

of File and Print Sharing on Windows 9x

Access Denied 3.30, BootLocker
7.65, 1Click & Lock 2.4, Securi-
ty Storm Desktop Lock 2002 for
Windows 9x/Me, Cyber Patrol

5.0, Snitch 1.2
Find them on the Mindware CD
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networked workstation. The first traces of
network protocols, clients and services
were thrown into Windows for Work-
groups 3.11. Windows 95 had a much bet-
ter network implementation, but the
protocols used have gone through quite a
few changes. Primitive protocols have been
dropped and a handful of protocols such as
TCP/IP and IPX/SPX have come up as win-
ners by natural selection.

NetBIOS (Network Basic Input/Output

System) has been adopted as an industry
standard to access LAN resources. 
Windows 98 uses a very primitive protocol,
LAN Manager, which is quite weak on secu-
rity. Microsoft implements NetBIOS over
TCP/IP to share resources. The File and Print
Sharing service primarily runs on port 139
and can easily give access to anyone on the
network—LAN, or even the Internet. This is

usually the first port hackers try to access—
password-protecting your shares only make
it slightly more difficult to get to your files.
There are ample tools on the Net such as
GFI LANguard Network Security Scanner
(www.gfisoftware.com) that can discover pass-
words in a matter of seconds.

Your computer is vulnerable even if
you are not on a LAN and don’t have any
shared folders or printers, as long as the
service is installed. The best solution would
be to remove the File and Print Sharing
service, if you are not going to be using
these services. To do this, open Control Panel
> Network, click File and Print Sharing and
disable both the checkboxes. If Client for
Microsoft Networks is installed, you will
have to remove that too. You can then
select TCP/IP and click Properties and
check the NetBIOS tab to ensure that it has
been disabled. Check the same for other
protocols such as IPX/SPX and remove the
NetBEUI protocol, which is just an exten-
sion of NetBIOS. However, you cannot do
this if you are on a LAN and need to share
resources. There is no real solution to pre-
vent discovery of passwords on a LAN.
User-level access is slightly stronger than
share-level access, especially when logging
in to a Windows NT or 2000 domain.
Using long and complicated passwords also
makes them difficult to figure out. Howev-
er, if you want reliable security for your
files, you should use some file encryption
tools such as PGP (www.pgpi.org). (For more
on encryption, data security and PGP, refer to
Datawatch in the November 2002 Digit issue).

Content Advisor
The parental control features added to
Internet Explorer are a boon in many

households and organisations. Access to
Web sites using Internet Explorer can be
restricted to a great extent, based on vari-
ous settings. In Internet Explorer 4 howev-
er, there were several bugs in this system
that caused problems with the Content
Advisor settings. The feature would enable
or disable itself, forget the password and
manifest other problems.

With each new problem that surfaced,
Microsoft had to put up documentation on
how to solve it. Most of the solutions gave
detailed step-by-step instructions on how
to disable the Content Advisor and reset its
password, without requiring the current
password. One such document at http://sup-
port .microsoft .com/default .aspx?scid=kb;
en-us;242037 lists virtually every version of
Internet Explorer to be affected by the bug.
These solutions also found their way to var-
ious support sites and message boards.
Thus, it became quite simple to bypass this
security.

In this case, the security feature is not

inherently flawed, but ways to circumvent
it are well documented. Thus, there is no
workaround within Internet Explorer that
will strengthen the security. If you want to
restrict access to certain Web sites, you will
have to use a third-party parental control
software. Cyber Patrol (www.surfcontrol.com)
filters out indecent or otherwise unwanted
material on the Internet by controlling the
user’s Internet access and can also restrict
the amount of time spent online. It
updates the list of inappropriate sites daily
and provides some powerful filtering
options, giving you adequate control over
each Internet session. Snitch (www.hyperdy-
nesoftware.com), another Web-control soft-
ware, works on a very interesting concept.
It filters out content in real-time, by using
several algorithms to detect adult content.
It looks for words of a certain kind and
analyses images to determine what per cent
of them is showing skin, etc. It can even

JANUARY

For several common file formats, there are
tools available to extract forgotten pass-
words. Elcomsoft (www.elcomsoft.com) prob-
ably has the longest portfolio of such soft-
ware, and their tools have proven to work
in most cases. They have tools to recover
passwords from Word, Excel, PowerPoint,
Access, Outlook, Zip, RAR and many more
file formats. All one needs to do is run the
software, set a few password criteria,
choose the file and let the software run.
Using long and complicated passwords
would make it quite difficult for the soft-
ware to crack the password.

Archives such as Zip and RAR files have
a very weird behaviour. If you set a pass-

word when creating the
archive, the password is
assigned to each file in the
archive and not the archive itself. Thus, the
file can be opened and the entire list of files
can be seen. The files cannot be extracted
without the password, but in many cases,
viewing the file listing itself could be detri-
mental. One way to make them more
secure is to compress files into an archive
with a password, and then compress that
archive into another one, again with a
password. Thus, the only file that can be
seen will be the original archive. Its con-
tents will not be visible until a password is
provided to extract it.

File Passwords

Snitch monitors Web activity for adult content
in real time

Configure network services and protocols
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bring up a list of suspicious files from your hard disk. Not surpris-
ingly, there are also software such as PeaceFire (www.peacefire.org) avail-
able for free, that block out many popular parental control software.

Outlook Express identities
Outlook Express has grown to be one of the most popular e-mail
clients because of its integration with Internet Explorer, ease of use
and features such as support for multiple identities. It is quite com-
plete as a basic e-mail client, but security of e-mail is quite flawed.
On the face of it, you can assign passwords to each identity so that
each user can maintain his or her accounts, settings and e-mail. This
feature has multiple flaws and working around it to access another
person’s e-mail is quite simple.

First of all, after a user logs in to an identity, it is necessary to log
off, otherwise the client promptly opens up with the same identity.
Simply closing the application is of no use. Secondly, if a person
wants to access your e-mail, he or she can simply create a new iden-

tity and point his store
folder to the existing
mailbox folder from
Tools > Options > Mainte-
nance. Another way to
get to the mail is to copy
off the mailbox files to
another PC. Account
settings are easily acces-
sible for pranksters with
a little knowledge of
Windows, from the
Windows Registry.

The identity feature
works just like the Win-
dows logon—it acts as a
profile login to load

your settings and that’s it. For e-mail security, you should switch to
Outlook, which is bundled with MS Office. Here, the mailbox file
itself is password-protected, so there is no easy way of accessing your
messages. One would have to actually crack the code. Outlook will
ask for a password every time it is opened, and the same password
will be applicable even if the file is copied to another machine and
loaded in a different Outlook. The password will be required even
when importing messages from the mailbox. You can set the pass-
word from Tools > Options > Mail Setup > Data Flies > Settings.

It is possible to overcome most security flaws in Windows sys-
tems. Though some of them are not the most elegant solutions, they
will definitely keep most prying eyes away. Plus, they do save you
big bucks in  upgrading the operating system and the hardware to
match it. Now you can sleep peacefully.

VEER KOTHARI

Key loggers are programs that run transparently
on your computer and keep track of every single
keystroke from your keyboard. These tools are
freely available and can reveal everything you type, including pass-
words, to anyone who knows that such a program is running on
your machine. Usually, these software also regularly send out the
logs to the e-mail address of the person who installed it. Most anti-
virus software are geared to trap and prevent key loggers.

Key Loggers

Set a password for the mailbox file in Outlook

1/4 page H AD
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In this age of technology, information
is the key and time is always a con-
straint. Searching smart on the Inter-

net isn’t just a concept—it’s an absolute
necessity. The World Wide Web is a vast
ocean of knowledge and a Net search is
much like looking for the proverbial nee-
dle in a haystack. While most of us man-
age to just scratch the surface of the Inter-
net, others maximise their precious online
time with the help of power tools. These
tools are freely available on the Net and
operate from within the browser. They
scrounge the Net using intelligent search-
es for what is relevant to your search and
discard what is not, helping you work
smarter and more efficiently. The tools
listed here are must-haves, especially if
you begin your online voyage by jumping
into a search engine. Most of them are lit-
tle browser add-ons that exist as toolbars
within the browser. Some others are site-
based tools that help you look for more
specialised information. The browser add-

ons have been categorised into three
types—those used for searching, those
used for knowledge and reference search-
es, and those used for shopping. Of
course, quite a few of these toolbars come
close to doing all three, thereby saving
you desktop real estate.

Seek and ye shall find
Fast and accurate—that’s how we like our
online searches. While you can log on to a
search engine and have it locate what you
want, few know that most of the popular
search engines can be directly started from
your browser. Seamlessly integrating into
your existing browser, the search engines
sit as tiny toolbars within your browser.
They offer you the convenience of search-
ing straight from your browser without first

having to locate the search engine on the
Web—just enter the search criteria within
the toolbar search box and start the search.
There are several such tools available, with
each famous search engine coming out
with its own version.

The Google Toolbar
Web site: http://toolbar.google.com
Utter ‘search’ and most people will asso-
ciate it with Google. The Google toolbar is
free, accurate and has some slick features.
Type in a query and access the results from
Google’s Web search or Image search,
check out news groups from Google’s
Groups button or access the Directory
search. This toolbar lets you open results
in a separate page, so you can start search-
ing, no matter what you are viewing cur-
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Fast, accurate and straight from within your browser—addons that will speed up 
your journey as you navigate through the vast and chaotic Net

Softbots

AI RoboForm v5.0.2
Find it on the Mindware CD 

1 2 3 4

Softbots
at your serviceat your service

ILLUSTRATIONS: Mahesh Benkar

Google the world:     Configure the toolbar by clicking on Google.     Use Search Site to search
within the current Web page.     Access news from the News button. Page Rank (if enabled)
shows you the popularity of the page.    The Page Info drop down list gives you a number of
options such as to view cached snapshot of the page, view other similar pages, check out the
backward links, and even have the page translated into English



rently. Click on Page Info and access links
to related pages, along with pages linking
to the current site and translations into
English from a variety of European lan-
guages. The Highlight highlights the
search criteria across the current page. 

It also has an enhanced version that has
a feature called PageRank. This feature rates
the popularity of your pages. Google warns
you that if you use PageRank, it will collect
information on your surfing habits. If you
don’t like this, take the non-enhanced ver-
sion that has all the bells and whistles,
except the aforementioned feature. 

Ask Jeeves Toolbar
Web site: www.ask.com
Get the power of Jeeves, the Butler, on
your browser toolbar. The Ask Jeeves Web
site has been popular for being a child-
friendly site and the toolbar continues
that trend. It lets you pose search terms in
simple natural language queries and

comes with a whole host of options. You
can also access Ask Jeeves for Kids for safe
surfing for children, and check dictionary
definitions and weather forecasts. The
toolbar highlights every instance of the
search term entered in the current page.
The search results also include references
to encyclopaedic sources. 

The Yahoo! Companion
Web site: http://companion.yahoo.com
The Yahoo! Companion lets you access
Yahoo!’s services quickly. Use the toolbar

to sign into Yahoo! and check out person-
alised news feeds and pages. You can also
add oft-referred services such as news,
finance, address books, jobs, directory list-
ings and games. The buttons reveal the
options within each section. E-mail alerts
are linked to the toolbar and remind you
to check your mail and provide a link to
your account. 

The Ultrabar IE Toolbar
Web site: http://ultrabar.com
The Ultrabar IE toolbar comes with built-
in support for many search engines such
as Google, Alta Vista, Yahoo!, etc. The
toolbar also supports searches within
Google’s groups, Yahoo’s News and
Stocks, News.com, the CGI Resource
Index and the CPAN modules. It even
lets you search across Tucows. The search
is not restricted to these sites alone and
can be customised to work with the
search engines of your choice. You can
appoint the order of the search engines
and highlight all occurrences of the
search terms within the page and go
directly to the search terms or phrases.
Unfortunately, metabrowsing across all
of the listed engines, at the same time, is
not possible.

Teoma Search Bar
Web site: http://sp.ask.com/docs/teoma/toolbar
Teoma’s Search Bar runs the new Teoma
search engine that refines your searches to
provide more accurate hits. It has two very
useful features—Refine which offers sug-
gestions to narrow down the search, and
Resources which offers link collections to
explore. Teoma also offers you a diction-
ary and definition feature that links up
with Merriam-Webster OnLine. The high-
lighting button can be used to mark all
the occurrences of the search term within
the current page. 

If reference be thy game
If you are a student who uses the Net for
intensively researching specific topics,
there are some excellent tools that let you
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We are drowning in information but starved of
knowledge —John Naisbitt,author, talking about the future in his

book Megatrends, 1982”“
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Access the Yahoo! homepage by clicking on
Y!. Edit and customise the toolbar by clicking
here. The buttons reveal further links that let
you jump straightaway onto your destination.    

For accessing the extra search options, click
here and choose between dictionary and
Thesaurus services, stock tickers, the address
book, yellow pages, shopping facilities, news
stories and picture galleries.    Sign into
Yahoo! from here

Ask Jeeves:      Configure the Butler on your
toolbar by clicking on Ask Jeeves.     The surf
option for children is accessed here.    You can
access the news and     the dictionary and
definitions from here.    You can even choose
to mail the current page to a friend

21 3 54

IDs, Online
Most Web-based services such as message
boards and speciality sites require you to
log on to access their services, slowly
defining us by our online identities. This
means we need to juggle our multiple
online identities. So how do you remem-
ber the identities and passwords for each?
Trust your online identities to a software
designed for holding them. 

AI RoboForm 5.0
Web site: www.roboform.com

This identity and password management
addon holds all sorts of personal informa-
tion—from names and addresses, to pass-
words and credit card information. Look-
ing below the hood and tuning this soft-
ware can be somewhat intimidating, but it
becomes easy once you use it. It uses some
pretty slick artificial intelligence routines to
fill up any form you come across online.
RoboForm Pro uses 3DES for security; how-
ever, the free 30-day trial version uses the

less secure 1DES algorithm.
The encrypted data is
stored locally on the hard
disk and not on any
remote third party server. 

AI RoboForm:      Identities gives you access
to the identities that you have created.        

Forms can be filled by a click of a
button.     Personalise the toolbar under
More.     This hides the toolbar, although it
is still active.     Manage your passcards
from here. 

Click on Ultrabar and access the configur-
ation options.    Click here to change search
engines. This displays the list of search engines.
Set a customised search engine here. You can
even highlight the search term across the results 

2
1

1 2 53 4



JANUARY 2003

do it efficiently. News services, ency-
clopaedias and other authoritative refer-
ence works are available aplenty on the
Net and you can also have them on your
browser for immediate access. 

Merriam-Webster Toolbar
Web site: www.m-w.com
Whether you are a writer or a reader, this
toolbar is made for you. Just type in your
subject and hit search, or highlight a term
on a Web page and right-click to locate its
meaning across the venerable Merriam-
Webster OnLine. A pop-up window answers
your question and gives you a link to an
audio pronunciation of the word. This win-
dow also gives you relevant links and some
historical information. You can use the dic-
tionary as well as the associated Webster

Thesaurus. While you could access quite a
lot from the Webster portal online, you do
not have access to the unabridged Webster
online dictionary—this is a premium serv-
ice. Incidentally, many search toolbars link
up their dictionary and definition sections
to Merriam-Webster. 

MSNBC’s News Alert
Web site: www.msnbc.com/tools/newstools/d/
news_alert.asp
If you want to be up to date with the lat-
est news, get hold of MSNBC’s free news
alert. This program adds an icon to your
system tray and gives news alerts by flash-
ing the icon. Clicking the icon opens up a
popup window that gives you the head-
line and link to the complete story. Play
with the settings to get it working to your
liking and to set up personalised alerts for
stories of your interest.

BBC News Ticker
Web site:  http://news.bbc.co.uk/hi/english/stat-
ic/services/ticker/default.stm
This one runs as a ticker on the top of your
screen. You can configure the ticker to
deliver the kind of news you would like to
see. It continuously provides updated
news headlines with a link to the com-
plete stories at the BBC Web site.

Bargains on the Web
Using some pretty sophisticated tech-
niques, these little browser add-ons will
rummage the Internet and get you just
what you ordered for. But beware. When
it comes to bargains that look too good to
be true, they probably are. Use these tools
and some common sense to bag some
great bargains.  

The Side Step Travel Search
Engine
Web site: www.sidestep.com
Use this travel search engine to locate the
lowest airline fares, hotel bookings and
the lowest car rental costs all around the
world. This metasearch travel engine
combs all the low-cost travel sites to locate
the best deals for you. It saves much of
your planning time by searching and then
comparing some 90 odd supplier sites
such as Travelocity.com (www.travelocity.
com), Expedia (www.expedia.com), Cheap
Tickets (www.cheaptickets.com) and Lowest-
fare.com (www.lowestfare. com). It occupies a
sidebar that sits on the left side of your
page, so you can use it while you work.
However, it is not the fastest search engine
and restricts its search to starred hotels
within India. This renders it useless to
low-budget travellers. 

The interface lets you choose between
airlines, hotels and cars. You can flip
through tabs and search for low airfares,
cheaper hotel rates and car rentals. 
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These are sites that have search services to
locate information. Some of these sites offer
specialised services, such as powerful
metasearch tools. A ‘metasearch’ is similar to
an ordinary search, with one major differ-
ence—metasearches query and scan across
many search engines at the same time to
locate information. These search engines are
programmed to avoid duplicate listings. In
some of them, you can use simple, natural
language in the same way you communicate
while speaking. 

Generalised metasearch
If you are looking for vast metasearch
engines that harness the
power of several search
technologies, check out
MetaCrawler (www.metacrawler.com) and
Mamma (www.mamma.com). Both organise
the results into clusters by word, category or
level of popularity, without duplicating list-

ings. Dogpile
(www.dogpile.com)
presents the results
sequentially. Also
notable is Invisible Web
(www.invisibleweb.com), a search engine that
can ferret out information located within
specific databases—other search engines
find information on Web pages but fall short
while searching for information embedded
within databases. 

Science-related research
If you are looking for reliable papers in any
branch of study, you’ll
find them all using the
Scirus search engine
(www.scirus.com). Scirus scans across universi-
ty Web sites and online paper repositories
for your academic needs. Also check out
Find Articles (www.findarticles.com), to locate
magazine and journal articles.

Online, but not within your Browser

BBC: Tune in for news, anytime
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Teoma:     Click here to fine tune the limited
configuration options; choose which buttons
you want displayed and set the other options.
While you can’t configure the Search options,
it does yield some pretty useful resource sites.    

Highlighting is enabled from here.     To 
e-mail a copy of the page, click here

Merriam-Webster:     Click here to configure
the toolbar.     Enter the search term within
the text window and to obtain a dictionary
definition,     click on the Dictionary button. 

Use the Thesaurus button for more
information on the word. Both open up in a
separate popup window, so your current page
view remains intact.     The Word of the Day
button opens a popup that gives you a word
accompanied by some history
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The eBay Toolbar
Web site: http://pages.ebay.com/ebay_toolbar
This nifty toolbar keeps you updated

about the auctions at eBay.com
(www.ebay.com). The toolbar has a wide
range of subcategories in each drop
down box, allowing you to make your
search very specific. To bid, log into 
your eBay account and jump into the
market. The toolbar lets you keep tabs 
on your selected auctions and keeps 
you updated by popup boxes with links
to the auction when your selected 
auction is about to close. Similarly, 
your bids can also be monitored with 
the toolbar.

It’s a big, bad Net out there but these
high-quality, speed-enhancing tools get
you around in a jiffy. You will find more
such tools on the Net, but handle 
them with caution—they may be spy-
ware. Always read the fine print before
you sign up for any service to ensure 
that you don’t trade your privacy for
speed and ease. Steer away from tools
that promote only specific third-party
services, which will give you skewed
results. So experiment and find the 
ones that suit you the best; use these
quality browser addons to mine the 
Net efficiently and draw away from the
tedium of researching for information.

SRINIVASAN RAMAKRISHNAN
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SideStep: Search great bargains online!
Click here to get great airfare bargains.
Get affordable hotels here.     Click here for

low-cost car rentals

The eBay button leads you to a whole lot of
options—choose between signing in, checking
out the community, browsing eBay Motors 
and Stores, Half.com (an eBay associate),
Sotheby’s and others.     Click on the Search
button and you will find a huge, well-sorted
list. Click on any one category to open up a
wide range of subcategories to further narrow
down your search. Everything Else is for things
you can’t really classify.    Use the My eBay
button to access personalised features.     

The Bid Alert lets you set alerts for your
bids,     while the Watch alert keeps track of
an auction of your choice.

1/2 page H Ad
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The wide reach of computers to peo-
ple of all ages and backgrounds has
largely been affected by the user-

friendliness of software. Yet, this factor is
very subjective—it increases with expo-
sure to the software and with tips from
other users. In today’s connected world, 
e-mail is the the de-facto way of transfer-
ring files. Network administrators and
long-time PC users still try and evangelise
the use of FTP (File Transfer Protocol), but
the apparent ease of e-mail is too good to
let go. Most people have stopped urging
others to use FTP, but they are still trying
to share practices that will reduce the load
on e-mail. One such advice is to compress
the files you want to send by e-mail.

New users might be perplexed by the
Winzip or PKZip interfaces—one can’t
extract a file by just right-clicking on it in
an e-mail. WinRAR archives score over the
Zip format by allowing you to add instruc-
tional guides, and the archives are also
smaller. Also, this is a much more efficient
way to distribute small programs instead
of using commercial installers that make
the installation unnecessarily large.

Compression
As with Winzip, you can right-click

files in Windows Explorer to add them to
RAR archives, but this will not give you
access to options that optimise compres-
sion. If you are compressing very large or
a sizeable number of files, you could gain

a lot by changing the compression
options. Select the files or folders you
want to compress and click Add. 

Set the compression method to
Best and enable the Solid archive

option. If you are compressing multime-
dia files such as uncompressed wave files
(files compressed with multimedia
codecs will not afford noticeable com-
pression ratios) or images, enable Multi-
media Compression. On the Advanced
tab, choose the dictionary size. General-
ly, the higher the dictionary size, the
greater the compression.

Self-extracting options
Creating a self-extracting archive

when compressing with WinRAR is as sim-
ple as enabling the ‘Create SFX archive’
option on the General tab. However, this
will create simple SFXs, that will be no bet-
ter than those created over the Zip format.
For added functionality, add script to the
archive by writing commands in the Com-
ments box. Type each command on a sep-
arate line. You can use any combinations
of the commands, depending on your
purpose for the archive.

Title=<title> sets the title of the extrac-
tion window. For example, Title=Vacation
Photos.

Text=<message> displays a message in
the extraction window when the EXE is
double-clicked. You can repeat the com-
mand several times to display multiple
lines of text. Use this to give a detailed
description of the archive and instruc-
tions to the user.

Path=<path> sets the default path
where the files will be extracted. You can
enter the entire path including the drive
letter, or specify a relative path. Relative
paths are always extracted to the Program
Files folder. For example, Path=C:\My
Documents\Vacation Photos.

Silent extracts all files to the default
path without providing any options and
notifications to the user. If the Path com-
mand is not used, it will extract all files to

the current folder. Using this is not
advised without the Setup command, as it
makes usage less intuitive.

If Overwrite=[0, 1, 2] is set to 0, the user
will be asked before overwriting the exist-
ing files. If it is set to 1 or no number is
specified, all files will be overwritten with-
out confirmation; if it is set to 2, all the
existing files will not be overwritten.

Delete=<filename> deletes the speci-
fied file from the destination before
extracting any files. You can use as many
Delete commands as you want.

Setup=<program> is a powerful option
that can credit usability to your archives.
The specified program will launch auto-
matically after extraction is complete.
Again, you can specify an absolute path
or simply give the program name. 

With TempMode=[Question][@Title],
the SFX will create a temporary folder,
extract all files to it, start the program
specified in the Setup command and
remove the temporary folder with all its
contents after completing the Setup pro-
gram. This option is generally used to dis-
tribute programs. The optional Question
and Title parameters can be used for the
user to confirm installation.

VEER KOTHARI

WinRAR 3.00
Find it on the Mindware CD 

Self-extracting archives

Compression options in WinRAR

A sample script for sending your vacation
snaps to your friends
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Internet telephony
I have a 1 GHz Celeron processor, a

motherboard with integrated sound and
graphics and Windows 98, with a modem.
I use this system primarily for voice chat-
ting with my husband. The problem is
that he can hear what I'm saying but I
can't hear him. Is this problem related to
the soundcard or the telephone line?
Shamina
Via e-mail

This problem could occur due to vari-
ous reasons. Check if the headset is
plugged into the correct port on your
soundcard—it should be in the head-
phone-out port. Use the audio-tuning wiz-
ards that come bundled with the voice

chatting software to adjust the volume lev-
els. For instance, in MSN and Yahoo! Mes-
senger, these options are under the Tools
and Help menus, respectively. An error in
these wizards will let you know the cause
of your problem. Finally, go to Start > Set-
tings > Control Panel > Multimedia. Make sure
that the name of the soundcard under the
Playback and Recording sections is the
right one. Also, check the box titled ‘Use
only preferred devices’ and turn up the
Master and Wave volumes in Volume Con-
trol by going to Start > Programs > Accessories
> Entertainment > Volume Control. If you have
amplified speakers, increase their volume
as well.

Viral attack
I have Windows 98 SE installed on my

PC. A few days back, I noticed two files,
Folder.htt and Desktop.ini, recreated in
every folder. I formatted the hard drive
and recreated the partitions, but the prob-
lem persists. It causes an adverse effect on
the system speed too. Apparently, the files
are also infected with the VBS/Redlof@M
virus. Which virus scanner can I use to
remove it?
Vijay Tripathi
Via e-mail

This is a polymorphic, encrypted,
VBScript virus that infects HTML-based
and VBScript files on all drives. The virus
also copies itself to either the Kernel.dll
or Kernel32.dll files and changes the
default association for DLL files. It will
then embed itself into every HTML e-mail

you send. You can use any good virus
scanner such as Norton AntiVirus to look
for infected files. Before this, you should
modify the registry. Open the Registry
Editor by running regedit from Start > Run
and go to HKEY_Local_Machine\Soft-
ware\Microsoft\Windows\CurrentVer-
sion\Run. Delete the value Kernel32
under this. Next, browse to HKEY_Cur-
rent_User\Identities\[User ID]\Software\
Microsoft\Outlook Express\[Version]
\Mail and delete the values Compose Use
Stationery, Stationery Name and Wide
Stationery Name. Under HKEY_Cur-
rent_User\Software\Microsoft\Office\
9.0\Outlook\Options\Mail, delete the
EditorPreference value and finally, under
HKEY_Classes_Root\dllFile, delete the
keys Shell, ShellEx, ScriptEngine and
ScriptHostEncode. Next, open Start > Set-
tings > Folder Options and switch the view to
Classic style instead of Web style. Restart
the machine for the changes to take effect
and run the virus scanner.

USB camera
I have a Pentium III system running

Windows 98 SE. I have been using a
Canon IXUS 300 digital camera for the
past one year without any problems.
However, now whenever I connect my
camera to the computer using a USB
cable, an error, ‘STIMON caused an
invalid page fault’ is displayed. I have
uninstalled and reinstalled all the software
bundled with the camera. When I access
Scanners from the Control Panel and
select the camera in the window, an error

Video errors, installation and upgrade problems, using Hindi fonts 
and much more—find your answers here

Select your soundcard as the preferred device
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with Sticpl.cpl is displayed. Recently I had
downloaded and installed the Windows
98 Q323255 Update. Could this have
caused the problem?
Nitesh Kumar Jain
Via e-mail

It seems that the Stimon.exe file on
your PC is damaged. Press [Ctrl] + [Alt] +
[Del] and check if Stimon is running. If it
is, end the task. Delete the file from \Win-
dows\System. Run the Registry Editor and
navigate to HKEY_Local_Machine\Soft-
ware\Microsoft\Windows\CurrentVer-
sion. Look for a value named
StillImageMonitor under either the Run or
RunServices keys. Delete the value and
restart the PC. Now reinstall the drivers for
the USB camera.

If you still get an error, replace the Stic-
pl.cpl file, too. To do this, run sfc from Start
> Run and insert the Windows 98 installa-
tion disk. Select the option ‘Extract one file
from installation disk’ and click Browse.
Locate Sticpl.cpl in the \Windows\System
folder and click Start. Restart the machine
after restoring the file.

Bootable floppy
I made a bootable disk several times,

using different floppies, but my PC does-
n’t boot from it. I can see the file list on
the disk from DOS and Windows. What
could be the problem?
Ashish
Via e-mail

Your PC is probably not set to boot
from the floppy drive. This is a setting in
the BIOS, where you can choose what
device chain it should look through for
booting. While the PC is booting, press
the [Delete] key ([F2] on some BIOSes) to
enter the BIOS setup. The way to access
this option varies across different BIOSes,
but just look for an option such as Boot

Order or First Boot Device. Ensure that A
or Floppy is set as the first boot device,
save the changes and exit the BIOS.
Henceforth, it should boot from the 
floppy. If it still doesn’t, the problem could
be with the floppy drive itself, in which
case you will have to get it replaced.

Running old programs
I need to run a DOS accounting soft-

ware under Windows Me, but I have to
change the Files variable to 100, which by
default is 10. In Windows 98, I used to set
it from the config.sys file, but in Windows
Me I cannot edit it. How can this be done?
Rahil Mehta
Via e-mail

You can set the environment variable
from the autoexec.bat file instead of the
config.sys file. Use the DOS command SET
to assign a value to a variable. Thus, you
can enter the following line in the
autoexec.bat file, or type it directly at the
Command Prompt:

SET FILES=100
To remove an environment variable,

type the SET command without any value
(SET FILES=) and simply type SET to view a
list of current variables.

Receipt confirmation
I have a Pentium II 433 MHz system

with 128 MB RAM running Windows 98
SE. I have Outlook Express 6 installed as
my e-mail client. How can I confirm that
the person to whom the mail has been

sent has seen the message?
Sukhbir
Via e-mail

You can request a notification when
the recipient reads the message using the
Request Read Receipt option in Outlook
Express. When creating a message, click
Tools > Request Read Receipt to enable this for
the message. A better option would be to
enable this permanently, so that the
request goes with every message you send.
To do this, open Tools > Options > Receipts
and enable ‘Request a read receipt for all
sent messages’. Here, you will also notice
how Outlook Express should respond to
receipt requests it gets from other senders.
When the recipient first opens your mes-
sage or views it in the Preview Pane, 

Installing Solaris
I have a Compaq Presario PC with

Windows XP pre-installed on it. The
partitions of my 40 GB hard disk
are 37 GB (NTFS) and 2.7
GB (FAT32). I want to
install Solaris 8 on my
machine. When I
boot the Solaris ker-
nel, it gets terminat-
ed and the system
gets restarted. Is
there a problem with
my BIOS, which is not
allowing the kernel
to run on it?
Gaurav
Via e-mail

The installer is probably having
some problems with the 40 GB hard

disk. The OS does not support disks
beyond 32 GB, as documented on the
Sun Web site. Your BIOS probably does

support the drive, as Windows
XP is installed and running on

it. One workaround to this
is to get another smaller
hard disk and install
Solaris on it, install the
patches for Solaris that
enable support for
large disks, then
reconnect the 40 GB

drive. Another possible
workaround is to install

Solaris 8 on a smaller hard
disk and then connect the 40

GB drive, but disable it in the BIOS. You
could also try setting the drive to 32 GB
in the BIOS and installing the operat-
ing system. 

Restoring a file using System File Checker

Enable Read Receipt requests in Outlook
Express

ILLUSTRATIONS: Mahesh Benkar
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Outlook Express will either send back a
message saying that the e-mail has been
read, or ask the user for confirmation to do
so, depending on the settings. It may also
be set to never send such notifications.
Thus, it is possible for the recipient to not
send you the receipt notification.

Autorun
How can I create an Autorun CD?

Prabhat
Via e-mail

To create an Autorun CD, simply place
a text file named autorun.inf in the root.
The contents of this text file can have a
lot of property and behaviour-defining
parameters, but the ones you will use
most are the following:

open=<program path and name>
icon=<icon path and name>
Each parameter must appear on a sep-

arate line. Also, ideally the path should be
relative, since the CD-ROM drive letter
would differ from PC to PC. Thus, if you
want to launch a program named
runcd.exe from the Autorun folder on a
CD, the text would be open=autorun\
runcd.exe.

Cross cabling
I have an IBM NetVista with a D-Link

Lan card installed. Recently I purchased a

Pentium 4 system with a Compex
RE100ATX/WOL Lan card. I connected
them with a cross-crimped cable and
after logging on, the IBM node was avail-
able in Network Neighborhood of the
Pentium 4 system. When I tried accessing
it, it displayed a message that the node
was not accessible and the IBM system
does not show Pentium 4 at all. On con-
necting the two via a hub on an existing
network, both machines can access other
systems on the network, but not each
other. Please help.
Pathanjali Nadiminty
Via e-mail

You have not mentioned what operat-
ing systems each machine is running. The
problem can occur due to incompatibili-
ty of network protocols across the
machines, or simply some network set-
tings. Ensure that the same set of proto-
cols and services are installed on both
systems and they should be able to com-
municate with each other. Also, if you are
using only TCP/IP on both machines,
make sure they both have valid IP
addresses in the same subnet. You can
configure all network settings by right-
clicking Network Neighborhood and
clicking Properties. Most importantly,
ensure that File and Print Sharing is
enabled on both computers.

Hindi on the Web
I would like to put a Word document

containing Hindi script on the Internet. The
document has been created on Windows
98 using Word 97, using Akruti fonts. The
fonts have been embedded into the docu-
ment and I tested it on several computers
where Hindi fonts are not installed. The
document opened properly, so I sent it to
London, where the Web site is being main-
tained. The feedback from there is that
they cannot see Hindi script as the font is
not available. What could be the reason for
this? Are there any limitations in embed-
ding true type fonts in Word?
Prasad DVR
Via e-mail

It is possible that the document is
being viewed within Internet Explorer at
the other end. Thus, the embedded fonts
may not show. Also, it is possible that the
document is being viewed on a different
version of Microsoft Word, which may be
handling the file differently. Create dif-
ferent versions of the document on dif-
ferent versions of Word and see if they
open properly. Word 2000 and higher
have stricter licensing policies when
embedding fonts than Word 97, so this
could cause the problem.

Startup screen
I’m facing a curious problem. Normally

when Windows boots, it shows the graphi-
cal bootup screen of the Windows version.
I have Windows 98 SE on my machine. For
the last three months, my bootup screen
has changed to that of Windows Memphis.
I don’t know how it got changed. I looked
for the logos.sys and logow.sys files, but
these are intact. The screen had changed
after I installed some software. I have 

XP Service Pack
I have a Pentium III 1.14 GHz proces-

sor and 128 MB SDRAM. I tried installing
Windows XP Service Pack 1 from the
November Mindware CD. After it copied
all the files, it gave a message that the CD
key is not valid. If the key was not
valid then Windows XP
would not have installed
in the first place. Why
am I getting this error?
Meetesh Jain
Via e-mail

Since the release of
Windows XP,
Microsoft noticed that
the vast majority of
illegitimate copies are
using a small handful of
leaked CD keys. In an effort
to thwart these illegitimate users, Win-
dows XP Service Pack 1 will not install
on systems using these keys. Microsoft
claims that legitimate licensed users of

XP Professional should be unaffected.
During the installation of Windows

XP Professional, you are prompted to
enter a 25 digit Windows XP Product
Key, which XP uses to generate the sys-
tem’s product ID. Because of security
concerns about piracy, Microsoft does
not provide a tool that allows you to
view the Product Key that was used to

install the operating sys-
tem. The Product ID

can be found by right-
clicking My Com-
puter and choosing
Properties. To deter-

mine eligibility for
the update, Service

Pack 1 compares the
Product ID on the sys-

tem against the list. Ser-
vice Pack 1 for Windows

XP will fail to install if either the
XXXXX-640-0000356-23XXX or the
XXXXX-640-2001765-23XXX range of
Product IDs is found on your system.

Add, remove and configure protocols and
services on Windows 9x
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uninstalled it, but the screen has not
changed back. Is there a way to solve this
problem other than reinstalling Windows?
Abhradeep Biswas
Via e-mail

The startup screen is not loaded from
the logo.sys or logow.sys files. If the
logo.sys file exists, it is used for the start-
up screen, otherwise the default system
screen is used. Thus, to revert back to the
original display, simply locate and delete
the logo.sys file. This could be in the root
of drive C or in the Windows folder.

Noisy drives
When I start my PC, the floppy drive

makes some noise and after entering the
BIOS password, it again makes some
noise. After the operating system is
loaded, when I start any application, my
hard disk also starts making some noise.
Please help me reduce these noises. I scan
and defragment the hard disk regularly.
Kamalshil Lokhande
Via e-mail

On starting the PC, after POST and after
entering the BIOS password, the BIOS may
be looking up the floppy drive to check if
a bootable disk is inserted, causing the
noise. You can disable this option from the
BIOS and have it boot directly from the
hard disk instead (see question, Bootable
floppy). Also disable ‘Boot Up Floppy Seek’
from the BIOS. When you start applica-
tions, Windows would be transferring a lot
of data to the hard disk to use the sswap
file. There is not much you can do about
this. The hard disk will make noise every
time there is heavy disk activity. Setting a
permanent swap file after defragmenting
the hard disk once may help, but will not
reduce the noise much. If you have Win-
dows 9x, to set a permanent swap file open
Control Panel > System > Performance > Virtual
Memory. Enable ‘Let me specify my own
virtual memory settings’ and set the same
value for the minimum and maximum
swap file size. Ideally, this value should be
two-and-a-half times the amount of RAM
you have on the PC. Thus, if you have 64
MB of RAM, set this value to 160.

TV tuner problems
I have a Mercury TV tuner card. TV

programs are captured with quite poor
quality while recording in VCD mode.
Changing the resolution has not helped.
Can I directly save the video capture in
DivX/MPEG4 format? I can’t afford to
record raw video as I have only 7 GB of
free space.
Anoop
Via e-mail

The quality at which you can capture
video is largely dependent on the TV
tuner card—cheap, low-end cards can
never match the quality of a dedicated
video capture card. The quality that you
get is probably a limitation of your hard-
ware. Try checking the driver configu-
ration of your card to see if it offers a
high-quality mode. You can do this by
referring to the manual or the manu-
facturer’s Web site (www.kobian.com). Cap-
turing to DivX formats is very
processor-intensive and requires a high-
end CPU. You can download the latest
DivX bundle from http://www.divx.com/
divx/. After doing so, you can choose to
encode into DivX from your TV tuner
card’s video capture settings—if your
processor has the necessary power, you
will be able to get good video encoding.

If your processor is not up to it, try
using other codecs such as Intel Indeo
5.x or Radius Cinepak. These are not
very heavy on the system and do not
cut away too much visible clarity. Do
note that encoding has very little to do
with the video quality of live feeds. The
codec only compresses the incoming
video feed and further quality loss due
to encoding is usually marginal
(depending on the codec settings). The
only other way encoding affects quality
is if frame-drops occur due to slow
processors. Thus, if you notice that the
video feed itself is good quality and only
the recording is poor, check the codec
settings—changes such as using a dif-
ferent codec (keep away from the CPU-
intensive ones), reducing the amount of
compression and using more keyframes
can tremendously improve quality. For
better video quality, the best option
would be to record video at higher res-
olutions, but you may have to upgrade
the TV tuner card for that.

No picture
I have a Compaq Presario 7500 run-

ning Windows XP Professional. It has 192
MB of RAM and a Compaq DVD/CD-
ROM SD-612B. I use Windows Media
Player version 9, but am not able to see
movies on it—I can hear the sound, but
there is no picture. Please help.
Ankush
Via e-mail

The problem is with either the player
itself, or the video codecs. This problem
has been documented in earlier versions
of Windows Media Player. Version 6.4
has been the most stable player till date,
but most bugs seem to have been fixed in
version 9. Also, until now only Release
Candidates for the new version have
been made available, which means it
tends to have bugs. The final release will
have at least the most apparent bugs
fixed. You can download and install the
earlier version from www.microsoft.com/
windows/windowsmedia/download/default.asp
and try watching the movies.

It would be difficult to determine
whether it’s a codec problem, since you
have not mentioned what kind of
movies you are trying to view—whether
they are MPEG or AVI files, VCDs, or
other formats. DivX videos that you
download off the Internet could pose
problems. There are several flavours of
the codec such as SMR, FlaskMPEG,
Microcrap, etc and if the videos are
encoded with any of these, you would
need to have the relevant codec installed.
Since these codecs are very similar at the
core, the player may open the file any-
way and not display any picture. If the
codecs seem to be the problem, try
downloading and installing the Codec
Pack of ELISOFT from http://codecpack.
elisoft.net/.

Another problem, though unlikely,
could be with the video files them-
selves if they are DivX files. Some
video files get corrupted during trans-
fers or encoding software add unnec-
essary headers. Open the file using
VirtualDub (www.virtualdub.org) and save
it as a different file using the Direct
Stream Copy option for video and
audio. This will cut out unnecessary
bytes from the file that the player may
not understand.

FAQs

Send your computing
problems to
sos@jasubhai.com
or write to Digit, 

D-222/2, Om Sagar, MIDC, Nerul-400
706, and we may answer it here!
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Turn off Task Scheduler
First of all, turn off the Task
Scheduler, unless it really 
is scheduling something
important. Most users have
no critical programs sched-
uled, especially after freshly
installing Windows. The
scheduling utility keeps run-
ning in the background,
unnecessarily hogging mem-
ory. To disable it, double-
click the Task Scheduler icon
in the system tray and click
Advanced > Stop Using Task
Scheduler. When you create a
scheduled task, the feature
will be enabled.

Nix the Active Desktop
For a healthy Windows, you
have to get rid of the Active
Desktop. Microsoft had
added this feature with
Internet Explorer 4 and later
into Windows when it 
integrated the browser and
the operating system. It
allows you to display Web
content on the desktop
itself. The Active Desktop
hogs a ridiculous amount 
of memory and often causes
the system to be unstable.
Simply right-click on an
empty area of the desktop
and disable View as Web
Page to turn this off. If 
you set JPEG or GIF files 
as your wallpaper, this 
feature needs to be turned
on. It is better to convert
them to BMPs before setting
them as the wallpaper.

Enable DMA
Direct Memory Access
(DMA) is a technique that
hard disks and CD-ROM
drives can use to transfer
data directly to and from
memory, without passing
through the processor. DMA
reduces the load on the sys-
tem processor since data
transfers do not require
monitoring by the CPU.
With DMA, a write or read
operation can be executed in
two to four clock cycles.
Without DMA it will cost the
CPU a minimum of 16 clock
cycles per operation. Not
only do disk read/write oper-
ations gain a significant
boost in speed, but Windows
also works faster, since it can
load system files much faster
and also accesses the swap
file at higher speeds.

Older hard disks and CD-
ROM drives do not support
DMA, but almost all com-
puters today use DMA-com-
pliant devices. In case you
face a problem after enabling
DMA, reboot Windows to
Safe Mode and disable the
option. Also, DMA needs to
be enabled from the BIOS,

but again, on most comput-
ers, this is on by default.
DMA is supported only in
Windows 95 OSR 2 and later.

To enable DMA, open
Control Panel > System > Device
Manager. Expand the Disk
drives tree, select the hard
disk and click Properties.
Under the Settings tab,
check the DMA option.
Repeat this for all other 
hard disks and the CD-ROM
or DVD-ROM drives. 

File system properties
Changing the File System
settings can also provide bet-
ter performance. First,
change your computer’s role
to a Network Server, even if
it is not one. Open Control
Panel > System > Performance
and click File System. Under
the Hard Disk tab, change
the typical role of the com-
puter to Network server
instead of Desktop comput-
er. The setting controls the
size of various internal data
structures used by the 32-bit
file access driver (VFAT).
When you use the Desktop
computer setting, VFAT allo-
cates memory to record the
32 most recently accessed
folders and 677 most recent-
ly accessed files, consuming
approximately 10 KB of
memory. With the Mobile or
docking system setting,
VFAT allocates memory to
record 16 folders and 337
files, taking up around 5 KB
of memory. As a Network
server, VFAT allocates
around 40 KB of memory to
record 64 folders and 2,729
files. With the kind of 
memory available on sys-

tems today, this slight over-
head hardly makes any 
difference, especially consid-
ering the performance gain
it provides.

Optimise virtual 
memory
The way virtual memory is
configured tremendously
affects Windows perform-
ance. This is true for all 
versions of Windows,
including the now-obsolete
Windows 3.1. The swap file
is what Windows uses to
store temporary data when it
runs out of RAM. Thus, your
working is not limited by the
amount of RAM on your
machine. However, for a
program to be able to use
this data, it must be trans-
ferred back to the RAM. The
data that is not immediately
required is moved to a part
of the hard disk and recalled
when required. However,
since hard disks are nowhere
as fast as RAM, swapping
data back and forth drasti-
cally reduces speed. No mat-
ter how much RAM you
have, Windows will always
use the swap file for some
infrequently used parts of
the OS (read the next tip to see
how to avoid this).

By default, Windows

■ tips and tricks

Enabling DMA significantly
improves speed

Optimise the Windows swap
file for better performance

WINDOWS 98
This most widely used OS is more tolerant
than later versions and allows many power
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uses a variable swap file that is
created on bootup and where
the size is dynamically modi-
fied when required. Though
this works just fine, it is not
the most optimal. You can
never get the speed of RAM
from the hard disk, but you
can make it slightly faster.
The best way to configure the
swap file is to have a perma-
nent swap file, preferably on a
dedicated partition. This min-
imises the effect of disk frag-
mentation and increases seek
time. Another practice that a
few power users have adopt-
ed is to place the swap file on
the first partition and the
operating system on the fol-
lowing partition. Data closer
to the centre of the drive is
read slightly faster than data
at the periphery. This is espe-
cially useful for PCs with only

64 or 128 MB of RAM where
data would frequently be
swapped to the hard disk and
can be easily done with BIOS-
es that allow booting from
the D drive.

To change the swap file
settings, open Control Panel >
System > Performance and click
Virtual Memory. Choose ‘Let
me specify my own virtual
memory settings’ and select
the drive for the swap file.
Note that no matter what
partition you boot from, it
will always appear as the C
drive from DOS and Win-
dows 98, and the first parti-
tion that is recognised as C by
the BIOS will be assigned a
higher drive letter. Set the
minimum and maximum
size for the swap file. Both
these numbers should be
identical to set a permanent

(non-variable) swap file. Ide-
ally, it should be two-and-a-
half times the amount of
RAM on your system, but if
you have a separate partition
for it, you may not want it to
be less than 512 MB—if it is
lower, it will have to be a
FAT16 partition, not FAT32. 

Avoid the swap file
When Windows loads, it
moves certain parts of the
operating system to the swap
file anyway, regardless of
whether it has run out of
RAM or not. This is very good
for systems with less memo-
ry, since it leaves some free
RAM and applications will
start much faster. Otherwise,
when you start an applica-
tion and memory is required,
Windows will have to first
move all this data to the swap
file to free up RAM. This
functionality is usually not
required on systems with 256
MB or more RAM, especially
if they only run common
productivity tools such as
Office and Internet applica-
tions. You can prevent Win-
dows from using the swap file
until absolutely required by
adding the line below to the
[386Enh] section of the
\Windows\ system.ini file. 

C o n s e r v a t i v e S w a p f i l e
Usage=1

You can edit this file in
Notepad. In case you face any
problems such as programs
crashing frequently, remove
this line and reboot.

Display settings
The display settings affect the
speed of Windows too. The
more animations and transi-

tions the OS has to show, the
higher is the processor and
RAM usage. Typically, turning
off all such features instanta-
neously shows the difference
in speed. Right-click an
empty area of the desktop
and click Properties. Under
the Effects tab, uncheck the
boxes for ‘Animate windows,
menus and lists’, ‘Smooth

edges of screen fonts’ and
‘Show window contents
while dragging’.

Temporary cleaner
Regularly removing files that
accumulate in the Temp fold-
er can also show better per-
formance—these files are
usually very small and
unnecessarily fill up the hard
disk. This also causes high
disk fragmentation and
pushes important data
towards the periphery of the
disk, where read/write opera-
tions are slower. Ideally, cre-
ate a batch file that empties
this folder and place it in the
Startup, so that it runs every
time you boot to Windows.
You could do this from the
autoexec.bat too, but this file
runs while still in DOS mode,
so disk access will be much

Regularly defragmenting the
hard disk maintains optimum
performance for read/write
operations. Hard disks store
data in sectors and clusters,
the latter being the smallest
addressable unit. Clusters are
of a fixed size, depending on
the file system (FAT, FAT32,
NTFS, etc). A cluster can hold
only one file, but a file may
span over several clusters.
For FAT32 partitions, the
cluster size is 4 KB. Thus, any
file between 0 bytes to 4 KB
will occupy one cluster.
Should its size increase
beyond 4 KB, it will look for
the next free cluster to fill up.
With frequently changing

files such as documents,
spreadsheets, images, etc,
the fragments of the file may
not be on contiguous clus-
ters. Reading and writing to
such files spread all over the
partition is obviously slow.
Defragmenting brings pieces
of the file together, so that
they are accessed faster.

All versions of Windows
are bundled with defragment-
ing tools. In Windows 98, you
can run it from Start > Pro-
grams > Accessories > System
Tools > Disk Defragmenter. In
Windows 2000 and XP, right-
click My Computer and click
Manage. Look for Disk
Defragmenter under Storage.

Defragmenting

Turn off unnecessary graphic
effects
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slower than when in Win-
dows. You should strip all file
attributes before running the
delete command, since hid-
den and system files will not
be deleted from the Com-
mand Prompt. Also, using the
deltree command instead of
del will ensure that even fold-
ers are deleted. Thus, your
batch file should contain the
following commands:

attrib -a -s -r -h c:\Windows\
Temp\*.* /s

Deltree/y C:\Windows\
Temp\*

Managing power
Power Management is a very
useful feature for notebooks,
but not as critical on a desk-
top PC. With default power
management settings, the
computer will automatically
reduce the spinning rate of
the hard disks and blank off
the monitor after a few min-
utes of idle time. In older sys-
tems, this sometimes causes
Windows to lock up. Depend-
ing on the settings, every
time you need to use the PC,
the hard disk will have to
spin up again before data can
be accessed on it. Turning 
off power management 
completely will not harm the
system in any way. At most,

set only the monitor to be
turned off. Open Control Panel
> Power Management and
choose Always On under
Power schemes to disable all
power saving features.
Optionally, you can set only
the system standby and hard
disk settings to Never.

Disable Autorun
Autorun was an innovative
feature to automatically
launch programs from CD-
ROM and DVD drives. How-
ever, the way it works, it
affects system performance,
apart from being irritating at
times. While this feature is
on, Windows polls the drive
every 5 seconds to check if
some media has been insert-
ed. If it finds a new disc, it
will check it for the
autorun.inf file and execute
the commands within this.
This is quite an overhead,
especially when you need the
feature only sometimes. This
is true for all versions of Win-
dows. To turn it off, open
Control Panel > System > Device
Manager. Expand the
CDROM tree, select the drive
and click Properties. Under
the Settings tab, disable ‘Auto
insert notification’.

Boot faster
Before Windows loads, it
processes certain files to set
the correct environment and
load initial drivers and Win-
dows settings. The config.sys
typically loads drivers and
the autoexec.bat sets the
environment and runs pro-
grams before Windows loads.
If these files are loading any
unnecessary items, you

should remove them. Both
files can be edited in
Notepad.

A third file, the msdos.
sys, sets several parameters
for Windows. It specifies the
Windows folder, the location
of the startup files, behaviour
of the boot menu, etc.
Changing a few parameters
can ensure faster booting of
the operating system. If any
parameters exist, you can
change its value, or simply
add a line with the parame-
ter. Before you can edit this
file, however, you must strip
its read-only and hidden
attributes. To do this, open a
Command Prompt window
and type this command:

attrib –h –r msdos.sys
When Windows is not

shut down properly, it auto-
matically runs Scandisk
when it boots again. You can
disable this by using
AutoScan=0. Setting its value

to 1 will bring up a prompt
asking if you want to run
Scandisk and setting it to 2
will run Scandisk automati-
cally. BootDelay=x sets the
amount of time you have to
press [F8] to bring up the
boot menu. The default value
for this is 2 seconds. If Boot-
Menu is set to 1, it will
always bring up the boot
menu, BootMenuDelay sets the
number of seconds this
menu is displayed for, before
booting with the default
selection. When BootWarn is
set to 0, Windows will boot
to Safe Mode without warn-
ing, whenever it does not
start properly.

By now, you probably
have FAT32 on all drives, so
disk compression utilities
will not work. You should
disable the driver for this by
setting DblSpace and Drv-
Space to 0. Also, if you do not
have a SCSI controller, set

Changing certain BIOS settings
can reduce the amount of time
it takes to hand over control to
the operating system, thereby
reducing the time taken to
boot. Although there are sev-
eral different BIOSes with vary-
ing options, there are some
settings common to all. Look
around your BIOS to find these
options. Usually, to enter the
BIOS setup, you have to press
the [Delete] key while it is
loading.

Configure your hard drives
in the BIOS, instead of setting
it to automatically detect them
every time it boots. For most

BIOSes, you can simply select
the Auto Detect Hard Disks
option. Disable Boot Up Flop-
py Seek. This option checks if
there is a floppy in the drive.
You also don’t need the Virus
Protection feature. Enabling
this from the BIOS often caus-
es problems with system
updates and also slows down
the booting time. Change the
boot order so that it loads the
operating system from the
hard drive first. You would
hardly ever boot from a floppy
or CD-ROM and when you
need to, you can switch to this
configuration in the BIOS.

BIOS Tweaks

Turn off power saving features



DoubleBuffer to 0. You can
disable logging of the boot
process by setting the value
of DisableLog to 1. Setting
SystemReg to 0 will disable
scanning of the Registry at
startup, but it is better to
leave this on.

Defragmenting to
rearrange programs
Windows 98 has a pretty use-
ful feature to help load appli-
cations faster—over time, it
tracks your usage patterns
and logs the frequency with
which you use each applica-
tion. It can then rearrange
the files of the application on
your hard drive so that they
will load faster. After you
have used your computer for
a few weeks, run the Disk
Defragmenter and select the
drive you want to defrag-
ment (usually C). Click Set-

tings and check the box to
‘Rearrange program files so
my programs start faster’.
Plus, you also have the added
advantage of the disk getting
defragmented. 

Windows logon
If you are not on a network
and Windows is not config-
ured for multiple users, or
network users are not
authenticated by an NT
domain, you should turn off
the Windows logon dialog

box. Open Control Panel > Net-
work to configure the net-
work properties. You don’t
require the Microsoft Family
Logon, so select it and click
Remove. Ensure that the Pri-
mary Network Logon is Win-
dows Logon and click OK. If
you don’t have any password
for the user, Windows will
automatically log on without
the prompt. If you did set a
password, you can locate and
delete the PWL file from the
Windows folder, restart Win-
dows and this time enter a
blank password. 

Using Tweak UI
Tweak UI is a very powerful
software that lets you change
various system settings with-
out having to edit system files
or fiddle with the 
Registry. It is free and can 
be downloaded from www.
microsoft.com/ntworkstation/dow
nloads/PowerToys/Networking/N
TTweakUI.asp. Version 1.33 is a
consolidated version that will
work on Windows 9x as well
as NT systems—it will give
you different options on dif-
ferent OSes. After it is
installed, it will be available
from the Control Panel.
Using Tweak UI is pretty
straightforward, but here are

a few changes you must make
to get better performance.

Under the General tab,
disable Window animation,
Smooth scrolling, Menu ani-
mation, Combo box anima-
tion and List box animation.
On the Explorer tab, disable
‘Animated Click here to
begin’. Next, switch to the
IE4 tab and disable ‘Active
Desktop enabled’. On the
Boot tab, you can control
boot settings such as the
behaviour of the boot menu,
Scandisk, etc. Autorun for
C D s
c a n

be disabled under the Para-
noia tab.
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Defragment the hard disk to
rearrange programs

Log on to Windows
automatically

Use Tweak UI to speed up
Windows 98

Get rid of services
Services are background appli-
cations that run on Windows.
They may be system-related
programs without which Win-
dows cannot run, or helper
applications, providing cer-
tain functionality to other
programs. For example, the
Security Accounts Manager
service stores security infor-
mation for user accounts to 
be used by all applications 
for authentication. Windows
2000 starts several services by
default, many of which you
may not require. You can
either permanently disable a
service, or set it to be manual-

ly started. If you are unsure,
choose the Manual mode—
the service will be started only
when required, but will not
cause any errors. If perma-
nently disabled, dependent
programs will throw up errors
when they need the service.

Right-click My Computer
and click Manage. On the left
pane, expand Services and
Applications and click Ser-
vices. Sort the services in
descending order by the Sta-
tus column to bring the serv-
ices that are currently run-
ning on top. You can select
each service and double-click
it to read its description,
change the Startup type to
Manual or Disabled and to
stop it. As you go through the
list, you may realise that you
don’t require more than half
the services, such as Distrib-
uted File System, Task Sched-
uler, Remote Registry Service,Stop services you don’t require

WINDOWS 2000 PROFESSIONAL
Windows 2000 lacks little in terms 

of performance and stability, but can be
squeezed for even more juice
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RunAs Service, etc. If you
don’t have any NTFS parti-
tions, Distributed Link Track-
ing will not help in any way.
Similarly, if you don’t have
any printers installed, you
can turn off Print Spooler.

Personalised menus
Windows 2000 introduced
personalised menus, tracking
usage of menu items across all
local users. Items that have
not been used recently are
hidden away, providing faster
access to frequently used
shortcuts. This is a very
resourceful addition to the
user interface, but comes at a
price. Every time you open a
menu, Windows checks up
which items are to be dis-
played and which ones are to

be hidden. This is quite
unnecessary and one can
actually feel the delay on slow
systems. Turn off personalised
menus from Start > Settings >
Taskbar & Start Menu. 

Active Desktop
Though there haven’t been
any known issues with Active
Desktop on Windows 2000 as
against 98, it can slow down

the OS. You should avoid
using GIFs and JPEG images as
your wallpaper. To disable
Web content on the desktop,
right-click on the desktop,
click Properties and switch to
the Web tab. Uncheck the box
to ‘Show Web content on my
Active Desktop’ and click OK. 

Away with display
effects
Windows 2000 brought with
it a new set of display effects
for menus, lists and windows.
Turning these off will save up
some resources. The perform-
ance gain will be more appar-
ent on low-end computers,
but you will definitely notice it
when minimising or maximis-
ing windows. Right-click on
the desktop, click Properties
and switch to the Effects tab.

Disable ‘Use transition effects
for menus and tooltips’,
‘Smooth edges of screen fonts’
and ‘Show window contents
while dragging’. 

Performance options
Built over the NT architec-
ture, Windows 2000 provides
performance options similar
to Windows NT 4. Open Con-
trol Panel > System > Advanced
and click Performance
Options. Here, you can set
Windows to optimise proces-
sor and memory usage for

applications or background
services. For desktop PCs, you
don’t need to change this set-
ting. If it were a server, you
would choose to optimise for
background services. You can
also change the virtual mem-
ory settings. You can have
one swap file per drive, each
with different sizes (Check
the tip Optimise virtual
memory in the Windows 98
section for more on swap
files). You will notice that
here you can also set the 
maximum registry size. 
You should not set this to a
very low value, or you will
start facing problems as you

install more programs. Setting
a small size does make a 
difference though—Windows
loads the registry into memo-
ry, so the smaller the registry,
lesser is the memory used. 

Maintaining temporary
files
By default, Windows 2000 sets
up different Temp folders for
each user along with the
\Winnt\Temp folder. Thus,
when clearing out temporary
files, you have to check this
folder, as well as the Temp
folder under each user’s
account profile, under \Docu-
ments and Settings\<User>
\Local Settings\Temp. This is
as unmanageable as it is irri-
tating. Fortunately, you can
change this behaviour. Open
Control Panel > System >
Advanced and click Environ-
ment Variables. You will see
two boxes for User variables
and System variables. Delete
the TEMP and TMP variables
for the user, or set their paths

to %SystemRoot%\TEMP. You
will have to repeat this for
every local user. 

Power boot
On the System Properties dia-
log, under the Advanced tab,
click Startup and Recovery to
change the boot options for
the NT Flex boot loader. If
you have only Windows 2000
installed, disable ‘Display a

Setting the swap file sizes and
the maximum registry size

Change environment variables

Web content on the desktop
hogs resources

Disable personalised menus in
Windows 2000

Squeeze out even the last drop
of power by turning off display
effects



list of operating systems’. If
you dual boot with another
OS, reduce the amount of
time for which the boot
options are displayed. Thus,
when you switch on your PC,
you will not have to hang
around to press [Enter] to
load Windows. 

Automatic Logon
If yours is a single-user PC, or
a particular user logs on to
Windows 2000 most often,
you can have the operating
system logon automatically
with that user’s credentials.
You should not use this if
security is a concern. If the
computer is part of a work-
group and not logging on to a
domain, open Control Panel >
Users and Passwords and
uncheck ‘Users must enter a
user name and password to
use this computer’. On the
Advanced tab, uncheck
‘Require users to press Ctrl-
Alt-Del before logging on’. 

If Windows is set to log on
to a domain, you can enable
this functionality by editing
the registry. Start regedt32
from Start > Run and navigate
to HKEY_Local_ Machine\
Software\Microsoft\Win-
dowsNT\CurrentVersion\
Winlogon. Create the keys
DefaultDomainName, Defaul-
tUserName, and DefaultPass-

word and enter the domain,
user name and password to
automatically log on to.

Using Tweak UI for 
Windows 2000
Tweak UI for Windows 2000
is a very powerful tool to
modify system settings.
Though the installer is the
same one as for Windows 98,
the options available and its
behaviour are different in sev-
eral respects. On installing
Tweak UI, you can launch it
from the Control Panel.

On the General tab, turn
off Combo box animation,

Cursor shadow, List box ani-
mation, Menu animation,
Menu fading, Menu selection
fading, Smooth scrolling,
Tooltip animation, Tooltip
fade and Window animation.
Switch to the IE tab and
uncheck the box to ‘Allow
Active Desktop to be turned
on/off’. On the Paranoia tab
you can disable Autorun for
audio and data CDs.

Options on the Cmd tab
let you configure keys to auto-
matically complete file and
directory names at the Com-

mand Prompt. For example,
you can type in the first char-
acter of the file or directory
name and press Tab to have
Windows fill in the rest for
you. This is extremely useful
even if you work only occa-
sionally

with the Command Prompt.
On the Logon tab, you can set
an account to automatically
log on after booting Windows.
This is useful for single-user
PCs, or where security is not
critical.
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Change the theme
The default Windows XP
theme looks very pretty, but
hogs a lot of system resources
for the eye-candy effects such
as bevelled objects and transi-
tions. If looks are not impor-
tant to you, switch over to the
classic Windows look. To do
this, right-click an empty area

of the desktop and click Prop-
erties. Under the Themes tab,
set Windows Classic as the
current theme and click OK.

Turn off display effects
Switching off transition and
animation effects can save a
lot of system resources. These
effects are not required to run
programs and cause an
unnecessary load on the

processor and RAM. Right-
click on an empty area of the
desktop, click Properties and
switch to the Appearance tab.
Click Effects and clear all the
checkboxes. 

Choose performance
Windows XP has some very
good features to maximise
performance. Unfortunately,
the default settings are no
good. You can choose to have
it optimise itself for faster
computing. To change these
settings, click Start, right-
click My Computer and click
Properties. Switch to the
Advanced tab and click the
Settings button under Perfor-
mance. By default, ‘Let Win-
dows choose what’s best for
my computer’ is selected.
Choose ‘Adjust for best per-
formance’ instead, and you
will almost immediately
notice a boost in speed. This
is because all graphic effects
are turned off. You can

Tweak UI for Windows 2000

Log on automatically to
Windows 2000

Switch to the classic Windows
theme

Disable all display effects on XP
XP lets you optimise the OS for
performance

WINDOWS XP PROFESSIONAL
XP is quite user-friendly with an impressive

interface, but is sluggish on low-end systems



optionally choose each type
of effect that should be
enabled from here, but if it’s
power you are looking for,
leave them all off. Note that
the behaviour and appear-
ance of a lot of Windows such
as the Control Panel, will
become quite different. If you
prefer the helpful wizard-like
interfaces, you may want to
sacrifice a bit on performance
and enable the option to ‘Use
common tasks in folders’. 

Paging options
On the Performance Options
dialog (right-click My Com-
puter and click Properties >
Advanced > Settings), click on
the Advanced tab to access
even more performance fea-
tures. You can adjust the
processor and memory
options, but for desktop PCs

you should leave the default
options (optimise for Pro-
grams). What you should
change are the virtual memo-
ry settings. You can have one
swap file per drive (Check the
tip ‘Optimise virtual memory’ in
the Windows 98 section for
more on swap files). Set the

optimum size and click OK. 

Boot options
If you are not booting multi-
ple operating systems, you can
turn off the option perma-
nently, until it is required. If
there is another OS on your
system, say Windows 98, you
can reduce the amount of time
the option to choose which
OS to load is displayed. Right-
click My Computer, click Prop-
erties > Advanced and click the
Settings button under Startup
and Recovery. Here, you can
choose which operating sys-
tem to boot by default. You
can uncheck the boxes to
show the boot options, or
select the number of seconds
for which the choices are dis-
played. Five seconds is usually
more than enough.

You will notice recovery
settings in case of a system fail-
ure. Alerts and debugging
information will not be very
helpful for most users, so you
can turn these options off too.

Turn off services
Depending on your comput-
er’s configuration and options
chosen when installing Win-
dows XP, it will have certain
services enabled. Many of
these you may never require
and can safely switch off. You
can disable a service so that it

never runs, or set it to be
manually started.

Right-click My Computer
and click Manage to bring up
the Computer Management
console. On the left pane,
select Services under Services
and Applications to control all
installed services. The easiest
way to filter through the list is
to sort it by the Status column.
Services that are ‘Started’ are
the ones you need to look at.
(Read more on services in the tip
‘Get rid of services’ under Win-
dows 2000 Professional’.)

Quit indexing
The Indexing Service stores
information from documents
and organises it for faster
searches. This is not useful to
many users, especially if the
documents are well organised.
Not only does this service take
up system resources, it also
involves frequent read/write
operations to the hard disk,
which are particularly slow.
From the Computer Manage-
ment console (right-click My
Computer and click Manage),
select Indexing Service from
the left pane under Services
and Applications. You will see
the list of catalogues on the
right pane. If any of them are
started, you can stop them
from here, and even delete the
catalogue. Optionally, you can
expand the tree on the left
pane for each indexed item
and restrict the folders it scans.

Tweak UI for XP
Tweak UI is available for Win-
dows XP too. It gives you
access to quite a few system
settings that are otherwise not
readily available, and can help

gain that extra inch of power
from XP. You can download
this version from www.
microsoft.com/windowsxp/pro/
downloads/powertoys.asp.

Under General, you can
turn off display effects such as
fading and animations.
Under Explorer, uncheck the
boxes for ‘Allow Web content
to be added to the desktop’
and ‘Enable smooth scroll-
ing’. Expand the Explorer
tree, select Thumbnails and
move the Image Quality slid-
er to around the centre. Next,
expand the My Computer >
AutoPlay branch. Under Dri-
ves, you can disable AutoPlay
for all drives, thus reducing
this overhead. Under the
Types branch, you can choose
to disable AutoPlay for CD,
DVD and removable drives.

Under the Command
Prompt branch, you can con-
figure special keys to auto-
matically complete file and
directory names, as on a Unix
system. If you have a single-
user system, you can have XP
logon automatically from
Logon > Autologon. Under
Logon > Unread Mail, you can
disable the notification of
new e-mail messages for each
user. Not only is this more
secure, but it also reduces the
overhead of polling for new
messages for every user.
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Changing swap file settings 
in XP

Power up with Tweak UI for XP

Reduce load on CPU and RAM
by turning off services
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The grandfather of all action-adventure
games, Alone in the Dark is based loosely
on the works of H.P. Lovecraft. Like the
source of inspiration, the game’s plot can
leave you senseless at times and perpetu-
ally hanging in mystery. It was the first
game to involve the player in an immer-
sive and cinematic gaming experience.
Stark camera angles and 3D graphics (a
rarity then) heightened moments of sus-
pense within the cursed ‘roach-motel’ 
like mansion of Decerto—you can 
check out anytime you like, but you 
can never leave!

AALLOONNEE  IINN  TTHHEE  DDAARRKK

Released:  1992
Developer: Infogrames
Publisher: Interplay Productions

The Beast Within is a gala of ghoulish
adventure that mesmerises and thrills
through visceral explosions that span six
CDs. The game sets off with an investiga-
tion into a possible werewolf sighting and
uses live action sequences against back-
drops shot in Germany—filmed against a
blue screen and then seamlessly com-
bined with over 1,300 photographed set-
tings. An interestingly executed story
threads historical facts with fictional mus-
ings to form a weave rich in intrigue, 
horror and mystery. 

GGAABBRRIIEELL  KKNNIIGGHHTT  IIII::  
TTHHEE  BBEEAASSTT  WWIITTHHIINN

Released:  1995
Publisher: Interplay Productions,
Developer: Infogrames

So, you are wrongly accused of mur-
dering your daughter. To make things
worse, you are promptly hanged,
undoubtedly a very gentlemanly thing
to do. End of a bad day’s living you
think? Not if you happen to be buried
in the vicinity of a spade-happy doctor.
Through the Eyes of the Monster resur-
rects you, the player, as the beastly cre-
ation of one Dr Frankenstein, a part
played quite hauntingly by the peerless
Tim Curry. Browsing through his labo-
ratory and the accompanied collection
of oddities is twice as fun with Tim
growling threateningly at you, com-
plete with an eerie soundtrack.

FFRRAANNKKEENNSSTTEEIINN::  TTHHRROOUUGGHH  TTHHEE  EEYYEESS  OOFF  TTHHEE  MMOONNSSTTEERR  

Released: 1995  
Developer: Amazing Media
Publisher: Interplay Productions

If a reported budget of $4,000,000 does
not put fear into your soul, then maybe a
morbid and ghastly storyline will.
Created by the mother of adventure
games, Roberta Williams (of King’s Quest
fame), Phantasmagoria is an achievement
in that it comes the closest to delivering
a cinematic experience. Victoria Morsell
stars as Adrienne Delaney, the protago-
nist of the game  and David Homb as
Don Gordon, her loving, albeit homicidal
husband. They were blue-screened and
digital background footage was later
added. Created when an in-game cut-
scene was all the rage, this game effec-
tively uses the said tool to bump an ordi-
nary story into the twilight zone of a 
B-grade movie.

Released: 1995 
Developer: Sierra Games
Publisher: Sierra Games

PPHHAANNTTAASSMMAAGGOORRIIAA

With the works of Edgar Allen Poe forming a firm
inspirational platform, The Dark Eye descends into
the madness of one man’s twisted world. The
game presents an exploratory experience into the
minds of the insane, murderers and their victims.
Rendering the Floyd line of “all you touch and all
you see, is all your life will ever be”, the game
draws upon animate and inanimate objects to
throw you ever deeper into the realms of sinister
designs and the resulting dismay. A troubling saga
triggered by a sniff of paint thinner. The game
uses stop-motion character animations, populates
a multiple-story path with strong personalities and
adds another layer of richness via the voice of 
legendary author William S. Burroughs.

TTHHEE  DDAARRKK  EEYYEE

Released: 1995
Developer: The Dreamer’s Guild
Publisher: Expert Software 
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Sanitarium is a journey of metaphors that
begins with the age-old question of Who
am I? The horrors flow from the id that
forms the landscape of humanity. Self-dis-
covery is a scary concept and Sanitarium
proves just that. The ‘How did I get here?’
throws you into a world of grotesque
denizens—the strange that are familiar and
the familiar that are strange. Reconstruct
your past and unravel the horror of self. 

SSAANNIITTAARRIIUUMM

Released: 1998
Developer: DreamForge 
Intertainment Inc
Publisher: ASC Games

Welcome Gorrister, the suicidal loner,
Ellen a hysterical engineer (a phobia of
the colour yellow stalks him), Benny the
soldier (now evolved into a simian),
Nimdok, an ancient (hence mean-spirit-
ed?) man and Ted, a cynic and paranoid
to boot. These fine specimens of human-
ity are Earth’s only respite against AM—
an insane computer that has logically
deduced that mankind’s only hope is an
annihilation of the species.

Based on Harlan Ellison’s short story,
‘I Have No Mouth, and I Must Scream’,
the game complements the text very
well, extending the Hugo award-winning
tale further into the world of tortured
souls and hidden pasts. Provocatively
sprinkled with psychological musings, I
Have No Mouth succeeds in offering a
very mature premise: there is no victory
greater than defeat. An intellectually 
terrifying experience.

Released: 1995 
Developer: Inscape
Publisher: Expert Software

Although the game pits three species against each other—Aliens, Predators and
Humans—the scare factor is multiplied manifold within the human campaign.
No opportunity is spared here to thrill and shock you: with a motion detector
as the only source of salvation against the other species, playing as a Human
will have you at the edge of your seat every time you spot a blip on the sen-
sor—could it be an Alien face-hugger, a Predator? You clench your flamethrow-
er and turn the corner only to relax at the sight of a swinging hook. As you
lower your guard and switch off the flashlight, a Praetorian lunges from the
rooftop and goes for your head. Tag! You are prey.

AALLIIEENNSS  VV//SS  PPRREEDDAATTOORR  22

Released: 2001
Developer: Monolith Productions, Inc
Publisher: Fox Interactive, Sierra Games

Frighteningly fashioned by the husband and
wife team of Frank and Susan Wimmer,
Amber is a game that begs to be experi-
enced. Journeys Beyond takes you on a dis-
turbing walk beyond the grave. It teasingly
flashes glimpses of past mysteries and
tempts you to discover the secrets of life
after death by possessing the souls of the
dead still searching for peace. Inhabit, for
example, the soul of a dead child tethered
to the realm of the living by the loss of his
beloved teddy bear. Drink of the game
with lights off and snippets from this gem
are sure to haunt your waking dreams. 

Released: 1996 
Developer: Hue Forest Entertainment
Publisher: Hue Forest Entertainment

Resident Evil took the mantle of scaring
gamers from the veteran Alone in the Dark
series. The roller coaster begins the
moment you see a rather famished zombie
feasting upon the remains of one of your
friends; the horror then pours on relentless
as the shocks and the gore never cease,
always in your face and sudden. The ride is
hampered by bad voice acting, but the cin-
ematic flair of the game sends shivers of
horror down the spine.

Released: 1995 
Developer: Capcom Entertainment 
Publisher: Virgin Interactive 
Entertainment

AAMMBBEERR::  JJOOUURRNNEEYYSS  BBEEYYOONNDD

RREESSIIDDEENNTT  EEVVIILL

II  HHAAVVEE  NNOO  MMOOUUTTHH  AANNDD  II
MMUUSSTT  SSCCRREEAAMM
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If the ghosts of the past do not twist your innards in
fear, then this stream of fresh blood is sure to blind
your senses with terror and apprehension.

DOOM III
id Software takes a stroll down memory lane and
invites us back to the future with the hotly anticipat-
ed DOOM III. Mindless zombie-killing, shotgun-
pumping, slap-me-silly-and-point-me-to-the-ammu-
nition action awaits us at the end of the rainbow—
the same great taste now with super-duper graphics
and 5.1-channel Dolby sound. Buy your copy today!
Or when it’s out, which ought to be sometime this
year. 

Silent Hill 2
In my restless dreams I see
that town, 
Silent Hill...
You promised you’d take
me there 
again someday, 
but you never did.
Well, I’m alone there now 
in our special place, waiting for you…
A ‘Dear James’ letter addressed to one Mr Sunderland
that is twice as scary since the author is his wife and
three years dead. Silent Hill 2 is a port of the PlayStation
2 survival-horror game that has mesmerised console
gamers with terror. It promises to treat us PC gamers
with the same mental derision. 

Call of Cthulhu: Dark
Corners of the Earth
How’s this for a setup?
You are cast as Private
Investigator Jack Wal-
ters, an ex-cop trying to
locate a missing person
in the mysterious fish-
ing village of Innsmouth. Hmmm…scope for a horror
action/adventure game, you think? Based on the
works of H.P. Lovecraft, Dark Corners is expected to
cast shadows of self-doubt onto the reptilian mind
within us, late this year.

SSccaarreedd  YYeett??

You walk down a nursery and
sounds of children playing
and laughing fill the chilly
air—you see nothing, no one
breathes but you, no footfalls
but yours. The laughter grad-
ually fades into whimpers of
tribulations, which then cas-
cade into a horde of blood
curdling screams of pure
pain. The fear rising within
you forces a stronger grip on
your trusty scythe. As you
take the corner, silence greets
you, then a scream followed
by its source: a floating brain
that would like nothing 
better than your blood. 
The Undying has begun.

Released: 2001
Developer: Dreamworks Interactive
Publisher: Electronic Arts

DOOM is raw, naked dread. So
unabashed in the primal impulses that it
sends coursing through your senses, the
game claws away at your brain and
feeds your psyche with enough frenzy
to keep you going longer than that
bunny hotwired into unlife via an alka-
line battery. A maddening struggle 
within a web of survival, it has spawned
an industry, spanned a decade of com-
puter life that’s like a millennium in
human years. DOOM’s legacy of pain
promises to continue with a third chap-
ter due next year.

DDOOOOMM

Released: 1993
Developer: id Software
Publisher: id Software

Bodies sway from the ceiling;
apparitions reconstruct their
deaths, filling your senses with
fear and dread. As you cling on
to dear life, clawing your way
through a labyrinthine space-
ship that could turn into your
coffin, you are taunted to the
verge of insanity by SHODAN,
a computer with a God com-
plex and your nemesis. You are
trapped billions of miles from
Earth with a mass murderer on
the loose—best enjoyed alone
in the dark with a good pair of
headphones.

SSYYSSTTEEMM  SSHHOOCCKK22

Released: 1999
Developer: Irrational Games, 
Looking Glass Studios
Publisher: Electronic Arts

UUNNDDYYIINNGG
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No One Lives Forever 2: A Spy in H.A.R.M.’s Way, stole our hearts away.
We present a briefing on being the best darn spy the digital world has ever seen

Die 
Another Day

guns gives you all weapons

skillz gives you skill points

ammo gives you ammunition 

armor gives you full armour

health gives you full health

god makes you invulnerable

poltergeist makes you invisible

maphole lets you skip levels

pos indicates your position

To cheat in the game, hit 

Talk [T] while playing and 

type the following codes: 

➜



CCooiinn
SShhoorrtt  ttoo  MMiidd-rraannggee
TThhrroowwiinngg  mmoonneeyy  aawwaayy  
hhuurrttss  sseennssiibbiilliittiieess
UUssee  tthhiiss  ttoo  ddiissttrraacctt
gguuaarrddss..  VVeennddiinngg
mmaacchhiinneess  wwiillll  oofftteenn  
hhaavvee  ccooiinnss  iinn  ffrroonntt  ooff
tthheemm——ccrroouucchh  ttoo  ggeett  aa  
bbeetttteerr  llooookk

HHaaiirrsspprraayy  WWeellddeerr
CClloossee  rraannggee
VVeerryy  llooww
UUsseeffuull  ffoorr  bbuurrnniinngg  
tthhrroouugghh  lloocckkss  aanndd  
ddoooorr  hhiinnggeess..  TThhee  
wweellddeerr  ccaann  aallssoo  bbee  
uusseedd  ttoo  kkiillll  sslleeeeppiinngg  oorr
uunnccoonnsscciioouuss  eenneemmiieess

MMaassccaarraa  SSttuunn  GGuunn
CClloossee  rraannggee
IInnssttaanntt  kknnoocckkoouutt
TThhee  ssttuunn  gguunn  iiss  uusseeffuull  
ffoorr  kknnoocckkiinngg  oouutt  
eenneemmiieess  wwiitthh  mmiinniimmaall
nnooiissee..  NNoottee  tthhaatt  yyoouurr  
ffooeess  wwiillll  wwaakkee  uupp  aafftteerr  
aa  wwhhiillee

AAnnggrryy  KKiittttyy  
PPrrooxxiimmiittyy  ddeevviiccee  
VVeerryy  hhiigghh
TThhee  KKiittttyy  eexxppllooddeess  
wwhheenn  aann  eenneemmyy  
vveennttuurreess  wwiitthhiinn  iittss  
ddeetteeccttiioonn  rraaddiiuuss——iittss  
ddeettoonnaattiioonn  ccaann  aattttrraacctt
uunnwwaanntteedd  aatttteennttiioonn

LLiippssttiicckk  SSppyy  CCaammeerraa

SShhoorrtt  rraannggee

OOnnllyy  ttoo  rreeppuuttaattiioonnss
TThhee  mmiinniiaattuurree  LLiippssttiicckk  
SSppyy  CCaammeerraa::  ddoonn''tt  
lleeaavvee  hhoommee  wwiitthhoouutt  iitt!!

BBooddyy  RReemmoovveerr  PPeerrffuummee
CClloossee  rraannggee
LLiiqquuiiddaattee  uunnwwaanntteedd  aasssseettss
TToo  pprreevveenntt  eenneemmiieess  
ffrroomm  ssppoottttiinngg  ffaalllleenn  
ccoommrraaddeess  aanndd  hheennccee  
rraaiissiinngg  aa  rruucckkuuss,,  uussee  
tthhiiss  ppeerrffuummee  aanndd  
ccoommpplleetteellyy  ddiissiinntteeggrraattee  
aa  bbooddyy

Search is life: Always search bodies 
when it’s safe to do so. You’ll find notes,
weapons, health and armour items this
way, especially if you have invested well in
the Search skill. Quick searching a body
(briefly right-click it), will pick the ammu-
nition and weapons off it—you can then
move the body out of sight and search it
more thoroughly with time and safety.

Eye can’t see: While inside buildings or
enclosed areas, look around for light
switches and turn them off. Exposed light
bulbs can be unscrewed to create a dark
area in which you can hide. Listen to the
whir of close circuit cameras and use 
the Camera Disruptor off the Utility
Launcher to safely disable the same and
clear your path.

Ask for directions: Your handy compass
also doubles as a tool to indicate the 
status of your current mission. A red ‘X’
mark on your compass indicates an 
intermediary objective you need to 
tackle. A red ‘i’ marks the location of a
major task. Finally, red dots indicate
locations of people you have tagged with
tracking beacons.

For Your Eyes Only

Live and Let Die
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Stuck as the lone gunman taking a
dying stance on a beach under

assault? That's what you get for getting
frisky with the General’s daughter!
BEACH HEAD 2002 calls for one good
man, you, to defend a solitary strip of
beach armed with a 30 mm gun, your
antitank gun, some missiles and for those
ammo-starved days, a handgun. The
available weapons vary between levels,
thus avoiding tedium that would have
otherwise have crept in. The game also
features friendly bombers that drop
crates of ammunition and armour. The
catch being that you need to shoot the
boxes out of the air in order to replenish
the same attributes. Every few missions,
the game plunges you into a night time

mission. A workday is never dull with
companies of soldiers, tanks, attack heli-
copters, bombers, fighter planes and

troop carrying vehicles making regular
pit stops at your local haunt. The num-
ber, frequency and the pattern of visita-
tions, of course, change as you climb the
ladder of levels. The game has acceptable
graphics, considering its system require-
ments. The soldiers are sprites with min-
imum frames of animation, making
them look jittery. There are also problems
with collision detection within the game:
a plane will sometimes fly right through
a hill without a scratch. BEACH HEAD
2002 calls for some insane reflexes, and
shows both the addictive and the one-
more-level syndrome that is the hallmark
of good games. With an affordable price
tag, this may be just the dose of fun that
you were looking for.

PRETTY MEN ALL IN A ROW: You shoot 
one down, he falls to the ground, 99 more
to go

Tom and Jerry in
Fists of Furry is

a 3D fighting game
starring characters
from the cartoon.
The game is pretty
a much direct PC
conversion of the
same-named hit
Nintendo N64
game. It successful-
ly brings along the
same fun and zest
that the series introduced. 

The game features one-on-one fight-
ing in venues modelled after classic
episodes of the cartoon series such as an
alley, a kitchen, a farm, etc. There are 10

levels in all, some of
which you must unlock
by making your way
through the single player
game. Characters like
Tom, Jerry, Tyke, Spike
and Duckling will punch,
kick and assail each other
with weapons that
include shovels, bombs,
red-hot pokers, tennis
rackets, furniture, an
assortment of fruits and a

kitchen sink! 
Combat essentially involves punch-

ing, kicking, ducking, catching and
throwing household items. You can also
kick an item across the floor, and envi-

ronmental hazards such as fire and falling
pots can put the hurt on you. Power-ups
take the form of yellow question marks
and offer boosts such as invisibility and
energy sapping, contagious measles. The
game is quite challenging and for the
most part, the challenge is well-balanced.
Bouts can get frustrating, but the cartoon
elements that decorate the game keep you
going long enough to enjoy the ride. Fists
of Furry is an experience that is at times
enjoyable, at times frustrating, but always
interesting. It’s the kind of game that you
occasionally get into for 15-minute ses-
sions of action at a time. It is not likely to
involve you to an extent where you would
find yourself whiling away the hours until
you’ve beaten the last level.

Tom and Jerry in Fists of Furry 
A cat and mouse game, no kidding!

PUNCH DRUNK: Jerry experiences one
of the finer things in life, courtesy
Tom, of course!

Developer: NewKidCo ■■  Distributor: Milestone Interactive Software Ltd ■■ Phone: 022-28381614 ■■ Web site: www.fusiongames.com ■■ Price: Rs 499
System requirements: Pentium 233 MHz processor or equivalent, 64 MB RAM, 16 MB DirectX 8 compatible video card ■■  Rating: ★★★   ✩✩

BEACH HEAD 2002
Being Private Ryan

Developer: Digital Fusion ■■ Distributor: Milestone Interactive Software Ltd ■■ Phone: 022-28381614 ■■ Web site: www.fusiongames.com 
Price: Rs 499 ■■ System requirements: Pentium 350 MHz processor or equivalent, 64 MB RAM, 4 MB AGP/PCI video card ■■    Rating: ★★★✩✩✩✩

✩✩
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3ds max 4: Ground Rules is a tailor-
made book for beginners starting out

with 3D Studio Max R4—every aspect of
the software, from the basics of the user
interface, to modelling, rendering, ani-
mation and special effects, is covered in
a lucid and clear language. 

The book does not limit itself to the
basics—relatively advanced topics such as
network rendering and inverse kinemat-
ics have also been covered. Complex spe-
cial effects are also touched upon briefly,
without going into the deep details that
might baffle a new learner. The emphasis
is on basic techniques, interface layout
and usage, making it easier for new users

overwhelmed by 3ds
max’s interface to get
their work done.

The accompanying
CD has actual screen
captures of all the oper-
ations described in the
book. Organised by 
way of chapters, the CD
has visual representa-
tions for everything the
book describes. Along
with the final 
rendered animations,
these videos leave 
little to the imagina-

tion. On the whole,
Ground Rules is a very
wholesome book, cov-
ering all the features
present in 3ds max4.

However, none of
the topics are covered
in depth, which makes
this more of an intro-
ductory book. Recom-
mended reading for
absolute beginners ven-
turing into the realm of
3d animation and who
want to learn 3ds max in
its entirety.

Publisher: Autodesk Press ■■  Contact: Computer Bookshop ■■  Phone:022-22070989/22076356 ■■  Fax: 022-2623551
E-mail: cbsbom@giasbm01.vsnl.net.in ■■  Price: Rs 1,100
Rating: ★★★★✩✩

3DS MAX 4: GROUND RULES

The Lord of the Rings: The Fellowship of the Ring
A saga of hits and misses

Riding on the gravy train of Tolkein’s
work, Vivendi’s Fellowship of the Ring is

based more on the books than on the
recently released Peter Jackson movie. You
will find yourself in a visually rich Middle
Earth, with control over one of three
playable characters at various points in
time. Aragorn, Frodo and Gandalf fight
their way through hordes of wargs,
wraiths and trolls, each armed with a
unique style of play.

Entertaining and challenging, the
combat serves as the central element of
the game. It’s great fun playing as
Aragorn, with his stylish moves and a
cool, quick-draw, bow-action. Gandalf is
just as engaging; his repertoire of spells
makes short change of any foe—orc or
Balrog. While both Gandalf and Aragon
can dish it out, you will find yourself
avoiding confrontations (running for the
exit is a frequent occurrence) while play-
ing as Frodo. He carries weapons that force
a dodge-and-counter style of combat. The
hobbit can use the One Ring to render
himself invisible, but this property of the
Ring is almost never needed.

The levels are generally well
designed, but some come across as just
plain needless: they seem to have been
added to either give each character
enough of a role within the game, or for
the sake of contributing a little more
than the movie. Puzzles found within are
at times easily solved while at others are
a source of frustration. The in-game cin-
ematics are badly choreographed: the

characters seem to be in a hurry to finish
their dialogues and transitions from one
scene to another are a bumpy ride.

Somewhat related to the movie, the
game boldly sets out on a new path,
attempting to present an experience that
is different from, but complimentary to
the film. The offering does waver from its
set road: some aspects of the game have
been well executed while others fall short
of expectations.

Genre: Third person, action-adventure ■■ Developer: Black Label Games ■■ Distributor: World Wide CD Roms ■■ Phone: 022-26973894 
Web site: www.lordoftherings.com ■■ Price: Rs 1,299 ■■ System requirements: 600 MHz processor, 128 MB RAM, 32 MB DirectX 8 compliant video
card ■■ Rating: ★★★  ✩✩

SHOWDOWN DURING SUNDOWN:
Aragorn gets down and boogies with some
orcs

RINGS AROUND THE WRAITH:
Aragorn and Gandalf can slay the beasties

✩✩

To begin, click here
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Learning is Fun
Ever since the start of India’s first

technology media institute, Media
One, in September 2002, the offices
of Jasubhai Digital Media have

been abuzz with excitement. Media One
offers hands-on training in Media Man-
agement, which includes components
relating to technology as well as allied areas
such as design, research and production. 

The students at Media One are
exposed to every aspect of digital media
and technology in a practical way. Besides
daily assignments, frequent field visits to
media and technology companies and
lectures from industry professionals, the
students put in practical work hours as
part of an editorial group, at the Test Cen-
tre or Media Studio amongst other things. 

Abhiram Iyengar, a Bachelor of Elec-
tronics from Karnataka, is from the first
batch of Media One students. He recent-
ly got his feet wet in the Digit Test Cen-
tre. Here’s what he had to say: “From the
time I joined Media One and was intro-
duced to different departments within
Jasubhai Digital Media, the Test Centre
was what attracted me the most. The
place is full of the latest computer periph-
erals and is heaven for anybody remotely
interested in technology.

On my first day itself I
was assigned a bunch of
games to review. Within a
matter of hours I’d played
every type of game conceiv-
able, from Adventure, Arcade,
RPG to FPS and RTS games.
And that was not all. I was
supposed to write mock
reviews on each game I played, taking
into account its graphics and sound qual-
ity, ease of use of the interface and the

overall gameplay experience. Boy was 
it fun!

Over the next few weeks, I tested and
wrote a number of articles on processors,
motherboards, chipsets, and graphics
cards. This improved my knowledge on
how each component works and the
relationship between the various subsys-
tems of a PC. It also gave me an insight
on some new technologies on the 
horizon and a look at how the PC 
market operates. 

I also had the opportunity to attend
presentations by various technology com-
panies and attend some press confer-
ences. Currently I’m engaged full time in
testing motherboards and learning the
nitty gritties of using various bench-
marking software. Other than all this, I
also learnt what it is to work under con-
stant pressures of deadlines and the
importance of working smarter by plan-
ning ahead in today’s fast paced work-
place. All in all, it’s been a truly wonder-
ful experience.”

The beginning of the New Year is always a
good time to undertake new endeavours
and head to explore new frontiers. And
two of our oldest hands, Veer Kothari and
Marco D’Souza, have decided to explore
the world beyond the friendly familiar walls
of JDM. While they may be just a few
names at the bottom of the article for most
of you, Sweet Marco, as we like to call our
Head of Writers, is infamous around the
Navi Mumbai locale for his Indica by day
and Quakemobile by night, just as Veer is
for his white Astromobile—both being our
chariots of choice during late nights at
work and other escapades. 

Marco leaves behind fond memories of
his days as the head of Test Centre, his
trusty, well greased keyboard and a screen-

shot showing the word count of his last
cover story for Digit: a staggering 16,315
words. Veer, on the other hand, leaves
behind a hard-to-fill space as a permanent
resident of the JDM premises, the sensibili-
ties of a first aid box and a huge, happy
sunflower.

Saying that they will be missed is a
gross understatement. We’ll probably
never come across anyone with the same
unerring precision in matters of technolo-
gy, astronomy and pretty much everything
else under the sun as Veer. Or for that mat-
ter, we’re sure nobody will match up to
Marco’s charming ways of dissuading us all
from working on a weekend.

All the best for the future to these 
comrades!

Gone with the Wind!

Going back to school, but with a difference

Hard at work in the Test
Centre (left): A rigorous
schedule, unrelenting
assignments and lots 
of fun
Learning the trade from
the best in the field
(below): Bimal Biswas, 
a cinematographer with
MTV, reveals his bag 
of tricks



arcade ■
■ backbyte

138

■ backbyte

Highlight the lighter side of computing. Mail your contri-
butions to: Backbyte Digit, Plot D-222/2, TTC Industrial
Area, MIDC, Shirvane, Nerul, Navi Mumbai 400 706
or e-mail us at backbyte@jasubhai.com

DECEMBER 2002

Your chance to
bite back!
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